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Coding
For Beginners

Starting something new can be daunting. Learning a skill or
mastering a new piece of hardware is tough. Even tougher if
you have no-one at hand to help. Conversely as the complexity
of our consumer technology increases, the size of the requisite
instruction manual decreases or in some cases it simply
disappears. At numerous times in our lives we have all been
“beginners”, there is no shame in that fact and rightly so. How
many times have you asked aloud, “What does this button do?”.
“Why doesn’t that work?"”. “What do you mean it doesn’t do
that?”. “"HELP!". At the start of any new journey or adventure we
are all beginners but fortunately for you we are here to stand
beside you at every stage.

Over this extensive series of titles we will be looking in great
depth at the latest consumer electronics, software, hobbies and
trends out of the box! We will guide you step-by-step through
using all aspects of the technology that you may have been
previously apprehensive at attempting. Let our expert guide help
you build your technology understanding and skills, taking you
from a novice to a confident and experienced user.

Over the page our journey begins. We would wish you luck but
we're sure with our support you won't need it.
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Everything you do online, every time
you power on your smart TV, whenever
you use your in-car GPS, use your phone,
play a game on a tablet, console or PC,
it's all been coded by a group of people.
All these ones and zeros are developed
by those who have learned how to

code, and with this book you too can
learn how to get started on the road to
becoming a programmer.

We cover C++, Python, and Linux
Scripting within these pages. There's

a huge section of project ideas, type-
in listings, and in-depth looks at how
code works. But first, let’s begin with a
good foundation.
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Belng a Programmer

Programmer, developer, coder, they're all titles For the same occupation, someone who
creates code. What they're creating the code for can be anything from a video game

to a critical element on board the International Space Station. How do you become a
programmer though?




( Being a Programmer

MORE THAN CODE

For those of you old enough to remember the ‘80s, the golden era of home
computing, the world of computing was a very different scene to how it is
today. 8-bit computers that you could purchase as a whole, as opposed to
being in kit form and you having to solder the parts together, were the stuff
of dreams; and getting your hands on one was sheer bliss contained within
a large plastic box. However, it wasn't so much the new technology that
computers then offered, moreover it was the fact that for the first time
ever, you could control what was being viewed on the ‘television'.

. Instead of simply playing one of the thousands of games available at the
Times have changed since programming in the ‘80s, time, many users decided they wanted to create their own content, their
but the core values still remain. - own games; or simply something that could help them with their homework
. or home finances. The simplicity of the 8-bit home computer meant that
creating something from a few lines of BASIC code was achievable and so

i ]
It S U p to yOU the first generation of home-bred programmer was born.

From that point on, programming expanded exponentially. It wasn’t long

h OW Fa r to ta ke before the bedroom coder was a thing of the past and huge teams of

designers, coders, artists and musicians were involved in making a single
game. This of course led to the programmer becoming more than simply

yo U r CO d i n g someone who could fashion a sprite on the screen and make it move at the

press of a key.

a d Ve n t U re ! - Naturally, time has moved on and with it the technology that we use.

However, the fundamentals of programming remain the same; but what
exactly does it take to be a programmer?

#include<stdio.h>

#includecdos.h> - The single most common trait of any programmer, regardless of what
Shchudscconocfe - they're doing, is the ability to see a logical pattern. By this we mean
— . someone who can logically follow something From start to finish and
textbackground(15); - envisage the intended outcome. While you may not feel you're such a
window(18,2,7,3); - person, it is possible to train your brain into this way of thinking. Yes, it
cprintf(“Press X to Exit, Press Space to Jump"); : . . . . . .
e (8,208,303, - takes time but once you start to think in this particular way you will be able

window(1,25,80,25); - ko construct and follow code.

for(int x=08;x<79;x++)
cprintf(“n");

extcolor(@); : : ‘ ’
g . Second to logicis an understanding of mathematics. You don't have to be
int t,speed=40; . ata genius level but you do need to understand the rudiments of maths.
void ds(int jump=0) : 8 :
E e o - Maths s all about being able to solve a problem and code mostly falls under
- ' - the umbrella of mathematics.
1f{]::gf=ﬁ}

else if(jump==2)

vt L, Being able to see the big picture is certainly beneficial for the modern

window(2,15-t,18,25); - programmer. Undoubtedly, as a programmer, you will be part of a team

cprintf(' i ;

cprint#(* mwAnAAAAM" ) of other programmers, and more than likely part of an even bigger team
cprintf(" nnnanann™); . " . .

cprintf(" naanAnAA" ) ; of designers, all of whom are creating a final product. While you may only
cprintf(" n mnnnannn *);

be expected to create a small element of that final product, being able to

cprintf (" nnm mnannnnmmm ") ;
cprintf (" nannnnannnnn n "

- - -

- - - ]
e T it S i it Sl il et
e imae s as im L™ L] Lo

cprinte( * anannn und?rsta_nd what everyone el‘se is duipg will hel|? you create sorpethinr_:!
EEE:EE: nnn o that's ultimately better than simply being locked in your own coding cubicle.
}else if(a==1) :
ipr;nm “  naan oo )3 - Finally, there's also a level of creativity needed to be a good programmer.
e L - Again though, you don't need to be a creative genius, just have the
e ise Atin5) - imagination to be able to see the end product and how the user will interact
iprintF{” nnM nn b ? UUitrlit‘
:Eiintf{“ nm "); f
printe(" “); . There is of course a lot more involved in being a programmer, including
Wil o - learning the actual code itself. However, with time, patience and the
gy determination to learn, anyone can become a programmer. Whether
Being able to follow a logical pattern and . you want to be part of a triple-A video game team or simply create an
see an end result is one of the most valued - automated routine to make your computing life easier, it's up to you how

skills of a programmer. far to take your coding adventure!
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A Brief History of Coding

It's easy to think that programming a machine to automate a process or calculate a value
is @ modern concept that's only really happened in the last Fifty years or so. However,
that assumption is quite wrong, coding has actually been around for quite some time.
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Essentially all forms of coding are made up of ones and zeros, on or off states. This works for a modern computer
and even the oldest known computational device.
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It's difficult to pinpoint an exact . >
start of when humans began to 2 *
‘program’ a device. However, : 3
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it's widely accepted that the
Antikythera Mechanism is possibly
the Ffirst ‘coded’ artefact. It's
dated to about 87 BC and is an
ancient Greek analogue computer
and orrery used to predict
astronomical positions.

Joseph Marie Jacquard invents a
programmable loom, which used cards with
punched holes to create the textile design.
However, it is thought that he based his
design on a previous automated weaving
process from 1725, by Basile Bouchon.
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mathematician, Francis
Maneclang, regarding
Charles Babbage’s
Analytical Engine. She
made copious notes
within her writing,
detailing a method of
calculating Bernoulli
Numbers using the
engine. This is recognised
as the First computer
program. Not bad,
considering there were
no computers available at
the time.
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The Banu Musa brothers, three Persian
scholars who worked in the House of
Wisdom in Baghdad, published the
Book of Ingenious Devices in around
850 AD. Among the inventions listed
was a mechanical musical instrument,

a hydro-powered organ that played
interchangeable cylinders automatically.
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During the Second World War,
there significant advances
were made in programmable
machines. Most notably, the
cryptographic machines used
to decipher military codes
used by the Nazis. The Enigma
was invented by the German
engineer Arthur Scherbius
but was made famous by Alan
Turing at Bletchley Park’s
codebreaking centre.
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The First true computer code was
Assembly Language (ASM) or
Regional Assembly Language.
ASM was specific to the
architecture of the machine

it was being used on. In 1951

programming languages Fell under

the generic term Autocode. Soon
languages such as IPL, FORTRAN
and ALGOL 58 were developed.
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the mid-sixties.
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INPUT
PRINT
FEM

INPUT

9§ =

FOR I

e
=1

"Hello

IFIHT'hE
REN

| INPUT

80 IF LEN(AS) =
At = LEFTs (Ag, 1)
IF [A§ =
PRINT "Goodbye ":
FOR I = 1 TD 200

30 PRINT Ug; ™ "

0 NEXT I
PRINT
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Admiral Grace Hopper was part of

the team that developed the UNIVAC

| computer and she eventually
developed a compiler for it. In time,
the compiler she developed became
COBOL (Common Business-oriented
Language), a computer language that's
still in use today.

Computer programming was
mainly utilised by universities,
the military and big
corporations during the ‘60s
and the ‘70s. A notable step
toward a more user-friendly,
or home user language, was
the development of BASIC
(Beginners All-purpose
Symbolic Instruction Code) in

“What 13 your name:
" U§

"How many stars do you want: ";
I

"Do you want more stars?
0 THEN GOTO 70

¥") OR (A§ =

F
EENNESR |
o B
1 '
A

U BN BN BN

S0 F O P P AP RFEAREFREETEENREARRRRETFREERRERRREEE

rr: [JE

r:: Jﬂ$

“y') THEN GOTO 30

'IIIrilbIr‘d'I-.ﬂtE:

From the 1970s, the development of the likes of C, SQL, C with
Classes (C++), MATLAB, Common Lisp and more came to the
fore. The ‘80s was undoubtedly the golden age of the home
computer, a time when silicon processors were cheap enough
for ordinary folk to buy. This led to a boom in home/bedroom
coders with the rise of 8-bit machines.
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%%
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Scheme

C+

ActionScripb 8

MATLAB

:

= Pascal
o

The Internet age brought a wealth

of new programming languages and
allowed people access to the tools and
xnowledge needed to learn coding in a
better way. Not only could a user learn
now to code but they could freely share
their code and source other code to
improve their own.
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Choosing a
Programming

| anguage

It would be impossible to properly
explain every programming language in
a single book of this size. New languages
and ways in which to ‘talk’ to a computer
or device and set it instructions are being
invented almost daily; and with the
onset of quantum computing, even more
complex methods are being born. Here

is a list of the more common languages
along with their key features.
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SQL - SQL stands for Structured Query Language. SQL is a standard language
for accessing and manipulating databases. Although SQL is an ANSI
(American National Standards Institute) standard, there are different versions of
the SQL language. However, to be compliant, they all support at least the major
commands such as Select, Update and Delete in a similar manner.

JavaScript (often shortened to JS) is a lightweight,
interpreted, object-oriented language with first class
functions. JavaScript runs on the client side of the web, that can be used to design
or program how the web pages behave on the occurrence of an event. JavaScript is
an easy to learn and also powerful scripting language, widely used For controlling
web page behaviour.
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- Java is the foundation for virtually every type of networked
application and is the global standard For developing enterprise
software, web-based content, games and mobile apps. The two main components

of the Java platform are the Java Application Programming Interface (API) and the
Java Virtual Machine (JVM) that translates Java code into machine language.

C# is an elegant object-oriented language that enables developers to
build a variety of secure and robust applications that run on the .NET
Framework. You can use C# to create Windows client applications, XML Web services,
client server applications, database applications and much more. The curly-brace
syntax of C# will be instantly recognisable to anyone familiar with C, C++ or Java.

Python is a widely used high level programming language used
for general purpose programming, created by Guido van
Rossum and First released in 1991. An interpreted language, Python has a design
philosophy that emphasises code readability and a syntax that allows programmers
to express concepts in fewer lines of code. This can make it easier for new
programmers to learn.

C++ (pronounced cee plus plus) is a general purpose programming
language. It has imperative, object-oriented and generic programming
features. It was designed with a bias toward system programming and embedded,
resource-constrained and large systems, with performance, efficiency and Flexibility
of use as its design highlights.

Ruby is a language of careful balance. Its creator, Yukihiro “Matz”
Matsumoto, blended parts of his fFavourite languages (Perl, Smalltalk,
Eiffel, Ada and Lisp) to Form a new language. From its release in 1995, Ruby has
drawn devoted coders worldwide. Ruby is seen as a flexible language; essential
parts of Ruby can be removed or redefined, at will. Existing parts can be added to.
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- Perlis a general purpose programming language, used for a wide
range of tasks including system administration, web development,
network programming, GUI development and more. Its major features are that it's
easy to use, supports both procedural and object-oriented (OO) programming, has

powerful built-in support for text processing and has one of the most impressive
collections of third-party modules.

Swift is a powerful and intuitive programming language for macOS,
i0S, watchOS and tvOS. Writing Swift code is interactive and fun;
the syntax is concise yet expressive and Swift includes modern features that
developers love. Swift code is safe by design, yet also produces software that runs
lightning fast. A coding tutorial app, Swift Playgrounds, is available for the iPad.
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Creating a Coding

Platform

The term ‘Coding Platform’ can signify: a type of hardware on which you can code,

a particular operating system, or even a custom environment that's pre-built and
designed fFor easy game creation. In truth it's quite a loose term, as a Coding PlatFform
can be a mixture of all of these ingredients, it's simply down to which programming
language you intend to code in and what your end goals are.

P ]

from dijango.contrib.auth.qecs

from dijango.contrib.admin.views.os
rom django.core.exceptions
from django.ntip Htiprespons
from django.contrib.auth
from diango.contrib.auth.models

from django.core.paginator
from djangn.tnre.urlreznluers
settings

from django.conf
ﬂ' sum, "

f rom diangn.dh.mndels

¢ messages

f rom djanqn.tuntrih
date, ximede\lta

from datetime impor
LML W r'e Te

¢rom . models import *

= "There are SonNc errors, o

3 HARDWARE

Thankfully, coding at the
Foundation level doesn't
require specialist equipment,
or a top of the range, liquid
hydrogen-cooled PC. If

you own a computer, no matter how basic, you can begin to
learn how to code. Naturally, if Ehe computer in question is a
Commodore 64 then you may have some difficulty following a
modern language tutorial, but some of the best programmers
around today started on an 8-bit machine, so there's hope yet.

You will need access to the Internet to download, install and
update the coding development environment, alongside a
computer with Windows 10, macOS, or Linux, installed. You
can use other operating systems, but these are the ‘big three’
and you will find that most code resources are written with
one, or all, of these in mind.

Coding can be one of those experiences that sounds fantastic,

but is often confusing to tackle. After all, there’s a plethora

of languages to choose from, countless apps that will enable

you to code in a specific, or range, of languages and an equally
huge amount of third-party software to consider. In addition, by
accessing the Internet, you will discover that there are countless
coding tutorials available for the language in which you've decided
you want to program, alongside even more examples of code. It's
all a little too much at Ffirst.

The trick is to slow down and, to begin with, not look too deeply
into coding. Like all good projects, you need a solid foundation
on which to build your skillset and to have all the necessary tools
available to enable you to complete the basic steps. This is where
creating a coding platform comes in, as it will be your learning
foundation while you begin to take your first tentative steps into
the'wider world of coding.

M SOFTWARE

In terms of software, |
most of the development
environments have the
tools that allow you to
code, compile the code
and execute it, freely
available to download and install. There are some specialist
tools available that will cost, but at this level they're not
necessary, so don't be fooled into thinking you need to purchase
any extra software in order to start learning how to code.

Over time, you may find yourself progressing from the
mainstream development environment and using a collection
of your own, discovered, tools to write your code. It's all
personal preference in the end and as you become more
experienced, you will start to use different tools to get the
job done.
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OPERATING SYSTEMS

Windows 10 is the most widely used operating system in the
world, so it's natural that the vast majority of coding tools are
written For Microsoft's leading operating system. However,
don't discount macOS and especially Linux.

I I
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- macOS users enjoy an equal number of coding tools to their ‘

. Windows counterparts. In fact, you will probably find that a

lot of professional coders use a Mac over a PC, simply because

- of the fact that the Mac operating system is built on top of

- Unix (the command-line OS that powers much of the world's
Filesystems and servers). This Unix layer lets you test programs

- in almost any language without using a specialised IDE.

However, Linux is, by far and away, one of the most popular

- and important coding operating systems available. Not only

. does it have a Unix-like backbone, it's also free to download,

- install and use and comes with most of the tools necessary to
start learning how to code. Linux powers most of the servers
that make up the Internet. It's used on nearly all of the top
supercomputers, as well as specifically in organisations such
as NASA, CERN and the military, it also Forms the base of
Android-powered devices, smart TVs and in-car systems. Linux,
- asacoding platform, is an excellent idea and it can be installed
inside a virtual machine without ever affecting the installation
of Windows or macOS.
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VIRTUAL MACHINES

Avirtual machine is a piece of software that allows you to install a

fully working operating system within the confines of the software
itself. The installed OS will allocate user-defined resources from the
host computer, providing memory, hard drive space etc., aswellas
sharing the host computer’s Internet connection.

The advantage of a virtual machine is that you can work with
Linux, For example, without it affecting your currently installed
host OS. This means that you can have Windows 10 running and
launch your virtual machine client, boot into Linux and use all
the functionality of Linux, while still being able to use Windows.

This, of course, makes it a fantastic coding platform, as you can
have different installations of operating systems running from
the host computer while using different coding languages.
You can test your code without fear of breaking your host OS
and it's easy to return to a previous configuration without the
need to reinstall everything again.

Virtualisation is the key to most big companies now. You
will probably find, rather than having a single server with an :
installation of Windows Server, for example, the IT team have
instead opted for a virtualised environment whereby each
Windows Server instance is a virtual machine running from
several powerful machines. This cuts down on the number

of physical machines, allows the team to better manage
resources and enables them to deploy an entire server
dedicated to a particular task in a fraction of the time.
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THE RASPBERRY PI

YOUR OWN CODING PLATFORM

If you haven't already heard of the Raspberry Pi, then we

suggest you head over to www.raspberrypi.org and check
it out. In short, the Raspberry Pi is a small, fully functional
« computer. It comes with its own customised, Linux-
based operating system that's pre-installed with
everything you need to start learning how to
code in Python, C++, Scratch and more.

B B BN OB OB OB OB A

Costing around £35, it's incredibly
cheap and allows you to utilise
different hardware, in

the Form of robotics and
electronics projects, as well

as offering a complete desktop
experience. Although not the most
powerful computing device in the world, the
Raspberry Pi has a lot going for it, especially in terms
of being one of the best coding platforms available.

| B O B BN B OB

8 & 8 B

LI

llllllllllllllllllllllllllllllllllllllllllllllllllllllllllllllll

Whichever method you choose, remember that your coding
platform will probably change, as you gain experience
and favour one language over another. Don't be
afraid to experiment along the way, as
you will eventually create your
own unique platform that
can handle all the code
you enter into it.
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C++

C++ is an amazing programming language. Most
of what you see in front of you when you power
up your computer, regardless of whether you're
using Windows, macOS or Linux, is created
using C++. Being able to code in C++ will open a
whole new world for you, in terms of desirable
professional skills and the ability to code
amazing apps and games.

C++ is an efficient and powerful language
that's used to develop operating systems,
applications, games and much more. It's used in
science, engineering, banking, education, the
space industry, and much more.

[plugele[Vlalple
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Why C++7?

C++ is one of the most popular programming languages available today. Originally

called C with Classes, the language was renamed to C++in 1983. It's an extension of
the original C language, and is a general purpose object-oriented (OOP) environment.

C EVERYTHING

Due to both the complexity of the language and its power and performance, C++ is often used to develop games, programs,

device drivers, and even entire operating systems.

Dating back to 1979, the start of the golden era of home
computing, C++, or rather C with Classes, was the brainchild of
Danish computer scientist Bjarne Stroustrup, while working on
his Ph.D. thesis. Stroustrup’s plan was to further the original C
language, which had been widely used since the early seventies.

C++ proved to be popular among the developers of the 80s, since

it was a much easier environment with which to get to grips,

and, more importantly, it was 99% compatible with the original C
language. This meant that, beyond the mainstream computing labs,
reqular people who didn't have access to the mainframes and large
computing data centres could use it.

C++'simpactin the digital world is immense. Many of the programs,
applications, games, and even operating systems are coded

C

C++ code is much Faster than other
programming languages.

M “screenthotepp - Code=Blocks 17.12
File Edit View Search Project Busld Dlhuq Forran  wxSmith Tools Tools= F‘Iugin: DoxyElocks Sﬂling: Help
I feB8 «d KDL AR drsoB

i BB RIFE (M= i e D vl Lobhn -0 |

EirEGI L o BN

using C++. For example, all of Adobe’s major applications, such as
Photoshop, InDesign and so on, are developed in C++. You will find
that the browser you use to surf the Internet is written in C++, as
well as Windows 10, Microsoft Office, and the backbone to Google's
search engine. Apple's macOS is written largely in C++ (with some
other languages mixed in depending on the function), and the likes
of NASA, SpaceX, and even CERN use C++ for various applications,
programs, controls, and umpteen other computing tasks.

As well as being an easier addition to the core C language, C++ is
also extremely efficient and performs well across the board. This
higher level of performance over other languages, such as Python,
BASIC and such, makes it an ideal development environment for
modern computing; hence the aforementioned companies using it
so widely.
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Installing - Visual Studio Community 2017 (15.0.26223.1) X
Workloads Individual components Language packs
Windows (3) Summary
Universal Windows Platform development ﬁ .NET desktop development X DESktDp dEVE|DpI’T‘!E'I'"|I with C
Create applications for the Universal Windows Platform with C=, Build WPF, Windows Forms and console applications using the
VB, JavaScript, or optionally C++. NET Framework. Included
v Visual C++ core desktop features
Optional
¥y Desktop development with C++
|1_j Build classic Windows-based applications using the power of the VC++ 2017 v141 toolset (x86,x64]
Visual C++ toolset, ATL, and optional features like MFC and... ¥ C++ profiling tools
Windows 10 SDK (10.0.14393.0)

Visual C++ tools for CMake
Visual C++ AlL support
Windows 8.1 SDK and UCRT SDK

Web & Cloud (4)

ASP.NET and web development C& Azure development Windows XP support for C++
‘(E;) Build web applications using ASP.NET, ASP.NET Core, HTML, Azure SDK, tools, and projects for developing cloud apps and MFC and ATL support (x86 and x64)
JavaScnpt, and CSS, creating resources.

= = 4
L++/CLI support

i | " ot [ [P - I
Liang/Lc (expenmenial)

Standard Library Modules

ElS Node.js development Data storage and processing i el
] i * 1 Wi — 0 th nse forth
Build scalable network applications using Node,js, an asynchronous Connect, develop and test data solutions using SQL Server, Azure & By continuing, you agree to the license for the
. . e Visual Studio edition you selectad. We also offer the
event-driven JavaScript runtime. Data Lake, Hadoop or Azure ML

ability to downioad other software with Visua
Studio. This software is licensed separately, as sat
out in the 3rd Party Notices or in its accompanying
icense, By continuing, you aiso agree to those
Mobile & Gaming (5) llcenses.

Microsoft’s Visual Studio is a great, free
environment in which to learn C++.

C++ puts the developer in a much wider world of coding. By improvements to the engine, or when creating a new game, if
mastering C++, you will find yourself being able to develop code for  the developers want to add something that the engine can’t do,
the likes of Microsoft, Apple and so on. Generally, C++ developers they will use C++ to create the new content or link between two
enjoy a higher salary than programmers of some other languages, different engines. The end result, of course, is a game that contains
and, due to its versatility, the C++ programmer can move between the latest graphical technology, while being seamlessly bound

jobs and companies without the need to re-learn anything specific. together with some pretty clever C++ coding.

You will discover, as you become a more advanced coder, that many  Getting to use C++ is quite easy, all you need is the right set of tools
of the developers in various coding jobs around the world tend to in which to communicate with the computer in C++, and you can
use pre-designed development engines. For example, when creating start your journey. A C++ IDE is free of charge, even the immensely
games, the likes of Bethesda, the team behind Oblivion and Skyrim,  powerful Visual Studio from Microsoft is freely available to

utilise a 3D game engine called The Creation Engine. This enables download and use. You can get into C++ from any operating system,
the team to quickly create animations, characters, items, terrains, be it macOS, Linux, Windows, or even mobile platforms.

rooms, and just about everything else you'd see in the game. The

engine itself has been modified to make the most of the current So, to answer the question of Why C++, the answer is because it's fast,
graphics card hardware, and computer or console processing efficient, and developed by most of the applications you regularly
power. These engines are mostly written in C++, and when making use. It's cutting edge, and a fantastic language to have mastered.

Indeed, the operating system
you're using is written in C++.

Windows 10

s e Mac

ubuntu
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C++ is one of the top
programming languages
in the industry. It's quick,
powerful, and used by
nearly every major tech
and gaming company in
the world. Here's some
interesting facts about
the rather wonderful C++.

C++is
one of the
predominant
programming
languages for the

development of all
kinds of technical
NASA, CERN, and commercial
MICROSOFT, software.
ORACLE, PAYPAL,

LINKEDIN, AMAZON AND |
THE MILITARY USE C++.

oo 00O OO OOOOSTOOOOOSTOOBDTOODES OGO OOODS

C++ IS USED FREQUENTLY
IN ANIMATION PROCESSES.

influenced other
programming

languages, such as

C# and Java.

MODELLING,

SR, ~*° SIMULATIONS
ALL UTILISE C++.

A lot of the
Linux operating
system is coded
using C++, therefore
you could say that most

of the world’s Internet
hosting servers are
available thanks to C++. )/J
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SUPERCOMPUTING USES C++ CODE More than 70% of all

TO CALCULATE VAST AMOUNTS OF R ;Lag:_';z L'.Se 523?;333;9
DATA, INCLUDING THE NASA-BASED (HFT), and the software
SUPERCOMPUTING FARM THAT RUNS responsible is written in
SIMULATIONS OF THE UNIVERSE. C++ to make use of its

high speed.
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Gaming is one of the
biggest users of C++.

o It handles the
Many database applications complexities of 3D games,
are built using C++, such supports multiplayer Google Chrome, Mozilla's

as MySQL, it's also used
by Wikipedia, Yahoo and

options, and enables

I ! Firefox, and even Microsoft'’s
intensive CPU and

Edge web browsers are

YouTube. GPU hardware coded in Cas.
functions. |
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networking as the ' “
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Programmable Logic PERCENTILE SALARY = sta‘;fe '; e ;d :cis _
Controller, connecting FOR A UK-BASED C++ ; are developed |
servers, processors, other DEVELOPER IS D using Cor.
hardware, and Do, '

even robotics.

£120,000

MRI scanning

machines and
Windows 95, 98, 2000, Computer Aided Design The Unreal 4 Engine,
XP,7,8.1and 10, as well as all use C++ to help with which is coded in C++,
Microsoft OFFice, use C++ the enhanced imagery is used for hundreds
as the backbone programming produced by these of games, including

language of choice. Fortnite.

systems.
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FLIGHT CONTROL SYSTEMS IN
MODERN AIRCRAFT, INCLUDING
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Fquipment You

Will Need

You don't need to invest a huge amount of money in order to learn C++, and you

don't need an entire computing lab at your disposal either. Providing you have a fairly
modern computer, everything else is freely available.

C++ SETUPS

As most, if not all, operating systems have C++ at their code, it stands to reason that you can learn to program in C++ no
matter what OS you're currently using.
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COMPUTER

Unless you fancy writing out your C++ code by hand on a sheet of paper (which is
something many older coders used to do), then a computer is an absolute must have
component. PC users can have any recent Linux distro or Windows OS, Mac users the
latest macOS.

AN IDE

An IDE is used to enter and execute your C++ code. Many IDEs come with extensions
and plugins that help make it work better, or add an extra level of functionality.
Often, an IDE will provide enhancements depending on the core OS being used,
such as enhancements for Windows 10.

COMPILER

A compiler is a program that converts the C++ language into binary that the
computer can understand. While some IDEs come with a compiler built in, others
don’t. Code::Blocks is our favourite IDE that comes with a C++ compiler as part of the
package. More on this later.

TEXT EDITOR

Some programmers much prefer to use a text editor to assemble their C++ code
before running it through a compiler. Essentially, you can use any text editor to write
code, just save it with a .cpp extension. However, Notepad++ is one of the best code
text editors available.

INTERNET ACCESS

While it's entirely possible to learn how to code on a computer that's not attached
to the Internet, it's extraordinarily difficult. You will need to install the relevant
software, keep it up to date, install any extras or extensions, and look for help when
coding. All of which require access to the Internet.

TIME AND PATIENCE

You're going to need to set aside significant time to spend on learning how to code
in C++. Sadly, unless you're a genius, it's not going to happen overnight, or evenin a
week. A good C++ coder has spent many years honing their craft, so be patient, start
small and keep learning.
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OS SPECIFIC NEEDS

C++ will work in any operating system; however, getting all the necessary pieces together can be confusing to a newcomer. Here's
some OS specifics for C++.

L I BN BN BE BN BN B BT BN BE BN OB B BN B BN BE BN BN BN BN BN BN BN N BN AR BN BN BN O BE BN O B BN BN BN B BE BE BN OB B AR BN BN BN BN BN OB BN O BE BN B I BN B BN OB N N

LINUX

Linux users are lucky in that they already have a compiler and
text editor built into their operating system. Any text editor
will allow you to type out your C++ code, when it's saved with
a .cpp extension, use g++ to compile it.
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As we've mentioned previously, one good IDE is Microsoft's
Visual Studio. However, a better IDE and compiler is
Code::Blocks, which is kept regularly up to date with a new
release twice yearly, or so. Otherwise, Windows users can
enter their code in Notepad++ then compile it with MinGW —
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The Raspberry Pi's operating

MAC

Mac owners will need to

S =

system is Raspbian, which is
Linux based. Therefore, you're
able to write your code out
using a text editor and then

download and install Xcode,
in order to compile their
C++ code natively. Other
options for the macOS

include Netbeans, Eclipse or
Code::Blocks. Note: the
latest Code::Blocks isn't
available for Mac, due to a
lack of Mac developers.
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Structure of C++ Code

C++is an amazing programming language to learn. If your dream is to become a games

designer, or work at the cutting edge of science or engineering technology, then being
able to code in C++ is a must. Remember, you're never too old to learn how to code.

#INCLUDE <C++ IS ACE!>

As you learn the basics of programming, you will begin to understand the structure of a program. The commands may be

different, but you will start to see how the code works.

#INCLUDE

The structure of a C++ program
can look complex, but once you

* Danish student Bjarne
*  Stroustrup invented C++ in

+ 1979, as a part of his Ph.D.
thesis. Initially C++ was called
C with Classes, which added
features to the already popular
C programming language

begins with a directive, #include
<>, The directive instructs the
pre-processor to include a
section of the standard C++
- while making it a more . code. For example: #include
. user-friendly environment. . <iostream> includes the

: iostream header to support
Bjarne Stroustrup, inventor iInput/output operations.
- Of C++. .

INT MAIN()

+ int main() initiates the
declaration of a function, which
. isagroup of code statements
under the name ‘main’. All

C++ code begins at the main
function, regardless of where

it lies within the main body of
the code.

get familiar with it you'll begin to
see how it flows. Every C++ code

iiiiiiiiiiiiiiiiiiiiiiiiiiiiiii

v *newcode.cpp (~/D
File Edit View Search Tools Documents Help

POG | ~v|Xx08B|Q

c’| *newcode.cpp X

#include <iostream=
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v *newcode.cpp (~/D
File Edit View S5Search Tools Documents Help

ﬂﬁﬂi|nu|2|_ﬂﬂ Q,

c’| *newcode.cpp

#include <iostream>

int main()
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BRACES v

The open brace is
something that you may

not have come across _||:| ij Di | o RS | | E |_|:| ﬂ

*newcode.cpp (~/Documents) -
File Edit View Search Tools Documents Help

S

before, especially if
you're used to other
coding languages. The
open brace indicates the
beginning of the main
function, and contains » ,
all the code belonging to int main()
that function. 1

¢’ *newcode.cpp X

#include =<iostream=
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COMMENTS

Lines that begin with a double slash are comments. This means they
won't be executed in the code and are ignored by the compiler. Why
are they there? Comments are designed to help you, or another
programmer looking at your code, explain what's going on. There
are two types of comment: /* covers multiple line comments, // a
single line.

LB BE BN BN BE BN BN O BN BN B RE BN BN B BN OB BN

v *newcode.cpp (~/Documents)
File Edit View Search Tools Documents Help

NoenG ~v Y08 QQ

C | *newcode.cpp X ‘

#include <iostream>

int main()

{
// My first C++ program!

STD

In C++, STD means Standard. It's a part of the Standard Namespace
in C++, which covers a number of different statements and
commands. You can leave the std part out of a code, but it must be
declared at the start with: using namespace std.

v *newcode.cpp (~/Documents)
File Edit View Search Tools Documents Help

Ao ~- YO8 QQ

| *newcode.cpp X |

#include <iostream=
using namespace std;

int main()

{
// My first C++ program!

COUT

In this example we're using cout, which is a part of the Standard
Namespace — hence why it's there, as you're asking C++ to use it from
that particular namespace. Cout means Character OUTput, which
displays, or prints, something to the screen. If we leave std: : out we
have to declare it at the start of the code; as mentioned previously.

v *newcode.cpp (~/Documents)
File Edit View Search Tools Documents Help

Ao% ~v X008 QQ

c’| *newcode.cpp X

#include <iostream>

int main()

{
// My first C++ program!
std: :cout |

< Structure of C++ Code
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The two chevrons used here are insertion operators. This means
that, whatever follows, the chevrons are to be inserted into the
std::cout statement. In this case, they are the words ‘Hello World',
which are to be displayed on the screen when you compile and
execute the code.

v *newcode.cpp (~/Documents)

File Edit View Search Tools Documents Help
PG ~w Y08 QQ

‘@' *newcode.cpp X |
|

#include <iostream>
int main()

1
i ) HY first C++ prggram!
‘ std::cout << ("Hello World!\n")

OUTPUTS

Leading on, (“Hello World!”) is the part that we want to appear on
the screen when the code is executed. You can enter whatever you
like, as long as it's inside the quotation marks. The brackets aren't
needed, but some compilers insist on them. The \n part indicates a
new line is to be inserted.

/f My first C++ program!
std: :cout << ("Hello World!\n"})

- AND }

Finally you will notice that lines within a function code block
(except comments) end with a semicolon. This marks the end of
the statement, and all statements in C++ must have one at the end
or the compiler will fail to build the code. The very last line has the
closing brace to indicate the end of the main function.

File Edit view Seanth Tools Documents Help
AO@% ~- ¥X©0O Qa

¢ | newcode.cpp M

#Finclude <iostresm
” - david®mint-mat
?“ i File kot view Search lerminal Help
ff My Tirst Cis progrom! }

std::cout == (“Hello World!\n™):
I




</> Introducing C++

How to Set Up
C++ in Windows

Windows users have a wealth of choice when it comes to programming in C++. There
are loads of IDEs and compilers available, including Visual Studio from Microsoft.
However, in our opinion, the best C++ IDE to begin with is Code::Blocks.

CODE::BLOCKS

Code::Blocks is a free C++, C and Fortran IDE that is Feature rich and easily extendible with plugins. It's easy to use, comes with

a compiler and has a vibrant community behind it too.
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Start by visiting the Code::Blocks download site, at
www.codeblocks.org/downloads. From there, click

STEP 1

on the ‘Download the binary releases’ link to be taken to the latest
downloadable version for Windows.
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There you can see, there are several Windows
versions available. The one you want to download

STEP 2

has mingw-setup.exe at the end of the current version number. At
the time of writing this is: codeblocks-17.12mingw-setup.exe. The

difference is that the mingw-setup version includes a C++ compiler
and debugger from TDM-GCC (a compiler suite).

1. Windows XP / Vista / 7/ 8.x/ 10:

q
File

codeblocks-17 12-setup exe 30 Dec |
codeblocks-17_12-setup-nonadmin_exe 30 Dec :
codeblocks-17_12-nosetup.zip 30 Dec :
codeblocks-17 12mingw-setup exe 30 Dec |
codeblocks-17 12mingw-nosetup zip 30 Dec §
codeblocks-17_12mingw_fortran-setup axe 30 Dec :

NOTE: The codeblocks-17 12-setup exe file includes Code: Blocks with all plugins. The codeblocks-17 12-setup-nonadmin exe file is provided for corveni

NOTE: The codeblocks-17 12mingw-setup exe file includes addiionally the GCC/G++ compiler and GDB debugger from TDM-GCC (version 5.1.0, 32 bit,
(TOM-GCC)

MNOTE: The codeblocks-1/.12(mingw)-nosetup zip files are prowded for convenience to users that are allergic aganst installers. However, it will not allow
“installation” you are on your own

if unsure, please use codeblocks-17. 12mingw-selup. axel

STEP 3 When you've located the file, click on the
Sourceforge.net link at the end of the line and a
ownload notification window appears; click on Save File to start
he download and save the executable to your PC. Locate the
ownloaded Code::Blocks installer and double-click to start. Follow
ne on-screen instructions to begin the installation.

C
C
C
C

& Code:Blocks Installation —

Welcome to CodeBlocks Setup

Setup will guide you through the installation of CodeBlocks.

It is recommended that you dose all other applications
before starting Setup. This will make it possible to update
relevant system files without having to reboot your
computer,

Click Next to continue.

STEP 4 Once you agree to the licencing terms, a choice of
installation options becomes available. You can opt
for a smaller install, missing out on some of the components but we
recommend that you opt for the Full option, as default.

{":j _ode:Blocks Installatic

@l —

Choose Components
Choose which features of CodeBlodcks you want to install.

Check the components you want to install and uncheck the components you don't want to
install. Click Next to continue.

Select the type of install:  Full: All plugins, all tools, just everything v

Or, select the optional - [v] Default install A
Funu:unmts you wish to @-[¥] Contrib Plugins
install:
C::B CBP2Make
C::B CC Test
C::B Share Config
C::B Launche

: Fal aar  amvimn im B - W

Description

FOSICION Your mouse oy

SN A S

Space required: 253.4MB

er a component to see its
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STEP 5

Next choose an install location for the Code::Blocks
files. It's your choice but the default is generally
sufficient (unless you have any special requirements of course).
When you click Next, the install begins; when it's finished a
notification pops up asking you if you want start Code::Blocks now,
so click Yes.

Create shortcut: C:\Users\david\AppData\Roaming \Microsoft\Windows\Start Menu\Proagrams)

Exrxt: gdmlt' t'—',’ { ode'Block= In<tallation | ]
Output folder: ¢ R T ——

Extract: gfdl. 7.,
Extract: gpl.7../|
Output folder: ¢
Output folder: ¢
Created uninsta | Yes 1 | No

Output folder: ¢ ' enu'Pro...
Create shortcut: C:\WUsers\david\AppData\Roaming \Microsoft\Windows\Start Menu'p... ,

o Do you want to run Code::Blocks now?

I

Jullsoft Install System v3.02,1
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The first time Code::Blocks loads it runs an
autodetect for any C++ compilers you may already
have installed on your system. If you don’t have any, click on the
first detected option;: GNU GCC Compiler and click the Default
button to set it as the system’s C++ compiler. Click OK when you're
ready to continue.

_ompilers auto-detection L]

Note: After auto-detection, at least one compiler's master path is still empty and therefore invalid.
Inspect the list below and change the compiler's master path later in the compiler options.
Select you favourite default compiler here:

Status A | [Sctasdefmit | |

Detected

‘ Compiler
GNU GCC Compiler

v

STEP 7

The program starts and another message appears
informing you that Code::Blocks is currently not
the default application for C++ files. You have two options, to leave
everything as it is or allow Code::Blocks to associate all C++ File
types. Again, we would recommend you opt for the last choice, to
associate Code::Blocks with every supported file type.

- i

Hedepge 17 12 rew 11256 (2A017-12-28 10-44°41 ) gee 5 1.0 Windows enicods - 37 bl

[

_—— Al . "“\;’mrnu
iCode::Blods is ourrently not Bhe default applcaton for CjC++ source fies,
Do you want to set it as default?

Tow can abvavs change assocations Fom the environment settings later,

("IN, leave sverything as it i

()Mo, leave everything a5 it & (but ask me sgain next time)

Iﬂ'rr_:., assodate Code: :Dlodks with CC++ fle bypes

() Yes, associate Code: Blocks with every supported type (induding project fles from other IDEs)

(¥4

IR = ZUTT T O DTS TR

Extract: fsf-funi |

< How to Set Up C++ in Windows </>

L B O BN BN BN BN BN B BN B BN IR BN BN B BN BN BN BN BN BN BN BN AL BN BN B BN BN BE BN BN BN BN BN AR BN BN B BN BN AL BN B BN B BN OB B BN AR B BN BE BN BN ON I BN AN B N B

There’s a lot you can do in Code::Blocks, so you need
to dig in and find a good C++ tutorial to help you
get the most from it. However, to begin with, click on File > New >
Empty File. This creates a new, blank window for you to type in.

ﬂ *Unititled? - Code=Blocks 17.12
Fie Edit View Sesch Project Bulld Debug Fortran woSmith Took Tools+ Plugins DonyBlodks Settings Help
Empty ile o T SO T T
g Open.. Cul-0 Ulass. __v_ o Ml | C
Drpen with heex edditor Project..
Oyt delaull wunkspave Busid
el I S target_.
Recent files ' e
Custom...

From template...
Maszi Shineidernan diagram

import project ’

B save file Cul-5
[ Savefile as...

Save workspace as...
& Seve eventhing

& Closefile Cirl-W
Close all files Ctrl-Shift-W

Ctrl-Shaft-5

Clesc workspace

iy Print_ Cul-p
Export k
Propesties..

3 qua Cu-Q
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==K Inthenewwindow, enter the Following:

#¥include <iostream>

Int main{()

{
/ /My first C++ program

Std: :cout << “Hello World!\n”;
}

Notice how Code::Blocks auto-inserts the braces and speech quotes.

-

File Edd Veew Search Project Binld Debug Fortan  walereth Tools Toolie Mugmy DowyBlock Settngs  Help

e Ay XnalQALiarson BirEac i i FN;

e PRABRIES < EHT Yidepin DY Y o (] | o e o [
"” | |

f = Earthers X *Untitledl

:1 Frojects  Sywbols Hes ": finclude <isstrsams

ﬂmhpau

ing maini)

oL e L B e

{
fMy fizet C++ progmam
SEO:IEOUE < "Hello Worla'iyn®:

LY =]
-

STEP 10

Click File > Save as and save the code with a
.cpp extension (helloworld.cpp, for example).
Code::Blocks changes the view to colour code according to C++
standards. To execute the code, click on the Build and Run icon
along the top of the screen. It's a green play icon together with a
yellow cog.
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Introducing C++>

How to Set Up C++
on a Mac

To begin C++ coding on a Mac you can use Apple’s own developer platform: Xcode. This

is a free, full featured IDE that's designed to create native Apple apps. However, it's
also able to be used to create C++ code relatively easily.

XCODE

Apple’s Xcode is primarily designed for users to develop apps for macQOS, iOS, tvOS and watchOS applications in Swift or
Objective-C, but we can use it for C++ too.
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STEP 1 Start by opening the App Store on your Mac, Apple STEP 3 When you're ready, click on the Get or cloud icon
Menu > App Store. In the Search box enter Xcode, button which will install the Xcode app. Enter your
and press Return. There will be many suggestions filling the App Apple ID, and Xcode will begin to download and install. It may take

Store window, but it's first option, Xcode, that you need to click on. some time depending on the speed of your Internet connection, as
Xcode is in excess of 11GB.

[ ]
Results for "xcode” Filtars v

¥eoda
N

Results for “xcode” Filters v

Tools for Xcode

iiiiiiii
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STEP 2 Take a moment to browse through the app’s STEP 4 When the installation is complete, click on the Open
information, including the compatibility to ensure button to launch Xcode. Click Agree to the licence
you have the correct version of macOS. Xcode requires macOS terms, and enter your password to allow Xcode to make changes

10.12.6 or later to install and work. to the system. When you've done that, Xcode will begin to install
additional components.

[ 1 App 5to Eaft  Store W h =t

¢ B xcode
=] sharing Emf!.I:!I nu'n-pu:mﬂ:

« Swilft compliers iImproved diagnostics make it much easher to understand coding
mistakes, espacially in SwiftUl coda

Previaw Xcode and i0S SDK License Agreement
: ’ You must agroe 1o both Icense agraemonts below 10 ondor 1o complate

the installation and use Xcode, By i._'l.l:lv.'-ng .ﬁ.gr{r:l_ you ara agresing o
the tarms af the software license agreements

Xcode and Apple SDKs Agreement

PLEASE SCROLL DOWMN AND READ ALL OF THE FOLLOWING TERMS
AND CONDITIONS CAREFULLY BEFORE USING THE APPLE
SOFTWARE OR APPLE SERVICES. THIS IS A LEGAL AGREEMENT
BETWEEN YOU AND AFPLE. IF YOU AGREE TO BE BOUND BY ALL OF
THE TERMS AND CONDITIONS, CLICK THE *AGREE™ BUTTON. BY
CLICKING “AGREE" OR BY DOWHNLOADING, USING OR COPYING ANY
PART OF THIS APPLE SOFTWARE OR USING ANY PART OF THE APPLE
SERVICES, YOU ARE AGREEING ON YOUR OWN BEHALF AND/OR ON
BEHALF OF YOUR COMPANY OR ORGANIZATION TO THE TERMS AND
COMDITIONS STATED BELOW. IF ¥OU DO NOT OR CANNOT AGREE

Zcode inclodes everylhing developers need to create great applcations for Mac, iPhore, iPad,
Apple TV, and Appht Watch, Xcods provioes oevsopers a unified workdiow for uses inlerface ) = Save. Disagree Agree
Wabsita (F)

delign, codng, leiting, and debugging. The Koote IDE combined with the Swill programmng
language maky developng sops easy and fun i
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STEP 5

With everything now installed, including the

additional components, Xcode will launch displaying
the version number along with three choices and any recent projects
that you've worked on — although for a fresh install, this will be blank.

Welcome to Xcode

2.1 (12A7403) No Recent Projects

4 | Create a new Xcode project
Creats an app for iPhore, (Pad, Mac, Apple 'Walch, or Apple TV,

Clone an existing project

Siart working on something Trom a Git reposilory.

Open a project or file
Opan an existing project or Tile on your Mac.

Show this window when Xcode launches

STEP 6 Start by clicking on Create New Xcode Project, this
opens a template window to choose which platform
you're developing code for. Click the macQOS tab, then click the
Command Line Tool option. Click Next to continue.

e D@ =

No Seleaiion

Choose a template for your new project:

Multiplstform 05  mec0S waichDS w05  Other ]
Application
- % =
A | “
)
— il = : F
App Docurment App Game

Framework & Library

g e i
= = i N 7 |
: M
Driverkit Framewaork Library Metal Library XPC Service
Framework
D
Bundla

Cancel Mt

STEP 7 Fillin all the Fields, but ensure that the Language
option at the bottom is set to C++. Simply choose
it from the drop-down list. When you've Ffilled in the fields, and
made sure that C++ is the chosen language, click on the Next
button to continue.

i ¥

A &

No Selection

Choose options for your new project:

Product Name: | C++ Program I

Team: Add account...

Organization ldentifier-
Swift
Objective-C

Linguos S |

C

Bundle ldentifier

C How to Set Up C++ on a Mac </>
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Mac, or a network location, and click the Create button. When
you've done all that, you can start to code. The left-hand pane
details the files used in the C++ program you're coding. Click on the
main.cpp file in the list.

The next step asks where to create a Git Repository
For all your future code. Choose a location on your
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STEP 9

You will notice that Xcode has automatically
completed a basic Hello World program for you.
The differences here are that the int main () Function now contains
multiple functions and the layout is slightly different. This is just
Xcode utilising the content that's available to your Mac.

escwe 0O > =B

W Co+ Program | [ Wy Mac Cas Program: Resdy | fosey &1 1330 4 b EE
mEIIqQASSDLO O B " man e i B 0 a0 =
« B Co+ Program 3 B CoeProgram) I Cot Progeem | — manicpn ) o Selwction
w = Cw Program L
ff  EaLf
L Bmenge Pros
¥ 0 Progucts
rd
lude T
argvll) {

Mo Selechon

STEP 10

When you want to run the code, click on Product >
Run. You may be asked to enable Developer Mode
on the Mac, this is to authorise Xcode to perform functions without
needing your password every session. When the program executes,
the output will be displayed at the bottom of the Xcode window.

| B Ycode File Ed1 Ve
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Hello, werldr
Fregram ended with exil code: @




Introducing C++>

How to Set Up C++

IN Linux

Linux is a great C++ coding environment. Most Linux distros already have the essential
components preinstalled, such as a compiler and the text editors are excellent for

entering code into, including colour coding; there’s also tons of extra software

available to help you out.

LINUX++

There are many different versions of Linux available, for this example we’re using one of the more popular distributions: Linux

Mint. However, these steps will work in any Debian-based Linux.

STEP 1 The first step with ensuring Linux is ready for your
C++ code is check the system and software are
up to date. Open a Terminal and enter;: sudo apt-get update
&& sudo apt-get upgrade. Press Return and enter your
password. These commands updates the entire system and any
installed software.

"‘-

File Edit View Search Terminal
I

sudo apt-get update &
david:

Help

[sudo] p555wnfd for

STEP 2 Most Linux distros come preinstalled with all the
necessary components to start coding in C++.
However, it's always worth checking to see if everything is present,
so still within the Terminal, enter: sudo apt-get install
build-essential and press Return. If you have the right
components, nothing is installed but if you're missing some then
they are installed by the command.

v david@mint-mate ~
File Edit View Search Terminal Help

sudo apt-get install build-essential
B Reading package lists... Done
P Building dependency
P Reading state information... Done
build-essential is already the newest version (12.1lubuntu2).
build-essential set to manually installed.
@ to upgrade, ©® to newly install, ©® to remove and @ not to upgrade.

Tree

Amazingly, that's it. Everything is all ready for you
to start coding. Here's how to get your First C++

STEP 3

program up and running. In Linux Mint the main text editor is Xed
can be launched by clicking on the Menu and typing Xed into the
search bar. Click on the Text Editor button in the right-hand pane to
open Xed.
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In Xed, or any other text editor you may be using,
enter the lines of code that make up your C++ Hello
World program. To remind you, it's:

STEP 4

#include <iostream>
int main ()

{

/ /My first C++ program

std::cout << ™MHello World!\n”;

| *Unsaved Document 1 X

#include <iostream>

int main()

{

//My first C++ Program
std::cout << "Hello World!\n";

)




When you've entered your code, click File > Save As
and choose a folder where you want to save your
program. Name the file as helloworld.cpp, or any other name just as
long as it has .cpp as the extension. Click Save to continue.

[Hh Edit Wiew Search Tools Documents Help

g0 06 ~« ¥ 0080 QQ
"Unsaved Document 1 M
#include <iostream=
il maini)
| |
fiMy first C4+ Progran
&TA: oout << "Halln wWarldiyn®:
}
Save A5
Mame; | hellowsrid.cpg
p— g
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F_-. 51:1 | Name -  Sige Modified
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The first thing you can see is that Xed has
automatically recognised this as a C++ file, since the

File extension is now set to .cpp. The colour coding is present in the
code and if you open up the file manager you can also see that the

file’s icon has C++ stamped on it.

|F|I1= EbL View Search Touls Dotmienis Help
 pooG|~w| Y08 aa

. ¢ hellownoridrpp X

#Fincluda
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With your code now saved, drop into the Terminal
again. You need to navigate to the location of

STEP 7

the C++ File you've just saved. Our example is in the Documents
fFolder, so we can navigate to it by entering: cd Documents.
Remember, the Linux Terminal is case sensitive, so any capitals must
be entered correctly.

v

File Edit View Search Terminal Help

cd Documents

( How to Set Up C++ In Linux
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Before you can execute the C++ file you need to
compile it. In Linux it's common to use g++, an open
source C++ compiler and as you're now in the same folder as the
C++ file, go to the Terminal, enter: g++ helloworld.cpp and
press return.

v david@mii

File Edit View Search Terminal Help

g++ helloworld.cpp

STEP 9 There will be a brief pause as the code is compiled
by g++ and providing there are no mistakes or
errors in the code you are returned to the command prompt. The
compiling of the code has created a new file. If you enter 1s into the
Terminal you can see that alongside your C++ file is a.out.

v davidé

File Edit View Search Terminal Help

g++ helloworld.cpp

't helloworld.cpp

STEP 10 The a.out file is the compiled C++ code. To run the
code enter: . /a.out and press Return. The words
‘Hello World! appears on the screen. However, a.out isn't very friendly.
To name it something else post-compiling, you can recompile with:
g++ helloworld.cpp -o helloworld. This creates an output
file called helloworld which can be run with: ./helloworld.

v david@mint-mate ~/Docli

File Edit View Search Terminal Help

david@mint-mat Ja.out

Hello World!

javid@emint-maf g++ helloworld.cpp -o helloworld
./helloworld

Hello World!
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Other C++ IDEs to Install

IF you want to try a different approach to working with your C++ code, then there are
plenty of options available to you. Windows is the most prolific platform for C++ IDEs
but there are plenty for Mac and Linux users too.

DEVELOPING C++

Here are ten great C++ IDEs that are worth looking into. You can install one or all of them if you like, but find the one that

works best fFor you.

Eclipse is a hugely popular C++ IDE that offers
the programmer a wealth of features. It has a

ECLIPSE

great, clean interface, is easy to use and available for Windows,
Linux and Mac. Head over to www.eclipse.org/downloads/ to
download the latest version. If you're stuck, click the Need Help link
for more information.

File Edit Source Refactor Mavigate Search Project Run  Window Help
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= - S L
- —t // Hame : Hello.cpp
= al // Author
=5 Hello World C++ Project // version
{f Binanes ff Copyright : Your copyright notice
E;i includes f// Description : Hello World in C#+; Ansi-style
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.g] Hello World C+ + Project.cpp
= Debug

tinclude <iostream:
using namespace std;

int main() {
cout << “!1!!Hello Morld!!!™ << endl; // prints !!lHello World!!!
return 8;

}
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The GNAT Programming Studio (GPS) is a powerful
and intuitive IDE that supports testing, debugging

GNAT

and code analysis. The Community Edition is free, whereas the
Pro version costs; however, the Community Edition is available for
Windows, Mac, Linux and even the Raspberry Pi. You can find it at
www.adacore.com/download.
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Codelite is a free and open source IDE that's
reqularly updated and available for Windows,

CODELITE

Linux and macOS. It's lightweight, uncomplicated and extremely
powerful. You can find out more information as well as how to
download and install it at www.codelite.org/.

W “---"_":'_.'_-"'-"5' s ———
| Workapace View jmbster] i B¥  jyumecpp x ™ |
| o Worknpacs | sulrafer | SFT8 | PHS | Dbfspiecer | Svm | Expla w [ Joeles AF- (e .GFLId{ ]} == BRCID{ “whibespecs_indent oaly™jl -
........ 13- . . ' ! ; 1 ek bond - pSatEhowi i tapaces( 3]}
S & 5m tJ
L 1l =
I [in Debug Urscore =i BaTHASARASE( | -} ChaAME TaRpACE (4501 501 LA LhaAR T pRCa L] ) ]; ¥
wll | o Unckdmor ' o e
= shan 44 sanee - Lhe yELLLAgS E- £
[ i o "i"l#m EditarConfigsT: 16et( ) - sSeviptions(option); =
= h' pph ] L
AR 7 Ly vuid giHeinFrame::nlnererrntalive b wal cemerd Everrtd roont ]
£t eliplashacrom.cpp {
: ALY e Py e — MMF[ aent g q
= Gatiipinbook( § - vEhonGuiclliser [ tree }; ‘:-'k
: B vk [ }
A L geearairdogpp wald 2 iRainFrame s sOmiletagusrbipas e el amandEventh - corar ) -ﬁ
e n pessrabinio b {
1 I ONSERra.CPER walimssediar event )0 i
! o — 17 See if amy of the pluging uswt e hasdle this svent by Lrself - -
& | ievroersionhitedigh boal fullherag = |(evese.Gerld(] == NRCID]“retag workspace™))) |ﬁ| |
Gi hewereriandly.cpp walcmmandEvent & fullSetag 7 wxEVT (MD_EETAL WORCSFACE_FULL 1 wefWT_[M} RETAS WORKSFACE, Gatl
- B newmnndin h v, Setbventlject{this); =
- £ agtrinsncathosscioh.cop if{Eventiiotifier: tier()- sbrocensilent(e))
returng £
A FagERaCE ] | Euentiorifier: 10 | )=l B‘-
= M et 08 [t MR acar { Iter Gt ventFilters t1lter)
: ':ll.uli_wlﬂn.t'h aalalp § e B ddduode {maTracherhode "pra)
= home hinilecp axlventTilter® filter);
~ . P Il cadrendingtvenn| canst wubventdl svent)
CF wibupdutathrned, oy o gvant fber wheve FitmEventl) method will be called for sach
= - A webupdetethieid png every evest processed by waWidgess. Thie flsers sne called in LEQ
T WlcomaBage.cpy arder and walpp it regethened a¢ am woent filtes y delault. The painter
o 'WelcomePageh et rmde vlid unhl o' rerrstd weth RisricveFiber]] ared 19 not
- Eiwled by walbiHardler.
A el g test_carih ' ' [T PARAgErs || [T Y RE T ag
# oy Clmglede smpletian 1
5 Comtrals vild gREMBLAFr s Onkhimlull
W Dhebusgeki
F L ] i radvar ()
|l sl Declong Windows e § 5, - ——
Ll 65, Tl 38, Poa IPRLEL, SegleD v D, Dy Dl

LB L B B B B O B B N N N N R RN RN RN E R NN RN EENEENEERNESERLE.

Another popular choice is NetBeans. This
is another excellent IDE that’s packed with

NETBEANS

features and a pleasure to use. NetBeans IDE includes project based
templates for C++ that give you the ability to build applications with
dynamic and static libraries. Find out more at www.netbeans.org/
features/cpp/index.html.
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VISUAL STUDIO

Microsoft’s Visual Studio is a
mammoth C++ IDE that allows you
to create applications for Windows, Android, iOS and the web. The
Community version is free to download and install but the other
versions allow a free trial period. Go to www.visualstudio.com/ to
see what it can do for you.

& Fvold fune{wvold*) { Fi'_'“*’m"l'm

wtd:oout <« “The call resolwes to wold®wun®;

} e

tomplate<typename T> wold g7 x) { . Sesrci b
Fume (@) ;

d
} F " Loieipp

vold Fuc{int) {

ard oot << “The call resolves o IntyA™}
3k
13@ fF constexpr evaleation
=constexpr int factorlalf{int «al) -[
1f {val > 1)
return (val #* factorial{wal = 1});
el
return v
}
int maind) {

ff Structured bindings sdppori
hd: teapsatd: tatring, boals m_j
m_.emplace(“string®, true);
for (auloB&fk, v] : m_}

ff do something with k & v

{
I}
const Int x = Factorial{s);
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QT CREATOR

This cross-platFform IDE is designed to
create C++ applications for desktop and
mobile environments. It comes with a code editor and integrated
tools for testing and debugging, as well as deploying to you chosen
platform. It's not free but there is a trial period on offer before
requiring purchasing: www.qt.io/qt-features-libraries-apis-tools-
and-ide/.
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Bloodshed Dev C++, despite its colourful name,
is an older IDE that is for Windows systems only.

DEV C++

However, many users praise its clean interface and uncomplicated
way of coding and compiling. Although there’s not been much
updating for some time, it's certainly one to consider if you want
something different: www.bloodshed.net/devcpp.html.
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#define IDC_MAIN TEXT 1001

CErHFLL

~BName[] = "MyWindowCla=s':
nat = KWULL;

=gt

EOOL LoadFile (HWND hEdic, LPSTR pszFileNaimns)
{

HANDLE hFile:

BOOL bSuccess = FALSE:

hFile = CreateFile(pszFileName, GENERIC READ, FILE SHARE READ, NULL,
QOPEN EXISTING, O, 0):
hFile != INVALID HANDLE VALUE)

DWORD dwFileSize:=

e = '!-'--.7'1|l-?-:'-1 g2 (hFile, NULL):

if (dwFileSize != OxFFFFFFFF)
{

LPETE p=zFileText;

<Other C++ IDEs to Install </>
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The Anjuta DevStudio is a Linux-only IDE that
fFeatures some of the more advanced features you

ANJUTA

would normally find in a paid software development studio. There’s
a GUI designer, source editor, app wizard, interactive debugger and
much more. Go to www.anjuta.org/ for more information.
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MONODEVELOP

This excellent IDE allows developers
to write C++ code for desktop and
web applications across all the major platforms. There's an advanced
text editor, integrated debugger and a configurable workbench to
help you create your code. It's available for Windows, Mac and Linux
and is free to download and use: www.monodevelop.com/.
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Ultimate++ is a cross-platform C++ IDE that boats a rapid
development of code through the smart and aggressive
use of C++. For the novice, it's a beast of an IDE but behind its
complexity is a beauty that would make a developer's knees go
wobbly. Find out more at www.ultimatepp.org/index.html.
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COTET

Coding
with C++

This section contains the building block

of C++, from learning how to compile and
execute your First C++ code, through to
developing user interaction. There's a lot to
learn with C++, but these tutorials, tips and
tricks will lead you in the right direction.

C++ is different to the other programming
languages in this book, and it's continually
evolving as the applications that require it
are forever improving. If you know C++, then
you're well on your way to becoming a much
sought-after coder and a vital member of the
coding community.
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Coding with C++>

Your First C++ Program

You may have followed the Mac and Linux examples previously but you're going to be

working exclusively in Windows and Code::Blocks from here on. Let's begin by writing
your first C++ program and taking the first small step into a larger coding world.

HELLO, WORLD!

It's traditional in programming For the First code to be entered to output the words ‘Hello, World!' to the screen. Interestingly,

this dates back to 1968 using a language called BCPL.

STEP 1 We're going to use Windows 10 and the excellent
IDE Code::Blocks for the rest of the C++ code and
tutorials in this book. Begin by launching Code::Blocks. When open,
click on File > New > Empty File or press Ctrl+Shift+N on the keyboard.
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Now you can see a blank screen, with the tab
labelled *Untitled1, and]the number one in the top

left of the/main Code::Blocks window. Begin by clicking in the main |

window, so the cursor is next to the number one, and entering:

] #11‘1(:11?(:1; {qmstreambo O ] ‘t 1 10
1 0O 0 00 0 | 0 0 |

! *Untitled] - Code::Blocks 17.12

File Edit View 5earch Project Builld Debug Fortran wxSmith Tools Tools+ Plugins Doxykl
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At the moment it doesn’t look like much, and
it makes even less sense, but we'll get to that

STEP 3

in due course. Now click on File > Save File As. Create or find a
suitable location on your hard drive and in the File Name box, call
it helloworld.cpp. Click the Save as type box and select C/C++ files.
Click the Save button.
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STEP 4 Yolikcan see that Code::Blocks has now changed | |
theltolour coding, recognising that the file'is now
C++ code. This means thaticode cantbe auto-selected from the ()

() Code:Blocks repository. Delete the #include <iostream> lineand) | 0 ©

re-enter it} You can see the auto-select boxes appearing. o 0

N L | A
™8 “helloworld.cpp - Code:Blocks 17.12

File Edit View Search Project Build Debug Fortran wxSmith Tools
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#incl
#H if
# ifdef
# ifndef
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(Your First C++ Program
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i 09 Auto-selection of commands is extremely handy and = =X: 3 Note again the colour coding change. Press Return at
cuts out potential mistyping. Press Return to get to the end of the previous step’s line, and then enter:

line 3, then enter:

std: :cout << “Hello, world!\n”;
int main () .

m-.ma\@»aam B> w26

@8 |rm<|DRQfd e kD -
| starthere % | *helloworld.cpp X

$include <iostream>

Note: there’s no space between the brackets.

W | e OSSN W T P W W i

I rw<| e Qide D

int main()
—i{

e |

$include <iostream>

int main () L std: :cout << "Hello, wnrld!\n":l
I
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=X Onthe nextline below int main(), enter a curly bracket: ~E<gd={=X<J Just as before, Code::Blocks auto-completes the
code you're entering, including placing a closing

{ speech mark as soon as you enter the first. Don’t forget the
This can be done by pressing Shift and the key to the right of Ponan  semicolon at the end of the line; this is one of the most important
English UK keyboard layout. elements to a C++ program and we'll tell you why in the next
section. For now, move the cursor down to the closing curly bracket
and press Return.
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O X int main() } qm ’ $include <iostream> .l
< —] { 2 A
1 S t_ 3 int main() 00 O
e } 5 first ( !
] () 7 6 “ std: :cout << "Hello, world!\n"; ]
0 s | 7 |1
8 )
() ()I 9 | _1 1 U
0 ) 0
] N I I U | U U N | | ]
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5=y Notice that Codei:Blocks has automaticallycreated | Rgu==XToB That's all you need to do for the moment. It may
a corresponding closing curly bracket a couple of () © not lookterribly amazing but C++ is best absorbed 0 ©
] lines below, linking the(pain, aswell as a slight indent This is due to in small chunks. Don't execute the code at the momentasyou need
] E‘pe structure of C++andit's ﬂwer«e the meat @-f t:h;e codeisentered.  to look at-how a]CHr program is structured first; then you can, build
00 Now enter: .: ] 1 i B anc:i run the code. For now, click on Save, the single floppy disc icon.
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O ] $include <iostream> = 0
3 int main
1 int main/() | 4 [t ) | |
1 2 T std: :cont << "Hello, H:::Ild!"'l..n":l 0 O
- . 0
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Compile and Execute

You've created your first C++ program and you now understand the basics behind the

structure of one. Let's actually get things moving and compile and execute, or run if
you prefer, the program and see how it looks.

GREETINGS FROM C++

Compiling and executing C++ code from Code::Blocks is extraordinarily easy; it's just a matter of clicking an icon and seeing

the result. Here's how it’s done.

STEP 1 Open Code::Blocks, if you haven't already, and
load up the previously saved Hello World code you
created. Ensure that there are no visible errors, such as missing
semicolons at the end of the std::cout line.

- Lodez:Blocks 1/.1Z
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File Edit View 5earch Project Build Debug Fortran wxSmith Tools Tools+
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o  Starthere X | *helloworld.cpp X |
quﬁm 15‘-"'1"'*_|£"- 1 #include <iostream>
!Q Workspace .
3 int main{()
4 [
L
€ std: :cont << "Hello, world!\n";
-
8 o)
9
10
11
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If your code is looking similar to the one in our
screenshot, then look to the menu bar along the top
of the screen. Under the Fortran entry in the topmost menu you can
see a group of icons: a yellow cog, green play button and a cog/play
button together. These are Build, Run, Build and Run functions.

ocks 17.12

roject Build Debug Fortran wxSmith Tools Tools+ Plugins DoxyBlo¢

MR QARG ri3 oo U@ >
M| @R Qi o iD |

C

x

$include <iostream>

2

3 int main()

= —| {

S

6 std: :cout << "Hello, world!\n":;
7

8 =3

LAY
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STEP 3

Start by clicking on the Build icon, the yellow cog.
AL this point, your code has now been run through
the Code::Blocks compiler and checked for any errors. You can see
the results of the Build by looking to the bottom window pane. Any
messages regarding the quality of the code are displayed here.

3uild log

}{‘ f‘ Build messages }{‘ jﬂmﬁﬁdcﬂﬁ

in "no project" (compiler: unknown)

51, U0 warningis) (U0 minute(s), [0 secondis) ]

CfC++
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STEP 4

Now click on the Run icon, the green play button.
A command line box appears on your screen
displaying the words: Hello, world!, followed by the time it's taken
to execute the code, and asking you press a key to continue. Well
done, you just compiled and executed your first C++ program.
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Pressing any key in the command line box closesiit,
returning you to Code::Blocks. Let's alter the code
slightly. Under the #include line, enter:

using namespace std;
Then, delete the std:: part of the Cout line; like so:

cout << “Hello, world\n”;

 Starthere X *helloworld.cpp X
1 ¥*include <iostream>
2 usS1ing namespace std;
3
4 int main()
S =
€
7 cout << "Hello, world!'\n";
8
S =3
0

|t
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In order to apply the new changes to the code, you
need to re-compile, build, and run it again. This time,
however, you can simply click the Build/Run icon, the combined
yellow cog and green play button.
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STEP 7

Just as we mentioned in the previous pages, you
don't need to have std::cout if you already declare
using namespace std; at the beginning of the code. We could have
easily clicked the Build/Run icon to begin with but it's worth going
through the available options. You can also see that by building and
running, the file has been saved.

~ile Edit View Search Project Buwild Debug Fortran wxSmith Tools Tools+ Plugins DoxyBlocks Settir
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Start here *  hellowordd.cpp <
{ | Projects Symbols .F’lﬁ ’ . 1 #lnclude <liostream>
) Workspace 2 using namespace std;
3
4 int main()
s [t
&
7 ) cout << "Hello, world!\n":
| 3
I = -
10
11

(Compile and Execute </>
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Create a deliberate error in the code. Remove the
semicolon from the cout line, so it reads:

cout << “Hello,

world!\n”

,.LSEE here }I:_I_g *helloworld.cpp }{L —— —
1 finclude <iostream>
K. n=ing namespace =std:
3
4 int main/()
S
a
7 cont << "Hello, world!‘\n"
g
9 = ]
10
11
12
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Now click the Build and Run icon again to apply the
changes to the code. This time Code::Blocks refuses

STEP 9

to execute the code, due to the error you putin. In the Log pane at
the bottom of the screen you are informed of the error, in this case:
Expected ;' before ‘} token, indicating the missing semicolon.
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2 using namespace std;
3
4 int main()
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7 I cout << "Hello, world!'\n"
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Replace the semicolon and under the cout line,
enter a new line to your code:

cout << “And greetings from C++!\n”;

The \n simply adds a new line under the last line of outputted text.
Build and Run the code, to display your handiwork.
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Using Comments

While comments may seem like a minor element to the many lines of code that

combine to make a game, application or even an entire operating system, in actual fact
they're probably one of the most important Factors.

THE IMPORTANCE OF COMMENTING

Comments inside code are basically human readable descriptions
that detail what the code is doing at that particular point. They don’t
sound especially important but code without comments is one of
the many frustrating areas of programming, regardless of whether
you're a professional or just starting out.

In short, all code should be commented in such a manner as to
effectively describe the purpose of a line, section, or individual
elements. You should getin to the habit of commenting as much as
possible, by imagining that someone who doesn’t know anything
about programming can pick up your code and understand whatit's
going to do simply by reading your comments.

In a professional environment, comments are vital to the success

of the code and ultimately, the company. In an organisation, many
programmers work in teams alongside engineers, other developers,
hardware analysts and so on. If you're a part of the team that's
writing a bespoke piece of software for the company, then your
comments help save a lot of time should something go wrong, and
another team member has to pick up and follow the trail to pinpoint
the issue.

Place yourself in the shoes of someone whose job it is to find out
what's wrong with a program. The program has in excess of 800,000
lines of code, spread across several different modules. You can soon
appreciate the need for a little help from the original programmers
in the form of a good comment.

The best comments are always concise
and link the code logically, detailing what
happens when the program hits this line
or section. You don't need to comment on
every line. Something along the lines of: if
x==0 doesn't require you to comment that if x
equals zero then do something; that's going
to be obvious to the reader. However, if x

equalling zero is something that drastically changes the program for
the user, such as, they've run out of lives, then it certainly needs to
commented on.

Even if the code is your own, you should write comments as if you
were going to publicly share it with others. This way you can return
to that code and always understand what it was you did or where it
was you went wrong or what worked brilliantly.

Comments are good practise and once you understand how to add a
comment where needed, you soon do it as if it's second nature.

DEFB 26h, 30h, 32h, 26h, 30h, 32h, 0, 0,32h, 72h, 73h, 32h, 72h, 73h, 32h
DEFB 60h, 61h, 32h, 4Ch, 4Dh, 32h, 4Ch, 99h, 32h, 4Ch, 4Dh, 32h, 4Ch, 4Dh
DEFB 32n, 4Ch, 99h, 32h, 5Bh, 5Ch, 32h, 56h, 57h, 32h, 33h, 0CDh, 32h, 33h
DEFB 34h, 32h, 33h, 34h, 32h, 33h, 0CDh, 32h, 40h, 41h, 32h, 66h, 67h, 64h
DEFB 66h, 67Th, 32h, 72h, 73h, 64h, 4Ch, 4Dh, 32h, 56h, 57h, 32h, 80h, OCBh
DEFB 19h, 80h,0, 190, 80h, 81h, 32h, 80h, OCBh, OFFh
TR58C:

DEFB 80h, 72h, 66h, 60h, 56h, 66h, 56h, 56h, 51h, 60h, 51h, 51h, 56h, 66h
DEFB 56h, 56h, 80h, 72h, 66h, 60h, 56h, 66h, 56h, 56h, 51h, 60h, 51k, 51h
DEFB 5éh,56h, 56h, 56h, 80h, 72h, 66h, 60h, 56h, 66h, 56h, 56h, 51h, 60h
DEFB 51h,51h, 56h, 66h, 56h, 56h, 80h, 72h, 66h, 60h, 56h, 66h, 56h, 40h
DEFB 56h, 66h, B0h, 66h, 56h, 56h, 56h, 56h

; Game restart point

START: XOR L

LD (SHEET) ,A
LD (EEMF) ,A
LD (DEMOC) , A
LD (BEB45B) ,A
LD (BB458) ,A
LD A,2 rInitial lives count
LD (NOMEN) , A
LD HL,T845C
SET 0, (HL)
LD HL, SCREEN
LD DE, SCREEN+1
LD BC,17FFh ;Clear screen image
LD (HL) , O
LDIR
LD HL,OAO000R :Title screen bitmap
LD DE, SCREEN
LD BC, 4098
LDIR
LD HL,SCREEN + 800h + 1*32 + 29
LD DE, MANDAT+64
LD c,0
CALL DEWFIX
LD HL, OFCO0Oh sAttributes for the last room
LD DE,ATIR : (top third)
LD BC,256
LDIR
LD HL, 09EQOOh srAttributes for title screen
LD BC, 512 ; (bottom two-thirds)
LDIR
LD BC, 31
DI
XOR A
RE621:
IN E. (C)
CR E
DJNZ RB621 »8-03
AND 20h
JR NZ,RB862F :;5+07
LD A,1
LD (EEMP) ,A
RB62F:
LD 1Y, T846E
CALL C92DC
JP NZ,L8684
XCR A

LD (EUGHGT) , A




C++ COMMENTS

<Using Comments </>

Commenting in C++ involves using a double forward slash '/, or a forward slash and an asterisk, ‘/*'. You've already seen some

brief examples but this is how they work.
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STEP 1

Using the Hello World code as an example, you can
easily comment on different sections of the code
using the double forward slash:

/ /My first C++ program
cout << “Hello, world!\n”;

g $include <iostream>
. using namespace std;
3
E int main()
= =
& .
7 cout << "Hello, world!\n";
8
S

10 =7

? = &

5 B

1 -
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However, you can also add comments to the end
of a line of code, to describe in a better way what's

STEP 2

going on:

cout << “Hello, world!\n”;
‘Hallo, worlidl”® .

//This line outputs the

words The \n denotes a new line.

Note, you don’t have to put a semicolon at the end of a comment.
This is because it's a line in the code that's ignored by the compiler.

——————— e L —— e e ————— e —t,.
Starthere % *helloworld.cpp X |

$include <iostream>

n=ing namespace std;

int maini()

Hi

conut << "Hello, world!\n";

[PUR R T T R S 7 I X HI

STEP 3

You can comment out several lines by using the
forward slash and asterisk:

/* This comment can
cover several lines
without the need to add more slashes */

Just remember to finish the block comment with the opposite
asterisk and forward slash.

Il int main()

=h

cout << "Hello, world!\n";
cout << "And greetings from C++";

LA B B R R BN ENESREEEEEREEEREREEREREEEREDENENERLERNELEZ-SHNSEINEHRISISH:SEHSIERSEIS;SNRENNESRJSE-RJBESE;NE.

Be careful when commenting, especially with block
comments. It's very easy to forget to add the closing

STEP 4

asterisk and forward slash and thus negate any code that falls inside

the comment block.

l !ﬂhﬁhﬁf ]{]*htlmumﬂdmpp x |
1 Finclude <iostr=am>
2 m2ing namespace std;
3
o int maini()
I S T
B . .
7 coat << "Hello, world!'\n™:
8 cout << "And greetings from C++™;
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Obviously if you try and build and execute the
code it errors out, complaining of a missing curly

STEP 5

bracket '}’ to finish off the block of code. If you've made the

error a few times, then it can be time consuming to go back and
rectify. Thankfully, the colour coding in Code::Blocks helps identify
comments from code.

|| Starthere | helloworld.cpp X |

1 $#include <iostream>
using namespace std:

2

3

4 int main()

5 Hi

& |

7 cont << "Hello, world'\n";

8 cout << "And greetings from C++%;

IF you're using block comments, it's good practise
in C++ to add an asterisk to each new line of the

STEP 6

comment block. This also helps you to remember to close the
comment block off before continuing with the code:

/* This comment can
* cover several lines
* without the need to add more slashes */

int main()

=1

cout << "Hello, world!'\n";
cout << "And greetings from C++\n";

10 /%" This comment

cout << "This line is now being ignored by the compiler!\n"™;
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\ariables

Variables differ slightly when using C++ as opposed to Python. In Python, you can

simply state that ‘a’ equals 10 and a variable is assigned. However, in C++ a variable has
to be declared with its type before it can be used.

THE DECLARATION OF VARIABLES

You can declare a C++ variable by using statements within the code. There are several distinct types of variables you can

declare. Here's how it works.
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Open up a new, blank C++ file and enter the usual
code headers:

STEP 1

#include <iostream>
using namespace std;

int main{()

{
}

 Starthere X Variables.cpp X
I $#include <iostream>
2 using namespace std;l
3
4 int main()
S
6 =1
7
8 }
g -
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Start simple by creating two variables, a and b, with
one having a value of 10 and the other 5. You can

use the data type int to declare these variables. Within the curly

brackets, enter:

int a; , |
s X  *Variables.cpp X
$include <iostream>
a = 10; using namespace std;
b = 5;

int main()

=13

int a;
int b:

o 2
W
o

LB B B B N B B O B BN NN O B NN BN BN NN N BN BN B BN NN O BE AN B N A N N R NN N NN NNNNMNMNNEMGEIHMNHMSH:NHMNMNBMEHMEIS.S:;NE®:RIMS.]

You can build and run the code but it won't do
much, other than store the values 10 and 5 to the

STEP 3

integers a and b. To output the contents of the variables, add:

cout << a:;
cont =< \nY;
cout €< b}

$include <jiostream>
using namespace std;

The cout << “\n"; part
simply places a new line
between the output of
10 and 5.

int main|()

—1%

a = 10;

o
Il
on

cout << a;
cout << "\n":
cont << b:
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Naturally you can declare a new variable, call it
result and output some simple arithmetic:

STEP 4

int result:;

a + b
cout << result:

result =

Insert the above into the code as per the screenshot.

| Starthere  *  Variables.cpp < |

1 #include <ioscreams

2 n2ing namespace =td;
3

4 int main()

5

& [l

7 int a;

B int b;

g int resulrc;
10
11 R i 1 K
12 b =5}

13 regult = a + b:

15 cont << result:
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You can assign a value to a variable as soon as you
declare it. The code you've typed in could look like

this, instead:

int a = 10;
I b = 5
int result = a + b;

cout << result:;

Start here X | Yariables.cpp X

2 nsing namsspace std;

3

4 int main i B ChUzershdavid\Documents C+ +\Variables. exe
=

G

T int a

B int b

9 int result = a + by
14

11 cont << result:

12

13

149
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Specific to C++, you can also use the following
to assign values to a variable as soon as you

declare them:

Then, from the C++ 2011 standard, using curly brackets:

int result {a+t+b};

Start here * | Variables.cpp

1 Finclude <iostream

2 nsing namespace std; B
3

4 int main{)

5

& =

Fi int a

8 int- b ([5):

5 int result {a+b}:
10

1l ot - reault;
12
13
14

LR BN BN BE BN O O BE BN AR BN BN B N BN AL BE BN N BN BN IR BN AR B B BN AR B BN N O B BN N B AN Bk B BN BE BN N AN BN B N B N N BN B A N NN N

You can create global variables, which are variables
that are declared outside any function and used in

STEP 7

any Ffunction within the entire code. What you've used so far are
local variables: variables used inside the function. For example:

#include <iostream>
using namespace std;
1nt StartLives = 23;

int main ()

{
startlives = Startlives - 1;
cout << Startlives;
}
&
g Startlives = Startlives -
S
10 ront StartlLives;
11
12
13

C\/ariables
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The previous step creates the variable StartLives,
which is a global variable. In a game, for example,

a player’s lives go up or down depending on how well or how bad
they're doing. When the player restarts the game, the StartLives
returns to its default state: 3. Here we've assigned 3 lives, then
subtracted 1, leaving 2 lives left.

B Ch\Users\david\Documents\C++\Vanables.exe
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The modern C++ compiler is far more intelligent
than most programmers give it credit. While there

are numerous data types you can declare fFor variables, you canin
fFact use the auto Feature:

#include <iostream>
using namespace std;

auto pi = 3.141593;

int main ()

{
double area, radius = 1.5;
area = pl * radius * radius;
cout << area;
Starthere X Variables.cpp X
1 | $include <iostream>
2 using namespace std;
3 anto pi = 3.141593;
4
5 1Nt main|)
e
7 =
8 double area, radius = 1
g
10 area = pi radius radius;
11
12 ronut area
13
14

C L B B BN B BE BN B BN BN N B BN B BE BN O B BN BN R BN BN AL BN BN BE B N BE O BE B O B BN B BE BN AR BE BN B BRI B B B BN B BN N N BN O B B NN B BN N B BN AN

A couple of new elements here: firsk, auto won't
work unless you go to Settings > Compiler and

STEP 10

tick the box labelled ‘Have G++ follow the C++11 ISO C++ Language
Standard [-std=c++1]". Then, the new data type, double, which
means double-precision floating point value. Enable C++11, then
build and run the code. The result should be 7.06858.
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Data Types

Variables, as we've seen, store information that the programmer can then later call up,

and manipulate if required. Variables are simply reserved memory locations that store
the values the programmer assigns, depending on the data type used.

THE VALUE OF DATA

There are many different data types available for the programmer
in C++, such as an integer, floating point, Boolean, character and so
on. It’s widely accepted that there are seven basic data types, often
called Primitive Built-in Types; however, you can create your own
data types should the need ever arise within your code.

The seven basic data types are:

TYPE COMMAND
-

These basic types can also be extended using the following modifiers:
Long, Short, Signed and Unsigned. Basically this means the modifiers
can expand the minimum and maximum range values for each data
type. For example, the int data type has a default value range of
-2147483648 to 2147483647, a fair value, you would agree.

slele

Now, if you were to use one of the modifiers, the range alters:

Unsigned int = 0 to 4294967295

Signed int =-2147483648 to 2147483647
Short int =-32768 to 32767

Unsigned Short int =0 to 65,535

Signed Shortint=-32768 to 32767

Long int =-2147483647 to 2147483647
Signed Long int =-2147483647 to 2147483647
Unsigned Long int = 0 to 4294967295

Naturally you can get away with using the basic type without the
modifier, as there's plenty of range provided with each data type.
However, it's considered good C++ programming practise to use the
modifiers when possible.

There are issues when using the modifiers though. Double
represents a double-floating point value, which you can use for

incredibly accurate numbers but those numbers are only accurate
up to the fifteenth decimal place. There's also the problem when
displaying such numbers in C++ using the cout function, in that cout
by default only outputs the first five decimal places. You can combat
that by adding a cout.precision () function and adding a value inside
the brackets, but even then you're still limited by the accuracy of the
double data type. For example, try this code:

#include <iostream>
using namespace std;

double PI = 3.141592653589793238463;
int main ()
cout << PI:

‘Iﬂhﬂhﬂ! X DataTypes.cpp X

$include <iostream>

2 using namespace std;
3 | double PI = 3.141592653589793238463;
q
S int main ()
6 i
¥, | cout << PI;
8
9 }
10 Y

B ' C\Users\david\Documents\C++\DataTypes.exe

Build and run the code and as you can see the outputis only
3.14159, representing cout’s limitations in this example.

You can alter the code including the aforementioned cout.precision
function, for greater accuracy. Take precision all the way up to 22
decimal places, with the following code:

#include <iostream>
using namespace std;
double PI = 3.141592653589793238463;

int main ()

{



cout .precision(22);
geurt =< PBl;

}
Start here »  DataTypes.cpp
2 nsS1ng namespace std;
3 double PI = 3.,141558265358974932384¢63;
4
5 int main()
6 [
1 zout.precision | |
8 It << PI
9
10

3.141592653589/793115998

execution t

Process returned © (0x0)

C—
—

s
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['es55 dlly Key LO COolnuinue.

T =l -

Again, build and run the code; as you can see from the command
line window, the number represented by the variable Pl is different
to the number you've told C++ to use in the variable. The output
reads the value of Pl as 3.141592653589793115998, with the
numbers going awry from the fifteenth decimal place.

Calculator e [1] b

Scientific “T)

15.142857142857142857142857142857

DEG HYP F-E
M+ P1- 1
x” x¥ sin COS tan
v 10* log Exp Mod
g i CE C & —
TT P4

+
© N U
w o
|

(Data Types .,g:f;,.

This is mainly due to the conversion from binary in the compiler
and that the IEEE 754 double precision standard occupies 64-bits
of data, of which 52-bits are dedicated to the significant (the
significant digits in a floating-point number) and roughly 3.5-bikts
are taken holding the values 0 to 9. If you divide 53 by 3.5, then you
arrive at 15.142857 recurring, which is 15-digits of precision.

To be honest, if you're creating code that needs to be accurate to
more than fifteen decimal places, then you wouldn't be using C++,
you would use some scientific specific language with C++ as the
connective tissue between the two languages.

You can create your own daka types, using an alias-like system called
typedef. For example:

v og | ] ]| & ; “l| = > £
‘tart here »  DataTypes.cpp *

2 nsing namespace std;

3 typedef 1nt metres;

4

5 int main (

3 | {

7 metres distance;

i distance =

11 "distance in metres is: " . distance;

o W

#include <iostream>
using namespace std;
typedef int metres;

int main ()

{
metres distance;
distance = 15;

cout << “distance 1n metres 1s: “ << distance;

" " o
. . e = - =T = = - C

i | -] - | ]
A - B - —_— . o W -

cess returned © (x0) 0.041 s

1on time

-

LD CONnLLnue.

This code when executed creates a new int data type called metres.
Then, in the main code block, there's a new variable called distance,
which is an integer; so you're basically telling the compiler that
there's another name for int. We assigned the value 15 to distance
and displayed the output: distance in metres is 15.

It might sound a little confusing to begin with but the more you use
C++ and create your own code, the easier it becomes.

www.bdmpublications.com



Coding with C++>

SErings

Strings are objects that represent and hold sequences of characters. For example, you

could have a universal greeting in your code ‘Welcome' and assign that as a string to be

called up wherever you like in the program.

STRING THEORY

There are different ways in which you can create a string of characters, which historically are all carried over from the original

C language, and are still supported by C++.
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To create a string you use the char function. Open a
new C++ file and begin with the usual header:

STEP 1

#include <iostream>
using namespace std;

int main ()
{
}

(¥mBaQaigrsonl 0 GEP SEGIN
@B | mw<|CRQVid e D v & =

m—— |E!Iﬂ'thu': » | *Strings.cpp ){]
Files ¥ 1 #include <iostream>
2 using namespace std;
3
4 int main ()
S
& ¢
i
8
9 |
10 =]

L BB B B B O B B N B N B B N B BB BB R B B B R RN I N AN RN NN NN ENENNLENMSEM:RHSESEHSH:SEH:..

It's easy to confuse a string with an array. Here's an
array, which can be terminated with a null character:

STEP 2

#include <iostream>
using namespace std;

int main ()

{

char greet([8] = { ‘W',
el e

cout << greet << “\n”;

Vo
€ s
\ 7
S

= | Starthere ¢ *Stringscpp X% |

e | finclude <iostcraam>

u=2ing namespace =td;
int main ()

3
q
5
N (=R
T
2]

chHar-greeca] = PRV 'els TEES I REde Jhgfe Ywhs Tale: PRaVEE
cout << greet << "\n";
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STEP 3

Build and run the code, and ‘Welcome’ appears

on the screen. While this is perfectly fine, it's

not a string. A string is a class, which defines objects that can be
represented as a stream of characters and doesn’t need to be
terminated like an array. The code can therefore be represented as:

#include <jiostream>
using namespace std;

int main ()

{

char greet[] = “Welcome”;
coulb <= greet <2 “(n";

$#include <iostream>
using namespace std;

int main ()

=L
char greet|[] = "Welcome™;
cout << greet << "\n";

= O W O J oW W=

-

}

|

S
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STEP 4

In C++ there's also a string function, which works in
much the same way. Using the greeting code again,
you can enter:

#include <iostream>
using namespace std;

int main (J

{
string greet = “Welcome”;

cout << greet << “\n”;

5 | Files P #include <iostream>

using namespace std;

int main ()

=L
string greet = "NelcomaW;
cout << greet << "\n";

H O W o =] Mmoo W=

il




There are also many different operations that you

can apply with the string function. For instance, to
get the length of a string you can use:

#include <iostream>
using namespace std;

int main ()

{

string greet = “Welcome”;
cout =< "The length of the string 1s: ";
cout << greet.size() << “\n”;

using namespace std;

1int main )

string greet = "Nelcome";

O =] o N s Lo B =

ronat c "1Ihe length of the string 1s: ":
= -

e o i e

L0y

: greet.sizel() g A"

= ) =

-
= I i |

I
|

J

fet
r.

STEP 6 You can see that we used greet.size() to output the
length, the number of characters there are, of the
contents of the string. Naturally, if you call your string something
other than greet, then you need to change the command to reflect
this. It's always stringname.operation. Build and run the code to see
the results.

B C\Users\david\Documents\C++\Strings.exe

You can of course add strings together, or rather
combine them to form longer strings:

$include <iostream>

using namespace std;

int main ()

string greetl = “Hellao”;
string greet2 = ", world!”;
string greet3 = greetl + greetl;
cout. << greetd << “\n¥;
> - .
Start here % | Strings.cpp *
Files P :
1
2 nsing namespace std;
3
4 int main ()
9
e |
7 string greetl = Hel
8 tring greet2 = world!i™;
= string greet3 greetl + greetld;
10
1 grestc3 \
13
14

S _
L\ Strings 9P
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Just as you might expect, you can mix in an integer
and store something to do with the string. In this

example, we created int length, which stores the result of string.
size() and outputs it to the user:

#include <iostream>
using namespace std;

int main ()

{
int length;
®"Hallo®:

W

string greetz = %,

string greetl =
world!”;

string greet3 = greetl + greet2;

length = greet3.size();

cout << “The length of the combined strings
ig: * <o Terigth =< Y\n";
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STEP 9

Using the available operations that come with the
string function, you can manipulate the contents of a
string. For example, to remove characters from a string you could use:

#include <iostream>
using namespace std;

int main ()

{

string strqg
N

S BEDg ==

("Here i1s a long sentence 1n a
ST rarig.

cout Akn! s

.erase (10,5);
<% strg << 'An’;

Strg
COUE

StIqg
cout

.erase (strg.begin()+8);
<5 sbrg <= V\n':

strg.erase (strg.begin()+9,

<< BEtg << VAR

strg.end()-9) ;
cout

L B B BN BN IR BN BN |

STEP 10 It's worth spending some time playing around with
the numbers, which are the character positions
in the string. Occasionally, it can be hit and miss whekther you get it
right, so practice makes perfect. Take a look at the screenshot to see
the result of the code.

| m ™ M
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C++ Maths

Programming is mathematical in nature and as you might expect, there’s plenty of
built-in scope for some quite intense maths. C++ has a lot to offer someone who's

implementing mathematical models into their code. It can be extremely complex or

relatively simple.

C++ = MC(C?

The basic mathematical symbols apply in C++ as they do in most other programming languages. However, by using the C++
Math Library, you can also calculate square roots, powers, trig and more.

L BB B B B B BN OB OB B B B B O R B IR B R R B NN O R BN NN B NN RN NN NN NN NENENNENHSNIE:NH;ER:R.

C++'s mathematical operations follow the
same patterns as those taughtin school, in that

STEP 1

multiplication and division take precedence over addition and
subtraction. You can alter that though. For now, create a new file
and enter:

#include <iostream>
using namespace std;

int main ()

{

float numbers = 100;

numbers =
initial 100

numbers + 10; // This adds 10 to the

cout << numbers << “\n”;

numbers - 10; //
from the new 110

numbers = This subtracts 110

cout << numbers << “\n”;

ftinclude <ioscream>
aging namespace std;

int main ()
=k
float numbers = 100;
numbera = numbers + 10;

cont << numbers << "\n":

numbers = pumbers — 10:

I~ R =
[T R IR oS T T T e S B R B O PV S

coat << Dumbers << "\n":
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STEP 2

While simple, it does get the old maths muscle
warmed up. Note that we used a float for the
numbers variable. While you can happily use an integer, if you
suddenly started to use decimals, you would need to change to a
fFloat or a double, depending on the accuracy needed. Run the code
and see the results.

B C\U
[ =& C e
s I SETS

david\Documents\C++\Maths.exe
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STEP 3 Multiplication and division can be applied as such:

#include <iostream>
using namespace std;

S Fe B BERERER

int main ()

{

float numbers = 100;

numbers = numbers * 10; // This multiplies 100

by 10
coul. < niimbers =< “\n":

numbers =
1000 by 10

numbers / 10; // And this divides

cout << numbers << “\n”:
}

“?su-ther: X  Maths.cpp X

1 #include <iostream>

2 using namespace std;

3

4 int main ()

5 =«

€ float numbers = 100;

7

8 numbers = numbers * 10;
9

10 cout << numbers << "\n";
11

12 numbers = numbers / 10;
13

14 cout << numbers << "\n";
15

16 }
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Again, execute the simple code and see the results.
While not particularly interesting, it's a start into C++

maths. We used a float here, so you can play around with the code

and multiply by decimal places, as well as divide, add and subtract.

B Ch\Users\david\Documents\C++\Maths.exe
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The interesting maths content comes when you call
upon the C++ Math Library. Within this header are
dozens of mathematical functions along with further operations.
Everything from computing cosine to arc tangent with two
parameters, to the value of PI. You can call the header with:

#include <iostream>
#include <cmath>
using namespace std;

int main ()

{
}
X | = -
| | Starthere ) *Maths.cpp < |
Files P 1 | ¥include <iostream>
2 finclude <cmath>
3 using namespace std:;
q
- int main ()
6 |t
-
8
S

it
o
|
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i3 Start by getting the square root of a number:

#include <iostream>
#include <cmath>
using namespace std;

int main ()
{

float number = 134;

cout << “The square root of “ << number << ™

1g: ™ << sqgrt (number) << »\n%;

}
Starthere X *Mathscpp X |
1 Finclud e <iggtream:
2 include <cmath
3 nsing namespace std;
g
S int main ()
& =1
7 float number = 134;
B
9 cont << "The asquare root of "™ << number << "™ is: " << aqgrt (number) << "\n":
10
11
1z |-
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STEP 7

Here we created a new float called number and
used the sgrt(number) function to display the
square root of 134, the value of the variable, number. Build and run
the code, and your answer reads 11.5758.

<C++ Maths </>
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STEP 8 Calculating powers of numbers can be done with:

#include <iostream>
#include <cmath>
using namespace std;

int main ()

{
float number = 12;
cout << number << ® Lo the power of 2 15 " <<
pow (number, 2) << “\n”;
cout << number << " Lo the power of 3 1g V" <<
pow (number, 3) << “\n”;
cout << number << “ to the power of .08 is ™
<< pow (number, 0.8) << “\n”;
}
Fles 1 lude <iostream>
2 Fincluds cmath
3 neing namespace std;
4
= int main ()
& [JH
7 float number = 12:
B
G oout << pumber << "™ to the power of 2 ims " << pow(number, 2} << "\n®;
10 oconat number << " £o the power of 3 is " << pow(nuomber, 3} << "Yn";
11 cout << number << " to the power of .08 is ™ << pow(number, 0.8) << "\n";
12
13
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STEP 9

Here we created a float called number with the
value of 12, and the pow(variable, power) is where
the calculation happens. Of course, you can calculate powers and
square roots without using variables. For example, pow (12, 2)
outputs the same value as the First cout line in the code.

STEP 10 The value of Piis also stored in the cmath header
library. It can be called up with the M_PI function.

Enter cout << M_PI: into the code and you get 3.14159; or you can
use it to calculate:

#include <iostream>
#include <cmath>
using namespace std;

int main ()

{
double area, radius = 1.5;
area = M PI * radius * radius;
cout << area << “\n”;

}

Siar e X Haths.cpp x
1 .
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int mAln
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double arca, Dadius =

area = M PI * radius * radius;
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User Interaction

There's nothing quite as satisfying as creating a program that responds to you. This

basic user interaction is one of the most taught aspects of any language and with it
you're able to do much more than simply greet the user by name.

HELLO, DAVE

You have already used cout, the standard output stream, throughout our code. Now you're going to be using cin, the standard

input stream, to prompt a user response.
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Anything that you want the user to input into the
program needs to be stored somewhere in the

STEP 1

system memory, so it can be retrieved and used. Therefore, any
input must first be declared as a variable, so it's ready to be used by
the user. Start by creating a blank C++ file with headers.

$include <iostream>
using namespace std;

int main ()

—If

-
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The data type of the variable must also match the
type of input you want from the user. For example,

STEP 2

to ask a user their age, you would use an integer like this:

finclude <iostream>
using namespace std;

int main ()

{

int age;
hA

cout << “what 1s your age: “;
cin >> age;

cout <<”\nYou are “ << age << “ years old.\n”;

|
 Starthere X *userinteraction.cpp X |
1 $#include <iostream>
2 using namespace std;
3
4 int main ()
5 &«
| 6 int age:
| 7 cont << "what is your age: ";
8 cin >> age;
9
10 cout <<"\nYou are " << age << " years old.\n";
11
| 12 }
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STEP 3

The cin command works in the opposite way from
the cout command. With the first cout line you're
outputting ‘What is your age’ to the screen, as indicated with the
chevrons. Cin uses opposite facing chevrons, indicating an input. The
input is put into the integer age and called up in the second cout
command. Build and run the code.

B C\Users\david\Documents\C++\userinteraction.exe
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STEP 4

If you're asking a question, you need to store the
input as a string; to ask the user their name, you

would use:

#include <iostream>
using namespace std;

int main ()

{

string name;
L4

cout << “what 1s your name: “;
cin >> name;

cout << “\nHello, ™ << name << ™,

well today?\n”;

}

I hope you’ re

=" =

Y : : al | - N r
wog| (@ [B]| Qfiel @ »iD| Mo > Lt i | O
arthere X userinteraction.cpp X |
1 $include <iostream>
2 using namespace std;
3
4 int main ()
5 ¢
6 string name;
7 cout << "what is your name: ";
8 cin >> name;
5
10 cout << "\nHello, ™ << name << ". I hope you're well today?\n";
11
12 }




g2 The principal works the same as the previous code.
The user’s input, their name, is stored in a string,
because it contains multiple characters, and retrieved in the second
cout line. As long as the variable ‘'name’ doesn’t change, then you
can recall it wherever you like in your code.
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You can chain input requests to the user but just
make sure you have a valid variable to store the

STEP 6

input to begin with. Let's assume you want the user to enter two
whole numbers:

#include <iostream>
using namespace std;

int main ()

{

int numl, num?Z;

A’

cout << “Enter two whole numbers: ;

cin >> numl >> num2:

L1

numl << and Y <<

cout << “you entered " =<
numZ << “\n”:

2 n=sing namespace std:
| 3
| 4 int main ()
| I (=T
L int numl, num;
7
[ B coot << "Enter two whole numbers: ";
| g cin >> numl >> nom2;
[ 10
[ 11l cout << "you entered " << muml << " and " << num2 << "\n":
[
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Likewise, inputted data can be manipulated once
you have it stored in a variable. For instance, ask the

STEP 7

user for two numbers and do some maths on them:

#include <iostream>
using namespace std;

int main ()

{

float numl, numZ;

cout << “Enter two numbers: \n”:

cin >> numl >> num2:

colt €< numl £ M 4+ M e niame <9 M qas W oaw

numl + num?2 << “\n”;

}
_t_ 1 Finclude <iostreams
2 using namespace std;
3
4 int main ()
s -t
B float noml, mmam:?;
-
8 cout << "Enter two numbers: \n";
B cin >> numl >> num3;
10
11 conlt << puml << ™ + ™ << pum? << " ig: " << numl 4+ nom2 << "\n¥;
12
13
14 14

< User Interaction </>
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While cin works well for most input tasks, it does
nave a limitation. Cin always considers spaces as a
terminator, so it's designed for just single words not multiple words.
However, getline takes cin as the first argument and the variable as
the second:

#include <iostream>
using namespace std;

int main ()

{

string mystr;

cout << “Enter a sentence: \n”;

getline(cin, mystr);

cout << “Your sentence is: “ << mystr.size() <<
“ characters long.\n”;
}

. =Y n . - -
Finclude <iostreams

using namespace std:

int main ()

[=] ¢

string mystr;
coat < "Enter a sentence: \n":
getline(ein, mystr) ;

H oW o -dmm e wk e

1
1

STEP 9

cout << "Your sentence is: ™ << mystr.size() << " characters long.\n";

Build and execute the code, then enter a sentence
with spaces. When you're done the code reads the
number of characters. If you remove the getline line and replace it
with cin >> mystr and try again, the result displays the number of
characters up to the first space.

B C\Users\dawid\Documents'\ C++\usennteraction.exe

STEP 10 Getline is usually a command that new C++
programmers forget to include. The terminating

white space is annoying when you can't figure out why your code
isn't working. In short, it's best to use getline(cin, variable) in future:

#include <iostream>
using namespace std;

int main ()

string name;
cout << “Enter your full name: \n”";
getline(cin, name);
cout << “\nHello, ™ << name << “\n”;
i P_ 1 finclude <iostream
2 nsing namespace std;
3
4 int main ()
5 Q=i
[
) string name;
8 cout << "Enter your full name: ‘\n";
5 getline (cin, name) ;
10
11 cout << "\nHello, ™ << npname << "\n";
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Python

Python is one of the most respected
and used programming languages

in the world. It's designed to help
beginners get into code, but also has
some amazingly powerful features

== that are utilised by data scientists and
engineers around the world.

You don't need to look too Far to
Python at work. It's used throughout
the Internet, and helps drive some of
the biggest projects and companies in
a multitude of industries.

In this section, we will look at what
you will need to get started with
Python. First steps into a new learning
experience are always the hardest, but
we're here to help.

A
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Why Python?

There are many different programming languages available for the modern computer,
and some still available for older 8 and 16-bit computers too. Some of these languages
are designed for scientific work, others for mobile platforms and such. So why choose
Python out of all the rest?

PYTHON POWER

Ever since the earliest home computers were available, enthusiasts, users and professionals have toiled away until the wee
hours, slaving over an overheating heap of circuitry to create something akin to magic.

These pioneers of programming carved their way into a new Regardless of whether you use an Android device, iOS device, PC,

Frontier, forging small routines that enabled the letter ‘A’ to scroll Mac, Linux, Smart TV, games console, MP3 player, GPS device built-in

across the screen. It may not sound terribly exciting to a generation to a car, set-top box or a thousand other connected and ‘smart’

that's used to ultra high-definition graphics and open world, multi- appliances, behind them all is programming.

player online gaming. However, forty-something years ago it was

blindingly brilliant. All those aforementioned digital devices need instructions to tell
them what to do, and allow them to be interacted with. These

Naturally these bedroom coders helped form the foundations for instructions form the programming core of the device and that core

every piece of digital technology we use today. Some went on to can be built using a variety of programming lanquages.

become chief developers for top software companies, whereas
others pushed the available hardware to its limits and founded the The languages in use today differ depending on the situation, the
billion pound gaming empire that continually amazes us. platform, the device’s use and how the device will interact with its
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environment or users. Operating systems, such as Windows, macOS
and such are usually a combination of C++, C#, assembly and some
form of visual-based language. Games generally use C++ whilst web
pages can use a plethora of available languages such as HTML, Java,
Python and so on.

More general-purpose programming is used to create programs,
apps, software or whatever else you want to call them. They're
widely used across all hardware platforms and suit virtually every
conceivable application. Some operate faster than others and some
are easier to learn and use than others. Python is one such general-
purpose language.

Python is what's known as a High-Level Language, in that it ‘talks’
to the hardware and operating system using a variety of arrays,
variables, objects, arithmetic, subroutines, loops and countless
more interactions. Whilst it's not as streamlined as a Low-Level
Language, which can deal directly with memory addresses, call
stacks and registers, its benefit is that it's universally accessible
and easy to learn.

//file: Invoke.java
import java.lang.reflect.*

class Invoke {
public static void main( string [] args ) {

~J Y U1 B B

try {
g1a55 c = Class.forName( args[0] );

8 ?ﬁt?u? ! = c.getMethod( args[1l], new Class
Oobject ret = m.invoke( null, null );
System.out.printin(

"Invoked static method: " + args[1]
+ " of class: " + args[0]
+ ' with no args\nResults: " + ret );

} catch ( ClassNotFoundException e )
// Class.forName( ) can't find the class
} catch ( NuSuchMethodExcept1nn e2 ) {
// that method doesn't exist
} catch ( I11ega1Acc555Except1un es ) 1
// we don't have permission to invoke that
method
} catch ( InvocationTargetException e4 ) {
// an exception ocurred while invoking that
method
system.out.printin(
"Method threw an: + e4.
getTargetException( ) );
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a Javais a powerful

é language that’s used in
web pages, set-top boxes,
TVs and even cars.

<Why Python? G

Python was created over twenty six years ago and has evolved to
become an ideal beginner’s language for learning how to program a
computer. It's perfect for the hobbyist, enthusiast, student, teacher
and those who simply need to create their own unique interaction
between either themselves or a piece of external hardware and the
computer itself.

Python is free to download, install and use and is available for Linux,
Windows, macOS, MS-DOS, 0S/2, BeQS, IBM i-series machines, and
even RISC OS. It has been voted one of the top five programming
languages in the world and is continually evolving ahead of the
hardware and Internet development curve.

So to answer the question: why Python? Simply put, it's free, easy to
learn, exceptionally powerful, universally accepted, effective and a
superb learning and educational tool.

BASIC was once the starter language that early
8-bit home computer users learned.

print(HANGMAN[®])
attempts = len(HANGMAN) - 1

while (attempts |= & and "-" in word guessed):
print(("\nYou have {} attempts remaining”).format(attempts))
joined word = "".join(word_guessed)
print(joined_word)

try:
player guess = str(input("\nPlease select a letter between A-Z" + "\n> %)).
except: # check wvalid input
print("That is not valid input. Please try again.”)
continue
else:
if not player guess.isalpha(): # check the input is a letter. Also checks a
print("That is not a letter. Please try again.”)
continue
elif len(player guess) > 1: # check the input
print(“That is more than one letter. Please try again.™)
continue
elif player guess in guessed letters: # check it letter hasn’'t been guessed
print(“You have already guessed that letter. Please try again.”)
continue
else:
pass

15 Eniy one letter

guessed_letters.append(player_guess)

for letter in range(len(chosen_word)):
if player guess == chosen word|letter]:

word guessed[letter] = player _guess # replace all letters in the chosen

if player _guess not in chosen_word:

ﬁ Python is a more modern take on BASIC, it's easy to learn
é and makes for an ideal beginner's programming language.
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What Can You Do

with Python?

Python is an open-source, object-oriented programming language that's simple to
understand and write with, yet also powerful and extremely malleable. It's these
characteristics that help make it such an important language to learn.

Python's ability to create highly readable code, within a small set
of instructions, has a considerable impact on our modern digital
world. From being an ideal first programmers’ choice through to
being able to create interactive stories and games; from scientific
applications through to artificial Intelligence and web-based
applications, the only limit to Python is the imagination of the
person coding in it.

It's Python's malleable design that makes it an ideal language fFor
many different situations and roles. Even certain aspects of the
coding world that require more efficient code still use Python. For
example, NASA utilises Python both as a stand-alone language
and as a bridge between other programming languages. This way,
NASA scientists and engineers are able to get to the data they
need without having to cross multiple language barriers; Python
fills the gaps and provides the means to get the job done.

BIG DATA

and beyond.

useable for humans.
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Big data is a buzzword you're likely ko have come across in the last couple of years.
Basically, it means extremely large data sets that are available for analysis to reveal
patterns, trends and interactions between humans, society and technology. OFf course,
It's not just limited to those areas, big data is currently being used in a variety of
industries, from social media to health and welfare, engineering to space exploration

Python plays a substantial role in the world of big data. It's extensively used to analyse
huge chunks of the available big data and extract specific information based on what
the user/company requires from the wealth of numbers present. Thanks to an
impressive set of data processing libraries, Python makes the act of getting to the data,
in amongst the numbers, that counts and presenting it in a fashion that's readable and

There are countless libraries and freely available modules that enable fast, secure and
more importantly, accurate processing of data from the likes of supercomputing clusters.
For example, CERN uses a custom Python module to help analyse the 600 million collisions
per second that the Large Hadron Collider (LHC) produces. A different language handles
the raw data, but Python is present to help sift through the data so scientists can get to the
content they want without the need to learn a far more complex programming language.
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You'll Find lots of examples of this, where Python is acting behind
the scenes. This is why it's such an important language to learn.

Beautiful is better than uagly.

Explicit is better than implicit.

Simple is better than complex.

Complex is better than complicated.

Flat is better than nested.

Sparse is better than dense.

Readability counts.

Special cases aren't special enough to break the rules.

Although practicality beats purity.

Errors should never pass silently.

Unless explicitly silenced.

In the face of ambiguity, refuse the temptation to guess.

There should be one-- and preferably only one --obvious way to do it.
Although that way may not be obvious at first unless you're Dutch
Now is better than never.

Although never is often better than *right* now

If the implementation is hard to explain, it's a bad idea.

If the implementation is easy to explain, it may be a good idea.
Namespaces are one honking great idea -- let's do more of those!
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What Can You Do with Python? </>
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1 B Minecraft Launcher

ARTIFICIAL INTELLIGENCE E Bl © snousw - unieo amecon
MIHELRRF\ %

News Skins Settings Launch options

Artificial Intelligence and Machine Learning are two of the
most groundbreaking aspects of modern computing. Al is the
umbrella term used For any computing process wherein the .
machine is doing something intelligent, working and reacting {1
in similar ways to humans. Machine Learning is a subset of Al
and provides the overall Al system with the ability to learn
from its experiences.

However, Al isn't simply the creation of autonomous robots
intent on wiping out human civilisation. Indeed, Al can be
found in a variety of day-to-day computing applications where
the ‘machine’, or more accurately the code, needs to learn
from the actions of some form of input and anticipate what
the input is likely to require, or do, next. : Picture Perfect
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This model can be applied to Facebook, Google, Twitter,
Instagram and so on. Have you ever looked up a celebrity

on Instagram and then discovered that your searches within
other social media platforms are now specifically targeted
toward similar celebrities? This is a prime example of using Al

in targeted advertising and behind the code and algorithms GAMING
that predict what you're looking for, is Python. 1

1.13.2 - Latest release

Spotify For sxample uses Pykhon based code : Allj'hnugh you won't find too many triple-A rated games r.:.nded
: . S Using Python, you may be surprised to learn that Python is used as
among other things, to analyse your musical : 1 : .
. an extra on many of the high-ranking modern games.

habits and offer playlists based on what you've
listened to in the past. It's all clever stuff and
moving forward, Python is at the forefront of
the way the Internet will work in the Future.

The main use of Python in gaming comes in the form of scripting,
where a Python script can add customisations to the core game
engine. Many map editors are Python compatible and you will also
come across it if you build any mods for games, such as The Sims.
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A lot of the online, MMORPG (Massively Multiplayer Online Role-

Playing Game) games available utilise Python as a companion

WEB DEVELOPMENT language for the server-side elements. These include: code to

. search for potential cheating, load balancing across the game's

Web development has moved on considerably since the early  -® servers, player skill matchmaking and to check whether the player’s
days of HTML scripting in a limited text editor. The many ¢ clientside game matches the server's versions. There's also a
Fframeworks and web management services available now Python module that can be included in a Minecraft server, enabling
means that building a page has become increasingly complex. the server admin to add blocks, send messages and automate a lot
of the background complexities of the game.
With Python, the web developer has the ability to create
dynamic and highly secure web apps, enabling interaction with
other web services and apps such as Instagram and Pinterest.
Python also allows the collection of data from other websites

and even apps built within other websites. PYTHON EVERYWHERE |

Ov\1 As you can see, Python is quite a versatile
Oh\_r«" : . programming language. By learning Python,
: you are creating a well-rounded skillset that's | wrle
able to take you into the next generation of h
computing, either professionally or simply %48 %, :
as a hobbyist. Vi

Whatever route you decide to take on your

coding journey, you will do well to have
Python in your corner.
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There's a - n
lot to like about Pythe s
; _ n’s £y,
Python, but don't just— $ Flying cfrcu:"fy

take our word for it. Here are
some amazing facts and figures
surrounding one of the most popular
programming languages of recent years.

Qs)

Alexa, Amazon's Virtual
Personal Assistant, uses
Python to help with
speech recognition.

Data analysis and
Machine Learning are the
two most used Python
examples.

DECEMBER

PYTHON AND
LINUX SKILLS
As of the end of 2018, ARE THE THIRD 3 Disney Pixar uses Python
Python was the most MOST POPULAR in its Renderman software
discussed language on T TIT.SKILLS IN to operate between other
the Internet. TH E UK graphics packages.

cO
—
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OVER 75% OF 90% OF ALL IT'S ESTIMATED
RECOMMENDED FACEBOOK POSTS THAT OVER 75% OF
CONTENT FROM NETFLIX ARE FILTERED NASA'S WORKFLOW
IS GENERATED FROM THROUGH PYTHON- AUTOMATION
MACHINE LEARNING - CODED MACHINE SYSTEMS ON BOARD

CODED BY PYTHON. LEARNING. THE I.S.S. USE PYTHON.
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Introducing Python)

Fquipment You
WIill Need

You can learn Python with very little hardware or initial financial investment. You

don't need an incredibly powerful computer and any software that's required is
freely available.

WHAT WE'RE USING

ThankFfully, Python is a multi-platform programming language available for Windows, macOS, Linux, Raspberry Pi and more. If
you have one of those systems, then you can easily start using Python.

COMPUTER

Obviously you're going to need a computer in order to learn how to program in
e Python and to test your code. You can use Windows (from XP onward) on either a 32

- e — ﬁ‘- ﬁ_" or 64-bit processor, an Apple Mac or Linux installed PC.

MES

P AN IDE

&l & An IDE (Integrated Developer Environment) is used to enter and execute Python

code. It enables you to inspect your program code and the values within the code, as
' well as offering advanced features. There are many different IDEs available, so find
the one that works for you and gives the best results.

PYTHON SOFTWARE

macOS and Linux already come with Python preinstalled as part of the operating
system, as does the Raspberry Pi. However, you need to ensure that you're running
the latest version of Python. Windows users need to download and install Python,
which we'll cover shortly.

e puthon

TEXT EDITOR

Whilskt a text editor is an ideal environment to enter code into, it's not an absolute
necessity. You can enter and execute code directly from the IDLE but a text editor,
such as Sublime Text or Notepad++, offers more advanced features and colour coding

S s when entering code.
| Python is an ever evolving environment and as such new versions often introduce

T————————————— S new concepts or change existing commands and code structure to make it a more
i e 2 Gy S A e e e® : efficient language. Having access to the Internet will keep you up-to-date, help you
o T | —, out when you get stuck and give access to Python’s immense number of modules.
ZETJ'” . :: | it oty smmmntnr. et ni o meaanie ey s ik
e o B e e
Srmmstsn . 15| ik oo e s SRR e 1 TIME AND PATIENCE
g " _ _ ,

e R Despite what other books may lead you to believe, you won't become a programmer

; l::;:-_;_.;E;:::?:::.-::;:1:::2::?*’;:2““*' i in 24-hours. Learning to code in Python takes time, and patience. You may become

|| ot it smmarnt i S oty 1k stuck at times and other times the code will Flow like water. Understand you're learning

R A R A N e N o . S SDmE‘thing entirelyr new, and you will get there.




THE RASPBERRY PI

< Equipment You Will Need

Why use a Raspberry Pi? The Raspberry Pi is a tiny computer that's very cheap to purchase, but offers the user a fantastic learning
platform. Its main operating system, Raspbian, comes preinstalled with the latest Python along with many modules and extras.

RASPBERRY PI

The Raspberry Pi 4 Model B is the latest version,
incorporating a more powerful CPU, a choice of 1GB,
2GB or 4GB memory versions and Wi-Fi and Bluetooth
support. You can pick up a Pi from around £34, increasing
up to £54 for the 4GB memory version, or as a part of kit
For £50+, depending on the kit you're interested in.

#
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ll FUZE PROJECT

LI

The Raspberry Pi's main operating system is a Debian-based
Linux distribution that comes with everything you need in

a simple to use package. It's streamlined for the Piand is an
- ideal platform For hardware and software projects, Python
« programming and even as a desktop computer.
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The FUZE is a learning environment built on the latest model
of the Raspberry Pi. You can purchase the workstations that

come with an electronics kit and even a robot arm for you

to build and program. You can find more information on the

FUZE at www.fuze.co.uk.

We have several great Raspberry Pi titles available via www.
bdmpublications.com. Our Pi books cover how to buy your
First Raspberry Pi,

set it up and use

it: there are some great step-
by-step project examples and
guides to get the most from
the Raspberry Pi too.
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Getting to Know Python

PYTHON POWER

Python is a high-level, general-purpose programming language that was designed by Guido van Rossum in the late ‘80s, as a
successor to the ABC Programming Language, and became available to use in 1990.

. Guido van Rossum, the
¥ designer of Python.

P o
¥

The Python Software Foundation, a non-profit organisation devoted
to both furthering and improving Python, currently develops the
language. The foundation'’s purpose is to “promote, protect, and
advance the Python programming language, and to support and
Facilitate the growth of a diverse and international community of
Python programmers.”

The structure of Python code has been designed to Flow easily,
allowing those who are just beginning to code to follow it without
too much diffFiculty. Yet, despite its ease of use, Python is regularly
used throughout a number of industries in real-world scenarios.

Big Data and Al are the two Fastest growing Python-backed
technologies at the moment. Big Data is simply a modern term

used to describe huge

| amounts of data,

o such as sequences

of numbers collated
during a day's worth of
trading on the Stock
Exchange. Python
code is used to dig

folder_path = Ve path. vt [l ¥ P Lagaivhi )
5 EEC obiects selecoes 4 *
wiewport_selection = by, context. selected shisr

'ﬂbi_ﬁlﬂl;"l-lhl = virmport_selection
¥ self use selection setriag == Felse

obf_espart_ 1t = [T M 1R H-!.--::Ml:ut-m.mt

by . g ok oot pelect sl lisction= "0ESELECT )

T e e into the voluminous
o collection of numbers,
e e e e
e and then feed back
I"""l - - ""'H."Illl ril-ll

with reports on the
highs and lows, what's
trending, and so on.

ﬁ Python code is both elegant and
é easy to read (when you know how).

www.bdmpublications.com

Made up from over 5 Petabytes of data, spread across a
@ ton of hard drives, Python helped science to unveil the First
image of a black hole.

As a side note, it's not just the likes of the Stock Exchange that

use Python to study large quantities of data; in April 2019 the First
image of a black hole was released, the supermassive black hole in
the galaxy called M87, located roughly 55 million light years away.
Thanks to the collaboration of over 200 scientists, using an array of
telescopes spanning the world (called the Event Horizon Telescope
Project), the combined power of the telescopes formed an
impressive five petabytes of data, spread across tens of hard drives
weighing in at nearly one ton. Five petabytes, by the way, equates
to around 5,000 years' worth of MP3 files. Once all those hard drives
were gathered together and shipped to a central supercomputer
cluster, the team then used Python to painstakingly stitch together
all the fragments of data from the five petabytes to finally form the
most talked about astronomic event of the decade.

Al, if you're not familiar with the term, stands for Artificial
Intelligence. Although we're still a long way off from the visionary
stories of Arthur C. Clarke, Al is fast becoming one of the most
influential technologies of our modern age. Rather than controlling
robots, the Al that Python drives is designed to create autonomous
ways of interacting with people online. For example, when you
search for something on the Amazon website you will usually notice
that similar products start to appear, whether within Amazon itself,




PYTHON 3 VS PYTHON 2

Getting to Know Python </>

In a typical computing scenario, Python is complicated somewhat by the existence of two active versions of the language:

Python 2 and Python 3.

e python’

About Downloads Choc L tation Commaiani by Surcrss Shornes Blrwes Fwinits

Python 3 is the best option to
download, or update to.

o

Python 3 is the newest release of the programming language.

However, if you dig a little deeper into the Python site and investigate

Python code online, you will undoubtedly come across Python 2.
Crucially, although you can run Python 3 and Python 2 alongside
each other, it's not recommended. Always opt for the latest stable
release, as posted by the Python website. You will find, when using
macOS or Linux, that Python 2 is already installed. This is because
both these operating systems utilise elements of code necessary to
the core functionality of the OS. Linux users tend to be better off,
as most distributions package the latest version of Python 3 out-of-
the-box, whereas macOS often has Python 3, it's usually an older

version. Microsoft doesn’t use any Python code for its core Windows
systems, which is why you won't find Python inherent to Windows and

therefore need to install it from scratch.

or from a search engine, or even Facebook. The code behind
these targeted snippets is Python, and it's using a form of Al to
help determine what it is you would likely search for.

Despite the Fact that many people find the targeting of
advertising intrusive, or even an invasion of privacy, you have to
admit that the code technology behind it all is rather impressive.
With some very clever techniques, a Python developer is able

to create a machine thinking script that not only displays items,
news stories, books, other websites and ideas relating to what
you've searched for, but it can also predict what you may be
interested in looking for in the future. Another element to
consider, with regards to Al, is that Python code can be used to
help a computer learn how to do something more efficiently. In
the case of neural networks in Al, the Python code is designed
to return a result, then, as the code is run over and over again,
the Al portion will begin to learn how to obtain a more accurate
result, or do the maths behind the code quicker. It all depends on
what the developer wants from their Al Python code.

ﬁ An example of Python Al code, using a
e feedforward neural network.

random
numpy np
class Network(object):
def __init__(self, sizes):
self.num_layers - len(sizes)
self.sizes sizes

self.biases [np.random. randn(y, 1) y sizes[1:]]
self.weights [np.random. randn(y, x)
X, ¥ zip(sizes[:-1], sizes[1:])]

def feedforward(self, a):
b, w zip(self.biases, self.weights):
a - sigmoid(np.dot(w, a)+b)
a
def SGD(self, training data, epochs, mini_batch _size, eta,
test data=None):

You need to be careful when you look up Python code online, although
there are countless websites that offer quick tutorials, code snippets
and support - and 99% of these site are a great help to those starting
out with Python —a lot of the sites haven't been updated for some
time, and as such use Python 2. If you enter Python 2 code into the
Python 3 IDLE, the chances are it won't work due to incompatibilities
between the older version and the newer. Python 2 is good, but
Python 3 is better. You can obviously spend time converting the
Python 2 code into version 3, but, to begin with, it’s best to make sure
that the code you're looking at is for the Python 3 libraries. Don’t
worry, though, all the code in this book is designed for Python 3, and
that includes all the sub versions from Python 3.1 to the latest 3.x.

Python 3’s growing popularity has meant that it's now prudent to start
learning to develop with the new features and begin to phase out the
previous version. Many development companies, such as SpaceX and
NASA, use Python 3 for snippets of important code.

However, support for Python 2 is set to end on January 1st 2020, but
this doesn’t mean it'll be the last you see of it. Many Linux distros use
Python 2 libraries, as does macOS, and to be fair, for the developers

to transfer the existing Python 2 content to Python 3 may take more
time than they have available, i.e. before the start of 2020. It's likely
then, that we will still be seeing Python 2 long after it has had the final
nail hammered into its coffin = in fack, expect to see that cut-off date
extend Further into the future.
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ZEN OF PYTHON :

Python lets you access
all the power of a
computer in a language
that humans can
understand. Behind all
this is an ethos called
“The Zen of Python".
This is a collection of 20
software principles that
infFluences the design of

the language. Principles P
include “Beautiful is e
better than ugly” and import this, into the

- “Simple is better than Python IDLE.

complex.” Type: :
into Python and it will display all the principles. :

The Zen of Python, as
seen when entering:

As you will discover over the coming pages, Pythonis a

fantastic language to learn. Get to grips with the basics, and
before long, you'll be creating your own Python code for :
. games, tools, and maybe even somethingin Al. The only limit
+ with Python is your own imagination.



Introducing Python)

How to Set Up

Python in Windows

Windows users can easily install the Python programming language via the main Python

Downloads page. While most seasoned Python developers may shun Windows as the
platform of choice for building their code, it's still an ideal starting point for beginners.

INSTALLING PYTHON 3.X

Microsoft Windows doesn’t come with Python pre-installed as standard, so you're going to have to install it yourselF manually.

ThankFully, it's an easy process to follow.

STEP 1 >
org/downloads/. Look for the button detailing the

Download link For Python 3.x. Python is regularly updated, changing
the last digit for each bug fix and update. Therefore, don't worry if
you see Python 3.7.0, or more, as long as it's Python 3, the code in
this book will work fine.

Start by opening your web browser to www.python.

e python’

About Downloads Documentation Community Success Stories New:

Download the latest version for Windows

E—— 5
' ' . |
Download Python 3.9.0
ooking for Python with a different 05? Python for Window
Linux/UNIX, Mac O5 X, Other

R R R R R AR R R R R AR R R R R R R R R R R R R R R R R R R R R R R R R R R R R R R

Click the download button for version 3.x, and save
the file to your Downloads folder. When the file is

STEP 2

downloaded, double-click the executable and the Python installation
wizard will launch. From here you'll have two choices: Install Now and
Customise Installation. We recommend opting for the Customise

Installation link, and that the Add Python 3.x to PATH option is ticked.

G Python 3.9.0 (64-bit) Setup X

} Install Python 3.9.0 (64-bit)

Select Install Now to install Python with default settings, or choose
Customize to enable or disable features.

@ Install Now
C\Users\dawvwd\AppUata\Local\Programs\Python\Python34

Includes IDLE, pip and documentation
Creates shortcuts and file associations

—> Customize installation
Chooze location and features

nuithon

Choosing the Customise option allows you to
specify certain parameters, and while you may
stay with the defaults it's a good habit to adopt as sometimes (not
with Python, thankfully) installers can include unwanted additional
features. On the first screen available, ensure all boxes are ticked
and click the Next button.

STEP 3

& Python 3.9.0 (64-bit) Setup -

Optional Features

B4 Documentation

Installs the Python documentation file,
B pip

Installs pip, which can download and install other Python packages.
b tdl/tk and IDLE

Installs tkinter and the IDLE development environment

b4l Python test suite
Installs the standarg lorary test suite.

A py launcher [ for all users (requires elevation)

e A= & b - b=l e 1= B R N e e . = Pt T = e
=ldils LNe QIoDal Py launcner 1O make Il easier 10 slart !'.:'j... on

puthon

STEP 4 The next page of options include some interesting
additions to Python. Ensure the Associate file with
Python, Create Shortcuts, Add Python to Environment Variables,
Precompile Standard Library, and Install for All Users options are
ticked — these make using Python later much easier. Click Install
when you're ready to continue.

gﬁ Python 3.9.0 (64-bit) Setup - X

Advanced Options

[ Install for all users

b Associate files with Python (requires the py launcher)
[ Create shorteuts for installed applications

A Add Python to environment variables

4 Precompile standard library

[_] Download debugging symbeols
[] Download debug binaries (requires VS 2017 or later)

Customize install location

C\Program Files\Python39 Browse

niithon
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You may need to confirm the installation with the
Windows authentication notification. Simply click

Yes and Python will begin to install. Once the installation is complete
the final Python wizard page will allow you to view the latest release
notes, and follow some online tutorials.

=
i
J Setup was successful
New to Python? Start with the online tutonal and
locumentation. At your terminal, type “"py to launch Python,
or search for Python in your Start menu.

See what's new in this release, or find more info about using

python

Close

windows
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Windows 10 users will now find the installed
Python 3.x within the Start button Recently Added

section. The first link, Python 3.x (64-bit) — or 32-Bit (more on that
in @ moment) - will launch the command line version of Python
when clicked (more on that in a moment). To open the IDLE, type

IDLE into Windows start.

Best match

IDLE (Python 3.9 64-bit)
aApn

IDLE ;
j @, = . IDLE (Python 3.9 64-bit)
Integrated Development Envir... 1l o
Apps
idle.bat > ! Oiben
Search the web > Run as administrator
£ idle - see web results ’ Open file location
Documents (12+) Pin to Start
Folders (2+) Fin to taskbar

| Uninstall
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Clicking on the IDLE (Python 3.x 64-bit) link will
launch the Python Shell, where we'll begin our

STEP 7

Python programming journey. Don't worry if your version is
newer, as long as it's Python 3.x our code will work inside your
Python 3 interface.

& Python 3.9.0 Shell O

File Edit Shell Debug Options Window Help
Python 3.9.0 (tags/vw3.9.0:9cfel52, Oct 5 2020, 15:34:40) [MSC w.l
L

Type *help*, "copyright®, “credits" or "license()"”

< How to Set Up Python in Windows </>
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IF you now click on the Windows Start button again,
and this time type CMD you'll be presented with
the Command Prompt link. Click it and you'll be at the Windows
command line environment. To enter Python within the command
line, you need to type: python and press Enter.

B Command Prompt - python

STEP 9 The command line version of Python works in much the
same way as the Shell you opened in Step 7; note the
three left-facing arrows (>>>). While it's a perfectly fine environment,
it's not too user-friendly, so we'll leave the command line for now. Enter
exit () toleave, and close the Command Prompt window.

@ Command Prompt
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There are bwo versions of the latest Python
available, 32-Bit and 64-Bit. Essentially, the 64-Bit

version of Python allows you to utilise more than 4GB of memory.
While this is great for users with a lot of memory, and memory hungry
processes, it's not an essential feature of Python. However, the 32-bit
version may provide more compatibility with existing modules.
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o . '. . -



</> Introducing Python

How to Set Up
Python in Linux

While the Raspberry Pi's operating system contains the latest, stable version of Python,
other Linux distros don’t come with Python 3 pre-installed. If you're not going down
the Piroute, then here’s how to check and install Python for Linux.

PYTHON PENGUIN

Linux is such a versatile operating system that it's often difficult to nail down just one-way of doing something. Different
distributions go about installing software in different ways, so For this particular tutorial we will stick to Linux Mint.
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STEP 1 First you need to ascertain which version of Python STEP 4 Once the update and upgrade completes, enter:
is currently installed in your Linux system. To begin python3 --version again to see if Python 3.xis

with, drop into a Terminal session from your distro's menu, or hit the  updated, or even installed. As long as you have Python 3.x, you're

Ctrl+Alt+T keys. running the most recent major version, the numbers after the 3.
indicate patches plus further updates. Often they're unnecessary,
david@david-Mint: ~ but they can contain vital new elements.
File Edit View Search Terminal HEIP File Edit View Search Terminal Help

Need to get 1,409 kB of archives.

After this operation, 23.6 kB of additional disk space will be used.

Do you want to continue? [Y/n]| y

Get:1 http;;;arihivE.UbUHtU.Eﬂmfubuutu biﬂnl{'uﬂdﬂtESENain amd64 libasound? an

L B B B BN BN B B BN IR BN BN B I BN O BE BN NN BN BN BN B OE BN BE BN AN BE BN OO B BN BN B BN On Bk BN AN b BE BN BN BN BN B B AN B BN BN O BN BN N BN AN B B BN O I 4115'5”b._|r|t|_]@,2 [359 l"-B]

Get:2 http://archive,ubuntu.com/ubuntu bionic-updates/main amd64 libasound2-

STEP 2 Next, enter: python --version into the Terminal all 1.1.3-5ubuntu@.2 [36.5 kB] i | | |
screen. You should have the output relating to f}j T;EnzleE”ETHTB?DMMT” e gy T

version 2.x of Python in the display. Most Linux distro come with Fetched 1,409 kB 1n @s (3,023 kB/s) . ,
. (Reading database ... 290768 files and directories currently installed.)
both P}r"thﬂﬂ 2and 3 b}," dEFaUlt, as there’s DlEﬂt_V of code out there Preparing to unpack .../libasound2 1.1.3-5ubuntu®.2 -:i"hj!54 deb ...
. . y ; Unpacking libasound2: amdn4 (1.1.3-5ubuntu@.2) over (1.1.3-5ubuntu@.1l) ..
still available for Python 2. Now enter: python3 --version. Preparing to unpack .../libasound2-data 1.1.3-Subuntus.2 all.deb ...

Unpacking libasound2-data (1.1.3-5ubuntu®.2) over (1.1.3-5ubuntu@.l) ...

Preparing to unpack .../linux-libc-dev 4.15.0-44.47 amd64.deb ...

dﬂ?id@dﬂ?id—”iﬂt: ~ Unpacking linux-libc-dev:amd64 (4.15.0-44.47) over (4.15.0-43.46) ...
Setting up libasound2-data (1.1.3-5ubuntu@.2) ...

File Edit View Search Terminal Help
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STEP 5 However, if you want the latest, cutting edge
version, you'll need to build Python from source.

Starkt by entering these commands into the Terminal:

david@david-Mint:~$ python --version
Python 2 ? 15rcl

david@david-Mint:~$ python3 --version
Python 3 6.7

My i+

david@david-Mint: sudo apt—-get install build-essential checkinstall
- sudo apt-get install libreadline-gplv2-dev
libncurseswS-dev libssl-dev libsglite3-dev tk-dev
STEP 3 In our case we have both Python 2 and 3 installed. libgdbm-dev libc6-dev libbz2-dev
As long as Python 3.x.x is installed, then the code in
our tutorials will work. It's always worth checking to see if the distro david@david-Mint: ~

has been updated with the latest versions, enter: sudo apt-get File Edit View Search Terminal Help
Update && sudo apt—get upgrade to Update the System_ david@david-Mint:~$ sudo apt-get install build-essential checkinstall

PPddlnq package lists... Done
Building dependency tree

e PR R R RE R R R R RRRR PR PR RN

. . ) Reading state information... Done
david@david-Mint: ~ build-essential is already the newest wversion (12.4ubuntul).
; , , , The following NEW packages will be 1nstalled
File Edit View Search Terminal Help checkinstall

 fem B 3 3 o 2 : @ to upgrade, 1 to newly install, © to remove and 3 not to upgrade.
I "1!.-. I ] = .| s 1 R— | iy ) =
avid-Mint:~$ python VvErslon Need to get 97.1 kB of archives.

Pytﬂ16r1 2.7.15rcl After this operation, 438 kB of additional disk space will be used.
d@david-Mint:~-% pythnnB --yersion Do you want to continue? [Y/n] vy

Pjthnn 3.6.7

david@david-Mint:~$ sudo apt-get update && sudo apt-get upgrade
[sudol password for david: |
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Open up your Linux web browser and go to the
Python download page: https://www.python.org/

STEP 6

downloads. Click on the Downloads, followed by the button under
the Python Source window. This opens a download dialogue box,
choose a location, then start the download process.

. \
& python

Opening Python-3.7.2.tar.xz

You have chosen to open

- Python-3.7.2 tarxz

About Download

which is: XZ archive (16.3 MB)
from: https:/Awww.python.org

What should Firefox do with this file?

110, m Python Qpenwith  Archive Manager (default) W

What is your name?

Python

Cancel

H1i, Python.

STEP 7 In the Terminal, go to the Downloads folder
by entering: ed Downloads/. Then unzip the
contents of the downloaded Python source code with: tar —-xvf
Python-3.Y.Y.tar.xz (replace the Y’'s with the version numbers
you've downloaded). Now enter the newly unzipped folder with: ed
Bythorn=3.Y.¥/.

Python-3.
Python-3.
Python-3.
Python-3.
Python-3.
Python-
Python-
Python-3.
Python-3.
Python-3.
Python-3.
Python-3.
Python-3.
Python-3.
Python-3.
Python-3.
Python-3.
Python-3

=

.2/0bjects/clinic/floatobject.c.h
.2/0bjects/clinic/funcobject.c.h
.2/0bjects/clinic/longobject.c.h
.2/0bjects/clinic/dictobject.c.h
.2/0bjects/clinic/structseq.c.h
.2/0bjects/clinic/tupleobject.c.h
.2/0bjects/clinic/moduleobject.c.h
.2/0bjects/clinic/odictobject.c.h
.2/0bjects/bytearrayobject.c
.2/0bjects/typeobject.c
.2/0bjects/lnotab notes.txt
.2/0bjects/methodobject.c
.2/0bjects/tupleobject.c
.2/0bjects/obmalloc.c
.2/0bjects/object.c
.2/0bjects/abstract.c
.2/0bjects/listobject.c
.2/0bjects/bytes methods.c
Python-3.7.2/0bjects/dictnotes.txt
Python-3.7.2/0bjects/typeslots.inc
david@david-Mint: $ c¢d Python-3.7.2/

SR o . il e m .
david@david-Mint: g
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STEP 8 Within the Python folder, enter:

. /configure
sudo make altinstall

This could take a while, depending on the speed of your computer.
Once finished, enter: python3.7 --version to check the latest
installed version. You now have Python 3.7 installed, alongside older
Python 3.x.x and Python 2.

checking for --with-ssl-default-suites.
configure: creating ./config.status
config.status: creating Makefile.pre
config.status: creating Misc/python.pc
config.status: creating Misc/python-config.sh
config.status: creating Modules/ld so aix
config.status: creating pyconfig.h

creating Modules/Setup

creating Modules/Setup.local

creating Makefile

.. python

If you want a release build with all stable optimizations active (PGO, etc),
please run ./configure --enable-optimizations

david@david-Mint: $ sudo make altinstall

< How to Set Up Python in Linux </>
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STEP 9

sudo apt—-get install idle3

For the GUI IDLE, you'll need to enter the following
command into the Terminal:

The IDLE can then be started with the command: idle3. Note, that
DLE runs a different version to the one you installed from source.

david@david-Mint: ~/Downloads/Python-3.7.2

File Edit View Search Terminal Help

dasss Bl sl 8-S vl
david@david-Mint:

Reading package lists... Done
Building dependency tree
Reading state information... Done
The followling additional packages will be 1installed:

blt idle idle-python3.6 python3-tk tk8.6-blt2.5
Suggested packages:

blt-demo tix python3-tk-dbg
The following NEW packages will be installed

blt idle idle-python3.6 idle3 python3-tk tk8.6-blt2.5
@ to upgrade, 6 to newly 1install, © to remove and 3 not to upgrade.
Need to get 938 kB of archives.
After this operation, 4,221 kB of additional disk space will be used.
Do you want to continue? [Y/n]

$ sudo apt-get install idle3

STEP 10 You'll also need PIP (Pip Installs Packages), which is
a tool to help you install more modules and extras.

Enter: sudo apt-get install python3-pip

Once PIP is installed, check for the latest update with:
pip3 install --upgrade pip

When complete, close the Terminal and Python 3.x will be available
via the Programming section in your distro’'s menu.

david@david-Mint: ~/Downloads/Python-3.7.2 -

File Edit View Search Terminal Help

david@david-Mint:
Reading package lists...
Bullding dependency tree
Reading state information... Done
The following additional packages will be installed:

python-pip-whl python3-distutils python3-lib2to3
Recommended packages:

python3-dev python3-setuptools python3-wheel
The following NEW packages will be installed

python-pip-whl python3-distutils python3-lib2to3 python3-pip
@ to upgrade, 4 to newly install, @ to remove and 3 not to upgrade.
Need to get 1,984 kB of archives.
After this operation, 4,569 kB of additional disk space will be used.
Do you want to continue? [Y/n] |}

$ sudo apt-get install python3-pip
Done

L B I R OBE O B ORE BB R R N N R RN B NN R O R R N RN N N AN NN B R RN R N AN R RN EENNE

PYTHON ON macOS

Installation of Python on macOS can be done in much the
same way as the Windows installation. Simply go to the Python
webpage, hover your mouse pointer over the Downloads

link and select Mac OS X from the options. You will then be
guided to the Python releases for Mac versions, along with the
necessary installers for macOS 64-bit for OS X 10.9 and later.
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Python on the Pi

If you're considering on which platform to install and use Python, then give some
thought to one of the best coding bases available: the Raspberry Pi. The Pi has many
advantages for the coder: it's cheap, easy to use, and extraordinarily flexible.

THE POWER OF PI

While having a far more powerful coding platForm on which to write and test your code is ideal, it's not often feasible. Most of
us are unable to jump into a several hundred-pound investment when we're starting off and this is where the Raspberry Pi can

help out.

While having a far more powerful coding platform on which to kits available will provide the Pi with a pre-loaded SD card (with the

write and test your code is ideal, it's not often Feasible. Most of us latest Raspbian OS), a case, power socket and cables, this is a good

are unable to jump into a several hundred-pound investment when idea as you could, with very little effort, leave the Pi plugged into the

we're starting off and this is where the Raspberry Pi can help out. wall under a desk, while still being able to connect to it and code.

The Raspberry Pi is a fantastic piece of modern hardware that The main advantage is, of course, the extra content that the

has created, or rather re-created, the fascination we once all had Raspberry Pi Foundation has included out of the box. The reason

about computers, how they work, how to code and foundation fFor this is that the Raspberry Pi's goal is to help educate the

level electronics. Thanks to its unigue mix of hardware and custom user, whether that's coding, electronics, or some other aspect of

software, it has proved itself to be an amazing platform on whichto =~ computing. To achieve that goal the Pi Foundation includes different

learn how to code; specifically, using Python. IDEs for the user to compile Python code on; as well as both Python
2 and Python 3, there's even a Python library that allows you to

While you're able, with ease, to use the Raspberry Pi to learn to communicate with Minecraft.

code with other programming languages, it's Python that has been

firmly pushed to the forefront. The Raspberry Pi uses Raspbian as There are other advantages, such as being able to combine Python

its recommended, default operating system. Raspbian is a Linux code with Scratch (an Object-Oriented programming language

OS, or to be more accurate, it's a Debian-based distribution of developed by MIT, for children to understand how coding works) and

Linux. This means that there's already a built-in element of Python being able to code the GPIO connection on the Pi to Further control

programming, as opposed to a fresh installation of Windows 10, any attached robotics or electronics projects. Raspbian also includes

which has no Python-specific base. However, the Raspberry Pi a Sense HAT Emulator (a HAT is a hardware attached piece of

Foundation has gone the extra mile to include a vast range of circuitry that offers different electronics, robotics and motorisation

Python modules, extensions and even examples, out of the box. projects to the Pi), which can be accessed via Python code.

So, essentially, all you need to do is buy a Raspberry Pi, follow the

instructions on how to set one up (by using one of our excellent Consequently, the Raspberry Pi is an excellent coding base, as well

Raspberry Pi guides Found at www.bdmpublications.com) and you as a superb project Foundation. It is For these, and many other,

can start coding with Python as soon as the desktop has loaded. reasons we've used the Raspberry Pi as our main Python codebase
throughout this title. While the code is written and performed on a

Significantly, there's a lot more to the Raspberry Pi, which makes Pi, you're also able to use it in Windows, other versions of Linux and

it an excellent choice for someone who is starting to learn how to macOS. If the code requires a specific operating system, then, don’t

code in Python. The Pi is remarkably easy to set up as a headless worry; we will let you know in the text.

node. This means that, with a few tweaks here and there, you're able
to remotely connect to the Raspberry Pi from any other computer,
or device, on your home network. For example, once you've set up
the remote connectivity options, you can simply plug the Piinto the
power socket anywhere in your house within range of your wireless
router. As long as the Pi is connected, you will be able to remotely
access the desktop from Windows or macOS as easily as if you were
sitting in front of the Pi with a keyboard and mouse.

Everything you need to learn to code with Python is
included with the OS!

Using this method saves a lot of money, as you don't need another
keyboard, mouse and monitor, plus, you won't need to allocate
sufficient space to accommodate those extras either. If you're pushed
for space and money, then for around £60, buying one of the many
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There’s no such

P oo

Introduced on 24th June 2019, the Raspberry Pi 4 Model B is

a significant leap in terms of Pi performance and hardware
specifications. It was also one of the quickest models, aside from the
original Pi, to sell out.

With a new 1.5GHz, 64-bit, quad-core ARM Cortex-A72 processor,
and a choice of 2GB, 4GB, or 8GB memory versions, the Pi4 is
onestep closer to becoming a true desktop computer. In addition,
the Pi 4 was launched with the startling decision to include dual-
monitor support, in the form of a pair of two micro-HDMI ports.

RASPBIAN BUSTER

In addition to releasing the Pi 4, the Raspberry Pi team also compiled
a new version of the Raspbian operating system, codenamed Buster.

In conjunction with the new hardware the Pi 4 boasts, Buster does
offer a Few updates. Although on the whole it's very similarin
appearance and operation to the previous version of Raspbian. The
updates are mainly in-line with the 4K's display and playback, giving the
Pi4 a new set of graphical drivers and performance enhancements.

In short, what you see in this book will work with the Raspberry Pi
4 and Raspbian Buster!

Once set up, you can remotely connect to the Pi's desktop
from any device/PC.
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You'll also find a pair of USB 3.0 ports, Bluetooth 5.0, and a GPU
that's capable of handing 4K resolutions and OpenGL ES 3.0 graphics.
In short, the Pi 4 is the most powerful of the current Raspberry Pi
models. However, the different memory versions have an increased
cost. The 2GB version costs £34, 4GB is £54, and the 8GB Pi 4 will set
you back £74. Remember to also factor in one or two micro-HDMI
cables with your order.

You can even test connected hardware with Python
remotely, via Windows.
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- Codingwith
Python

It's a long way from creating your First

Python code to controlling a robot on Mars,
but it's not impossible. Every advanced and
professional Python coder started with the
base fundamentals, tips and fFixes mentioned in
this section.

With these foundation Python concepts, you
will be able to advance your skills and branch
out into whatever Python project you have in
mind. From printing Hello World on the screen,
looking into conditions and loops, asking a user
for input and reacting to it, to using variables
to control your code, this is where your Python
skills are forged.
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Starting Python for
the First Time

We're using Python 3 under Windows 10 for these following examples. Don’t worry if

your version of Python is 3.4.2, or something lesser than the current version, as long as

you're using Python 3, the code will work.

STARTING PYTHON

As when learning anything new, you need to start slow. You can pick up the pace as your experience grows, but for now, let's
just get something appearing on the screen. Don’t worry, you'll soon be coding like a pro!

sedFR e RS RERER
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STEP 1

Click on the Windows Start button, and start typing
idle’. The result will be the currently installed
version of the Python IDLE on your system. You can Pin it to the
Start for convenience, otherwise simply click the icon to launch the
Python Shell.

Bty v

_ IDLE (Python 3.7 32-bit) A
A

Appt

IDLE (Python 3,7 32-bit)
T ime.car .

STEP 2 The Shell is where you can enter code and see the
responses and output of code you've programmed
into Python. This is a kind of sandbox, if you will, where you're able
to try out some simple code and processes.

| & Python 3.7.0 Shell — O b4

File Edit 5Shell Debug Options Window Help

Python 3.7.0 (v3.7.0:1bf9cc5083, Jan 27 2018, 04:06:47) [M5C v.1%14 32 bict (Intel)] on win32
Type "copyright™, "credits™ or "license ()" for more information.
FrE I

STEP 3 For example, in the Shell enter: 2+2
After pressing Enter, the next line will display the
answer: 4. Basically, Python has taken the ‘code’ and produced the
relevant output.

| & Python 3.7.0 Shell — 0O X

File Edit 5Shell Debug Options Window Help

Python 3.7.0 (+3.7.0:1bf9cc5093, Jun 27 2018, 04:06:47) [MSC v.1914 32 bit (Intel)] on win3iz
Type "copyright®™, "credits®™ or "license ()" for more information.

3ok 242

?}I

LB O B B N BN BN B B BN OGN B ORE NN BN BN OO N B B B B BN AR B BN BN B AR B NN B OO B IR O B BN B IR B O N OB O N OB O N NN NN B NN NN NN

STEP 4

The Python Shell acts very much like a calculator,
since code is basically a series of mathematical
interactions with the system. Integers, which are the infinite
sequence of whole numbers, can easily be added, subtracted,
multiplied, and so on.

L& Python 3.7.0 Shell — O b
File Edit Shell Debug Options Window Help

Python 3.7.0 (v3.T.0:1bf9ceS5093, Jan 27T 2018, 04:06:47) [MSC v.15914 32 bit (Intel)] on wini2
Type "copyright®™, "credics™ or "license ()™ for more information.
>33 242

3

>>> B46

14

»am 234534045545522

645568575

»>> G8778642342-12343

SHTTEBE295599

ez L2BT43TY43534%

5047282358

.i'.lr,.dl
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While that's very interesting, it's not particularly
exciting. Instead, try this:

STEP 5

print ("Hello everyone!”)

Just enter it into the IDLE as you've done in the previous steps.

| & Python 3.7.0 Shell - O X

File Edit 5hell Debug Optons Window Help

Pychon 3.7.0 (v3.7.0:1bf9cc5093, Jun 27 2018, 04:06:47) [MSC v.1914 32 bit (Intel)] on win32
Type "copyrighc™, "credits®™ or "license ()™ for more information.
a3 242

4

=nm Q4G

14

x> 23453+645545522

6455688975

»a» S9ETTEE42342-12343

S8TTEL&295599

»=> 12BT7437*23534

S6e047282358

>»>» print ("Hello everyons!"})

Hello sveryons!

}};l
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This is a little more like it, since you've just produced
your Ffirst bit of code. The Print command is fairly

STEP 6

self-explanatory, it prints things. Python 3 requires the parentheses
as well as quotes in order to output content to the screen, in this
case the ‘Hello everyone!’ bit.

»»>» print(“Hello everyone!™)
Hello everyone!
=>> |

STEP 7 You'll have noticed the colour coding within the
Python IDLE. The colours represent different

elements of Python code. They are:

Black — Data and Variables Blue — User Functions

Green —Strings Dark Red — Comments
Purple — Functions Light Red — Error Messages
Orange — Commands

IDLE Colour Coding

Colour | Usefor | Examples
Black Data & variables 23.6 area
Green Strings "Hello World"
Purple Functions len() print()
Orange Commands if for else
Blue User functions get area()
Dark red Comments #Remember VAT
Light red Error messages SyntaxError:

< Starting Python For the First Time </ >
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9§ ==X: 3 The Python IDLE isa configurable environment. If
you don't like the way the colours are represented,
then you can always change them via Options > Configure IDLE, and

clicking on the Highlighting tab. However, we don't recommend that
as you won 't be seeing the same as our screenshots.

- - - - 1 ™
La‘ Pyt tal=tl] - ]

File Edit Shell Debug Options Window Help
Fython 3.7.0 [(v3.7.0:1bf9%cc5093, Junm 27 2018, 02:08:47) [MSC w.19142 32 bit (Intel)] on win32
Iype "copyright™, "credita"™ or "license(}"™ for more information.

»p2 242

4

>»> B+6

14

e 23453+645545522
E45568075

2> SBTTHE42342-12343
98778629599

x> 128T7437v43534

S560497ZRZ358
>>> princ(®"Hello everyone!") Select :

(® a Built-in Theme

a Custom Theme

Lj Settings X

Fonts/Tabs Highlights Keys General Extensions

Custorn Highlighting Highlighting Theme

Hella sveryone!
>

IDLE Classic F=|

(@) Foreground {_) Background

- no custom themes - —

#you can click here
tto choose items
code context asction

Cielete Custom Theme

def func(param) :

F'Iﬂlr_-trIL-:In-Fﬂlr
= b nilg

STEP 9 As with most programs available, regardless of the
operating system, there are numerous shortcut
keys. We don’t have room for them all here, but within the Options
> Configure IDLE and under the Keys tab, you'll see a list of the
current bindings.

[ Python 3,7.0 Shel 0

File Edit 5Shell Debug Options Window Help

Python 3.7.0 (v3.7.0:1bf5cc5053, Jun 27 2018, 04:06:47) [M5C v.1514 32 bit (Intel)] on win32
Type "copyright", "credita™ or "license(}"™ for more informatiom.

>2> Z+2

4

>33 B+6
14
>3> 23453+645545522 | & Settings
6455689TS
>>> BBTTE642342-12343 Fonts/Tabs Highlights Keys General Extensions
SETTEE2995%
>>> 128T33T243534
Ee04T282358
>3 print{"Hello sveryane!™)
Hello everyvone! Usea Custorn Key 52t - no custom keys- —d
s
Delete Custom Key Set Save as Mew Custom Key Set
Custom Key Bindings
Action - Key(z)
beginning-of-line - <Key-Home= ~

center-insert - < Control-Key-1> < Control-Key-L=

change-indentwidth - <Alt-Key-u> <Meta-Key-u> <Alt-Key-U> <Meta-Key-
check-module - <AR-Eey-x=

close-all-windows - <Control-Key-q> <Control-Key-O>

clase-window - <Al-Key-Fi= <Meta-Key-Fi=

comment-region - <Al-Key-3> <Meta-Key-3=

copy - <Control-Key-c> <Control-Key-C»

The Python IDLE is a power interface, and one
that's actually been written in Python using one

STEP 10

of the available GUI toolkits. If you want to know the many ins and
outs for the Shell, we recommend you take a few moments to view
https://docs.python.org/3/library/idle.html, which details many of
the IDLE's features.

25.5. IDLE

Source code: Liboadkeih
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Coding with Python>

Your First Code

Essentially, you've already written your first piece of code with the print(“Hello

everyone!”) function from the previous tutorial. However, let's expand that and look at
entering your code and playing around with some other Python examples.

PLAYING WITH PYTHON

As with most languages, computer or human, it’s all about remembering and applying the right words to the right situation.
You're not born knowing these words, so you need to learn them.

STEP 1 IF you've closed Python 3 IDLE, re-open it as you
did in the previous page. In the Shell, enter the

Familiar Following:

print(“"Hello®™)

[ Python 3.7.0 Shell o 0

File Edt Shell Debug Options Window Help

Python 3.7.0 (v3.7.0:1bfS%cc5093, Jun 27 2018, 04:06:47) [MSC v.1914 32 bit (Intel)] on »

Windd
Type "™copyright™, "credits™ or "license()™ for more information.
>>> print ("Hello"™)

Hellao
>

0
0
B e e RRERRRERRRRRRRRERRE E;-'(E- ssddsensens {E+- s .
| As predicted, the word Hello appears in the Shell
as blue text indicating outputfrom a string. It's
Fairly straightforward, and doesn’t require too much explanation.
Now try: ]
] 5 print?“2+£ﬁ) 000 ] f 1 0O
| U 0 0

L@ Python 3.7.0 Shell = O <

File Edt 5Shell Debug Options Window Help

Bython 3.7.0 (v3.7.0:1bfS%cc50593, Jun 27 2018, 04:06:47) [M5C v.1514 32 bit (Intel)] on -
win3z2

Type "copyright™, "credits™ or "license ()™ for more information.

>>> print ("Hello")

Hello

>3>> print("2+2")

242

]

-

STEP 3 You'll notice that instead of the number 4, the
output is the 2+2 you asked to be printed to the
screen. The quotation marks are defining what's being outputted

to the IDLE Shell, to print the total of 2+2 you'll need to remove
the quotes:

print(Z+2)

[® Python 3.7.0 Shell - B

File Edit 5hell Debug Options Window Help

Python 3.7.0 ([(v3.7.0:1bf8cc50583, Jun 27 2018, 04:06:47) [M5C w.1%14 32 bit (Intel)] omn |#
win3z

Type "copyright™, "credits™ or "license ()™ for more information.

>>»> print("Hello™)

Hello

>55 print [("2+2")

242

2> print (24+2)

-

o>
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Ymiﬁtan continue as such, printing 2+2, 464+2343 |
and so on to the Shell. An easier way is to use a

variable, which is something we will cover in more depth later. For

now, enter: 0 0 0

a=2z ) _
b=2 | |
| O - o 0 1

uiEWﬂ“n'_ﬁr"Hl B U

File Edt Shell Debug Options Window Help
Python 3.7.0 (v3.7.0:1bfScc5093, Jun 27 2018, 0D4:06:47) [MSC v.1914 32 bit (Intel)] on

wWinds

Type "copyright™, "credits™ or "license()"™ for more information.
>>> print ("Hello"™)

Hello

>>> print ("2+2")

2+2

=>>> print (2+42)
q
2> a=2

2>> =2
2>




= —

rm—_
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=R Whatyou have done here is assign the letters a
and b two values: 2 and 2. These are now variables,
which can be called upon by Python to output, add, subtract, divide
and so on, for as long as their numbers stay the same. Try this:

print (a)
print (k)

(Your First Code </>
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STEP 8 Now let's add a surname;

surname="Hayward”
print (surname)

We now have two variables containing both a first name and a
surname, and we can print them independently.

& Python 3.7.0 Shell B

File Edt 5Shell Debug Options

Window Help

Python 3.7.0 (v3.7.0:1bfS%cc5053, Jun 27 2018, 04:06:47) [M5C v.15914 32 bit (Intel)] on
win32

Type "copyright™, "credica™ or "license ()™ for more information.
>>»> print {("Hello™)

Hello

=x> print ("242")

Z+2

>>> print(2+2)

4

>3 am

>»>» b2

>»>» print{a)

&

>»>» print (b}

2

e e -]
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STEP 6 The output of the last step displays the current
values of a and b individually, as essentially you've
asked them to be printed separately. If you want to add them up,
you can use the followinag:

print (a+b)

This code takes the value of both a and b, adds them together, and
outputs the result.

[# Python 3.7.0 Shell = B

File Edit Shell Debug Options
Python S.T.G (v3.7.0: lbe::EGEE Jun 27 2018, 04:06:47) [HS5C vw.1%14 32 bhit (Intel)}] on
win3z2

IType "copyright™, "credita™ or "license ()™ for more information.

»>27» print("Hello™)

Hello

222> print ("2+2")

2+2

>2»> print(2+2)

4

»x» g=2

>»> b2

»>>> print(a)

2

>»> print (b)

2

>>»» print (a+h)

4

undcﬁ Hﬂp

e
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STEP 7 You can play around with different kinds of variables
together with the Print Function. For example, we
could assign variables for someone’s name: 1 O

o

[ i A 1
; [ ]

name="David” \J
print (name)

0 1 ( ]

[@ Python 3.7.0 Shel O

FHE Edit bﬂe” Deth Gphﬂn Wﬁnﬂnw HEm

Pythnn <. e (B D {(v3.7.0: lbeGEEGEE Jun 27 2018, 04:06:47) [M5C v.1914 32 bit (Intel)] on
win32

Type "copyright™, "credits™ or "license ()™ for more information.
»»> print ("Hello"™)
Hello

»>>»> print ("242")
2+2

>»> print (24+2)

.q

3> a=2

>>> =2

»»> print (a)

2

>»> print [b)

2

»>> print [a+b)

!

>>> name="David"
>>»>» print [name)
David

e

0 0 ( | i 0

File Edit 5hell Debug Options

Python 3.7.0 (v3.T7.0:1bfScci5093, Jun 27 2018, 04:06:47) [MS5C v.1914 32 bit (Inte
1})] on win32

Type "copyright™, "credits™ or "license()" for more information.

»>»> name="David"

>»> print (name)

Dawvid

>>»> surname="Hayward"

»>>»> print |(surname)

Hayward

>

Window Help
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STEP 9 If we were to apply the same routine as before,
using the + symbol, the name wouldn’'t appear
correctly in the output in the Shell. Try it:

print (name+surname)

We need a space between the two, defining them as two separate
values and not something you mathematically play around with.

L@ Python 3.7.0 She O

File Edit 5hell Debug Ophons

Pycthon 3.7.0 (v3.7.0:1bfS%ccS5093, Jun 27 2018, 04:06:47) [MSC w.1914 32 bit (Inte
1})] on win32

Type "copyright", "credita™ or "licenses()"™ for mors= information.
>>> name="Lavrid"

>>> print (name)

David

>>> surname="Hayward"

>>> print (surname )

Hayward

>>»>» print (name+surnames)

DavidHayward

e

Window Help

STEP 10 | In Python 3 we can separate the two variables
with a space by using a comma: ¢

print (name, surname)

Alternatively, you can add the space yourself:, |

print (name+” “+surname)
0 ; ]
As you can 5%@ he use of I:he comma is much neater. "
]N ?gratulau ns, you've just taken your First steps into he w%e
0

ld of Python.
0 D 0 ] 1

LjiF theon 3./.0 She

File Edit 5hell Debug Options Window Help

Python 3.7.0 (v3.7.0:1bf%cc30%3, Jun 27 2018, 04:06:47) [M5C v.1951l4 32 bit (Inte

1)] on win32
Iype "copyright®, “credits™ or "license ()™ for more information.

>>> name="David"®

>>>» print (name)

David

»>>» surname="Hayward"
»>»>» print(surname)
Hayward

»>> print (name+surname)
DavldHaywaId

-

G
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Coding with Python>

Saving and Executing

Your Code

While working in the IDLE Shell is perfectly Fine for snippets of code, it's not designed

fFor entering longer program listings. In this section, we'll introduce you to the IDLE
Editor, where most of our code will be entered from now on.

EDITING CODE

You will eventually reach a point where you have to move on from inputting single lines of code into the Shell. Instead, the

IDLE Editor will allow you to save and execute your Python code.

STEP 1 First, open the Python IDLE Shell. When it's up, click

on File > New File, this will open a new window with
Untitled as its name. This is the Python IDLE Editor, and within it, you
can enter the code you need to create your future programs.

e bdit Shell Debug Uphons Window Help file Cdit Formet Run  Options Wondow Help

Pyihon 3.7.0 (v3.7.0:1b0%c50%3, Jun 27 2018, 04:06:47) [HSC v.1%14 32 biu (Inte
I on windz

Type "copyright®, ®oredita® or
T

Rlicense (j® for more information.

STEP 2 The IDLE Editor is, for all intents and purposes, a
simple text editor with Python features, colour
coding and so on. You enter code as you would within the Shell, so
taking an example from the previous tutorial, enter:

print ("Hello everyone!”)

L “vinivted

e Ede Cowst fom ptions Yo el

ip..:l...t

STEP 3 As you can see the same colour codingis in place in
the IDLE Editor as it is in the Shell, enabling you to
better understand what's going on with your code. To execute the
code, however, you need to first save it. Press F5 and you'll have a
Save...Check box open.

Click on the OK button in the Save box, and select a

destination where you'll save all your Python code.
The destination can be a dedicated folder called Python, or you can
just dump it wherever you like. Remember to keep a tidy file system,
though, it’'ll help you out in the future.

- -2 + & » ThisPC » Locel Disk (C) w

I-||'ni|'h4',l' - ew el der
ﬁ .3
& Orselivive Hame Date modidied
1 F
B Thie PC !Gftfluml d
- aulivity Fite fuld
B 30 Objects T
B Deskiop monitonng P r id
E Documents Perfl ngx 1M ANAR B33 Filw faldnr
.l,. Digearriboads Program Files ZMANANE TS kdetolder
B Muic Piugeari Files (8 24 D205 1044 File fuldes
= Pt Prograrmlata QD3 2009 1424 Fiie faldes
3 Pythan Codie SRS 20TT 161D Fidg falder
. Wideot
Speccy PO BB 1 %3 File faide
dee Local Disk (C:) Iermip 010 200 1350 Fila folde r
g Mew Vidume (D Unified Android Toolk 04/07/2017 1608 File folder
g & Licers S IR i) File daleler
Wandows CRA0S/2080 05610 Fibe falder

File name: |




STEP 5 Enter a name for your code, ‘print hello’ for
example, and click on the Save button. As soon
as the Python code is saved, it's executed and the output will be
detailed in the IDLE Shell; In this case, the words ‘Hello everyone!'.

[B Bython 370 She [ - (B print het
File Edst Shefl .-!rII::.I_.I E[l'...l-'. Windows H-.-||:: Ele  Edit
Bython 3.7.0 (v3.7.0:1bfScc50%3, Jun 27T 2018, 04:06:47) [M5C w.1%14 32 bitc (Inte

151 mm wim3?
Iype "copyright® Poredits® or "license ()™ for more informarion.

Format FRun Ogptions

print ("Hello azrerycone!®)

IInTh

RESTART: C:/DPychon Code/print hello.py
Helle everyone!
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This is how the vast majority of your Python code
will be conducted. Enter it into the Editor, hit F5,

STEP 6

save the code, and look at the output in the Shell. Sometimes things
will differ, depending on whether you've requested a separate
window, but essentially that's the process and, unless otherwise
stated, this is the method we will use.

Li Pvthan 3.7.0 Shi : E|

File Edit Shell

Debug Options Window Help

Python 3.7.0 (v3.7.0:1bfScch093, Jun 27 2018, 04:06:47) [M5C v.1914 32 bit (Inte
1)] on win32

Type “"copyright®™, "credits™ or "license()"™ for more information.
=3

= = RESTART: C:/Python Code/print hello.py = ===
Hello everyone!
-3

IF you open the file location of the saved Python
code, you'll notice that it ends in a .py extension.

STEP 7

This is the default Python filename, any code you create will be
whatever.py, and any code downloaded from the many Internet
Python resource sites will be .py. Just ensure that the code is written
for Python 3.

| |_-:: = | Python Code

Hamea Share Wiy

i 1T » This PC » Lecal Disk (C) » Python Code v O

FEarmie Date moddied I_-.-F-l_- b Pl

» 3 Ouick access
[# print hello.py

03062019 1109 Python File 1KB

. % Dropbox (Team BDM)
» flls OneDrive

w [ This PC
» ) 3U Ubgects
» A Deskiop
. 2| Documcnts
+ b Newnlnacds
- gy Music
&= Pictures
» [ Videos
¥ e Local Digk (C:)
» g MNew Volume [0:)

. ¥ Metwork

<Saving and Executing Your Code </>
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Let’s extend the code and enter a few examples
from the previous tutorial:

a=2z

b=2

name="David”
surname="Hayward”
print (name, surname)

print (a+b)

IF you press F5 now, you'll be asked to save the file again, as it's been
modified from before.

(&7 e
! t fig T fFin Ed - o
Fyelwom ¥.7.0 (wl).7.06ilbI%ccEonl, Jus 17 IGLE, O4i0€14T) [HEC w.Ll9L4 22 bic (Imce PELEE{ "ErLLE ST rans )
1i) o wimdd A=3
TYpr "oapyrighe™,; "oredisa™ or "licenseq|)” informasiom. EsD
3 nades WL

EESTARET ; i/ rythea Cods/prant Belle.Fy sugname="Hewnpd™

EHile eTRTyToae! PEAmE (hame, @i

A Sove Defooe Pum or Check X
Srurve Bhusl Br Santd
Of 10 Sase?

[ o ][ conca
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STEP 9

If you click the OK button the Ffile will be overwritten
with the new code entries, and executed; with the
output in the Shell. It's not a problem with just these few lines, but

if you were to edit a larger file overwriting can become an issue.
Instead, use File > Save As from within the Editor to create a backup.

[_i *print hello.py - C:/Python Code/print hello.py (3.7.0) =

File Edit Format Run Options Window Help

MNew File Ctrl+N

Open... Ctrl+0

Open Module... Ak+M

Recent Files k

Module Browser ARl+C

Path Browser

Save Ctrl+S
Ctrl+Shift+5

Save Copy As... Alt+5hift+5

Print Window Ctrl+P

Close Alt+F4

Exit Ctrl+Q

STEP 10

Now create a new file. Close the Editor, and open
a new instance (File > New File from the Shell).
Enter the following, and save it as hello.py:

a="Python”
b="1sg"
c="cool!”
printia, b, )

We will use this code in the next tutorial.

!_% hello.py - C:/Python Code/hello.py (3.7.0) = O X
File Edit Format Run Options Window Help

a="pPython"
b="ia"
c="cool!™
print{a, b, :ﬂ




Coding with Python >

Fxecuting Code from
the Command Line

While we're going to be working from the GUI IDLE, it's worth taking a moment to look

at Python's command line handling. Sometimes, depending on the code you write,
executing via the command line is a better solution over the IDLE.

COMMAND THE CODE

Using the code we created in the previous tutorial, the one we named hello.py, let’s see how we can run code that was made in
the GUI at the command line level.

IIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIII

When you first installed Python, the installation STEP 3 Now you're at the command line, we can start

routine automatically included all the necessary Python using the command python and pressing
components to allow the execution of code outside of the GUI the Enter key. This will put you into the command line version of the
IDLE; in other words, the command line. To begin with, click on the Shell, with the fFamiliar, three right-facing arrows as the cursor (>>>).

Windows Start Button, and type: cmd.

#5t rrbch

- Command Prompt

Evarch the web

From here you're able to enter the code you've
looked at previously, such as:

STEP 2 As you did when launching the Python IDLE,
click on the returned result from the search, the
Command Prompt App. This will launch a new window, with a black

background and white text. This is the command line, also called a
Terminal in macOS, Linux, and Raspberry Pi operating systems.

a=2
print (a)

As you can see, it works exactly the same.




N

/ Executing Code from the Command Line \*ﬁf;)
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Now enterexit () to leave the command line
Python session, and return back to the command
prompt. Enter the folder where you saved the code from the
previous tutorial, and list the available files within; you should see
the hello.py file.

(Vversion 16.8.17763 jiE:
+' Corporation.

_IIIIJ
q_l rights reserved.

.Fh—}-p

211
-U_ 7.8:1bf9cc5893, Jun 27 2018, ﬂﬂ:DE:i?} [MSC v.

yright”, ”-."-.-_'-:.Ii‘.'-" or "license”™ for more

1914 32 bit |

intormation.

T!EFTTPCﬂ Code>»dir/w
Volume in drive C has no label.

Volume Serial Number i:- BE47-ABFF

Directory of C:\Python Code
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From within the same folder as the code you're going
to run, enter the following into the command line:

python hello.py
This will execute the code we created, which to remind you is:

a="Python”
_H’lSH’
c="cool!”

printi(a, b. )

DIFFERENT VERSIONS OF PYTHON

If you've previously used Python 3 on a Mac or Linux, and
subsequently the Raspberry Pi, you may be a little confused as
to why the Windows version of Python uses the command line:
python, instead of python3.

The reason behind this is that UNIX-like systems, such as macOS
and Linux, already have Python libraries pre-installed. These older
libraries are present because some of the macOS and Linux system
utilities rely on Python 2, and therefore installing a newer version
of Python, and thus altering the executable name, could have dire
consequences to the system.

As a result, developers decided that the best approach for macOS
and Linux systems would be to leave the command line ‘python’
as exclusive Python 2 use, and newer versions of user-installed
Python would be ‘python3’.

BN Command Prompt

'me sion 18.8.17

] '[jll M d .__I_I’

Microsoft Virdﬂn_
-ku 27018 Mic

1

':1~ru+rﬂmﬁq_

- \iN1 Hﬂlll

1ne Compor P'*‘r-._-._-'

= Mm ﬁl (4 ¥
Inﬁ el
i ' . e

Management 1:|| _]_.u-
El' \NVIDIA Cor porat
l H ., e, D[I

o |

|"'

JindowsPower HI'-‘l... L

_|_| (-

S de a\ Ap,Dah_ Lu_j* P*H r4m~l
david\AppData\Local\ P*u:réﬂr=_ﬁ3ﬂf”37Tif

Con .}_n" nents\

—

on\PhysX\Common,;C:\

—"ir"l Files

‘;1h|n Puhiur| 'an;”;:HU_era
on36-32

BN Command Prompt

hon Code
10N 1' |||1

T
T,

. L

|;*r|r hel

L \Python Code>

This isn't an issue with Windows, as it doesn’t use any Python
libraries other than the ones installed by the user themselves

when actually installing Python. When a Windows user installs
Python, the installation wizard will auto-include the command line
instance to the core Windows PATH variable, which you can view by
entering: path into the command line. This points to the python.
exe file required to execute Python code from the command line.

We don't recommend you install both Python 2 and Python 3
within Windows 10; naturally, you can if you want, but realistically,
although Python 2 still has a foothold in the coding world, Python
3 is the newest version. However, if you do, then you will need to
rename one of the Python versions names; as they will be installed
in different folders and both use python.exe as the command line
executable. It's a little long-winded, so unless there's a dire need to
have both versions of Python installed, it's best to stick to Python 3.
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Coding with Pyth0n>

Numbers and Expressions

We've seen some basic mathematical expressions with Python, simple addition and the

like. Now let’s expand on that, and see just how powerful Python is as a calculator. You
can work within the IDLE Shell, or in the Editor, whichever you like.

IT'S ALL MATHS, MAN

You can get some really impressive results from the mathematical powers of Python, as maths is the driving force behind the
code with most, if not all, programming languages.

STEP 1 Open up the GUI version of Python 3, as mentioned ==k q You canuseall [® Python 3.7.0 Shell
you can use either the Shell or the Editor. For the the customary File Edit Shell Debug Options Window

time being, we're going to use the Shell. If you've opted to use a Mathematical operations: divide, f’;"]‘hzz j;;g (v3.7.0:1bL9cc5093,
third-party text editor, note that you need to get to the IDLE Shell multiply, brackets and so on. Type "copyright®, "credits" or "1
For this part of the tutorial. Practise with a few, for example: >~ 2*2
>>> 54356+34553245
Li Python 3.7.0 Shell - O > 1 /2 34607601
. : : . >>»> 95867344%27344484221
;irtth:::tiis‘tﬂ:] I:Z“i f_p:::;;c:;::w -::;ipz? 2018, 04:06:47) [MSC w.1914 32 bit (Inte =~ 6/2* b
1)] on winéz - ' ' o ' Zt2%3 >>> 1/2
Type "copyright™, "credita™ or "license()"™ for more information. {1+2} + {3*4) 0.5
>33 >>> 6/2
3.0
>2> 2+2%3
8
>>> (142)+(3*4)
15
>
iz [nthe Shell enter the following: i3 Asyou'veno [® Python 3.7.0 Shel
549 doubt noticed, File Edit Shell Debug Options Windc
division produces a decimal Python 3.7.0 (v3.7.0:1bf9ccS0%!
54356+34553245 b [::; Pyth th 1) ] on win32
99867344*27344484221 Lo ) el s eogiions FYpE. "CORYEIGRET, Teredipn” o
called floats, or floating point >>> 242
- . . 4
As you can see, Python can handle some quite large numbers. ar|thmet}£. If however, you I —
_ - needaninteger asopposedtoa 34607601
I Bytison 370 Shel - B % decimal answer, thenyou can use  >>> 99867344*27344484221
File Edit Shell Debug Options Window Help d bl 5k 2730821012201179024
P}rt.ic:n 3.7.0 (v3.7.0:1bf9%cc5093, Jun 27 2018, 04:06:47) [MSC w.1914 32 bit (Inte - a OU € Sas % 22> l.f"z
1)1 on win32 0.5
ziez::ﬂpyright', "credits™ or "license ()™ for more information. 1//2 >>> 6/2
4 6//2 3.0
>>> 54356+34553245 >>> 2+4+2%3
34607601 8
' and so on.
>>> 9586T7344*27344484221 4
2730821012201179024 >>> (1+2)+(3*4)
>>> 15
>>> 1//2
0
>>> 6//2
3

e




STEP 5

see the remainder left over from
division. For example:

You canalsouse L& Python3.7.0Shel
an DDEFatiUn tO File Edit Shell Debug Options Window

Python 3.7.0 (v3.7.0:1bfScc5093,
1l)] on win32
Type "copyright”, "credits" or "1
>>> 242
g

10/3 >>> 54356+34553245

—_— : 34607601

will display 3.333333333, which >>> 99867344*27344484221

is, of course, 3.3-recurring. If you ii“ii“lﬁ“”?”“

now enter: 0.5
>>> 6/2

10%3 4+
>>> 2+2%3

. : . s 8

This ujnll display 1, which is I.:h*eh o ek

remainder left over from dividing 15
>>> 1//2

10 by 3. :
>>> 6//2
3
>>> 10/3
3.3333333333333335
>>> 10%3
1

>>> |
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File Edit Shell Debug Options Window H

Python 3.7.0 (v3.7.0:1bf5cc5093, Ju
1)] on win32
Type "copyright™,
>>> 242

Next up we
have the power

STEP 6

operator, or exponentiation
if you want to be technical. 4

"credita®™ or "lic

>>> 54356+34553245

To work out the power of 34607601
>>> SS9867344%27344484221

something you can use a 2730821012201179024

double multiplication symbol, >>> 1/2
0.5

or double-star on the keyboard: Sha S
3.0

2% %3 >>> 2+42*3
g8

10**10 >>»> (1+2)+(3*49)
15

Essentially, it's 2x2x2, but we're 2 1//2

sure you already know the >>> 6//2
basics behind maths operators. -
This is how you would work it

3.3333333333333335
. >>»> 10%3
out in Python. 5
D> Z2WR3Z
8
»>>»>» 10*®]10

10000000000
}}}l

Python 3.7.0 (v3.7.0:1bf9%cc5093, Jun
l)] on win32

Iype "copyright™, "credita™ or "licer
>>> 242

Numbers and
expressions don't

STEP 7

q
stop there. Python has numerous s e

built-in functions to work out 34607601
»>>> G9867344%27344484221
sets of numbers, absolute values, |3730821012201179024

complex numbers, and a host of 22

Mathematical expressions and >5>> 6/2
3.0

Pythogarian tongue-twisters. For ... 2.2+3

8
example, to convert anumberto I ... ...

binary, use: 15
>>> 1//2

0

>»> 6//f2

3

>>> 10/3

3.3333333333333335

>>> 10%3

1

33> 2%%3

g

>>> 10**]10

10000000000

>>> bin (3)

'Obll"

>>»> |

bin (3)

<Numbers and Expressions </>

L B BN BN BN BN BN BN B N BN BN BE BN BN BN BN BN BN BN BN BN BN BN AL BN BN B BN BN BN BN BN BN BN BN R BN BN O BN BN B BN B BN BE BN BN BN B AR B BN B BN BN ORI BN AN AR N B ]

This will be
displayed as

File Edit Shell Debug Options Window Help

Python 3.7.0 (v3.7.0:1bf9%ccS5093, Jun 27 |
1l)] on win32
Type "copyright™, "credits™ or "license(

'0b11’, converting the integer Sk aa
into binary, and adding the prefix  >»> ss3se+34553245
Ob to the front. If you want to iin;ggé?aqe-zﬁqq&aqzn
remove the 0Ob prefix, then you sher >~ NS
can use: s
3.0
fGI‘lTlat {31’ \bf ) >3> 242%3

8
22> {(1+2)+(3*1)

The Format command converts 15
> 1772

a value, the number 3, to a 0

>>»> 6f/2

formatted representation 3
as controlled b},i’ the format ;f_;aigggaaasaaaaas
specification, the ‘b’ part. i

>>»> 10%3
23> 2%%3

=
]

>»> 10*%]10
10000000000

>>»> bin(3)

'*Obll*

»>>> Tormat (3, 'b")
ll_‘l-_l

o>

LB B B BN BN B RN OB BN OB B B BN OB B BN OO BN BN BT BN R B B BN OB B BN BN BN BN ORE B B BN B BN OB B BN B BE By BC OB B BN BE B OB B BN BN BE B BN BN B B 0N BE N B

A Boolean Expression is a logical statement that will
either be true or false. We can use these to compare

STEP 9

data, and test to see if it's equal to, less than, or greater than. Try

thisin a New File;

[ @ Eocleantestpy - C:/Python Code/Booleantes
a = b File Edit Format Run Options Window
b =7 o
pEintll, & == &) i;ﬁﬁ::;fi_ B
print(2, a == 7) R I
printi(s, & == 6 and b == 7 S, 5 B
printld, 3 = 7 and b =— I s e ey |
print (5, not a == 7 and b == 7)
print(6, a == 7 or b == 7)
print (7, a == 7 or b == 6)
print (8, not (a == 7 and b == 6))
print (9, not a == 7 and b == 6)

Execute the code from Step 9, and you'll see a
series of True or False statements depending on

STEP 10

the result of the two defining values: 6 and 7. It's an extension of
what we've looked at, and an important part of programming.

Lj Python 3.7.0 Shell = L

File Edit 5Shell Debug Options Window Help

Python 3.7.0 (v3.7.0:1bf%cc5093, Jun 27 2018, 04:06:47) [M5C v.1914 32 bit (Int
1)] on win32

Type "copyright®™, "credits™ or "license()™ for more information.

e

RESTART: C:/Python Code/Booleantest.py

True
False
True
False
True
True
False
True
False
e

W 0 =) o on s L B
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Using Comments

When writing your code, the flow, what each variable does, how the overall program
will operate and so on, is all inside your head. Another programmer could follow the

code line by line, but when the code starts to hit thousands of lines, things get a little

difficult to read.

#COMMENTS!

A method used by most programmers for keeping their code readable, is by commenting on certain sections. For example, if a
variable is used, the programmer comments on what it's supposed to do. It's just good practise.

variable and print command:

a=10
print (“The value of A is,”, a)

Save the file, and execute the code.

L% Comments.py - C:/Python Code/Comments.py (3.7.0)
File Edit Format Run Options Window Help

We'll start by creating a new instance of the IDLE
Editor (File > New File), and then create a simple

STEP 3 Re-save the code and execute it. You'll see that the
output in the IDLE Shell is still the same as before,
despite the extra lines being added. Simply put, the hash symbol (#)
denotes a line of text the programmer can insert, to inform them
and others of what's going on, without the user being aware.

L; Python 3.7.0 Shell — 1 X

File Edit 5Shell Debug Options Window Help

a=10
print (*"The value of A is, "™, a)

STEP 2 Running the code will return the line: The value of
Ais, 10 into the IDLE Shell window —which is what

we expected. Now let’s add some of the types of comments you'd

normally see within code:

# Set the start value of A to 10
a=10 ﬁ

# Print the current value of A
E}int{“The value of Aris,", a) 1

A 0 0
L& *Comments.py - C:/Python Code/Comments.py (3.7.0)*

File Edit Format Run Options Window Help

=

Python 3.7.0 (v3.7.0:1bf%ccS093, Jun 27 2018, 04:06:47) [MSC v.1%14 32 bit (Inte
l})] on win3z2

Type "copyright®™, "credits™ or "license()™ for more information.

2>
==================== RESTART: C:/Fython Cods/Comments.py
The value of A is, 10

e
Eeeeeseeeeeeeeeeee== RESTART: C:/Python Code/Comments.py
The value of A is, 10

>

STEP 4 Let's assume that the variable A we've created is

the number of lives in a game. Every time the player
dies, the value decreases by 1. The programmer could insert a
routine along the lines of:

a=a-1
print (“You’ve just lost a life!”)
print (“You now have”, a, “lives left!”)

[} *Comments.py - C:/Python Code/Comments.py (3.7.0)*
File Edit Format Run Options Window Help

$# Set the start value of A to 10

a=10
0 # Print the current value of A
] print ("The value of A is,", a)

1 |

# Set the start value of A to 10

a=10

# Print the current value of A

print (*The wvalue of A is,", a)

a=a-1

print ("You've just lost a life!"™)

print (*You now have", a, "lives leftc!"™)
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STEP 5

While we know that the variable A denotes number
of lives and the player has just lost one, a casual
viewer, or someone checking the code, may not know. Imagine for a
moment that the code is twenty thousand lines long, instead of just
our seven. You can see how handy comments are.

L& Python 3.7.0 Shell - O X

File Edit S5hell Debug Options Window Help

Python 3.7.0 (v3.7.0:1bfSccS093, Jun 27 2018,
l})] on win3:z
Type "copyright™,
e

04:06:47) [M5C w.1914 32 bit (Inte

"credits™ or "license ()" for more information.

=m= RFESTART:
The wvalue of A is, 10
e

C:/Python Code/Comm=nts.py

RESTART: C:/Python Code/Comments.py = =
The value of A 1is, 10

e

== B

=== RESTART:
The value of A is, 10

You've just lost a life!

You now have 9 lives leaft!
>35> |

C:/Python Code/Comments.py

L O B B BN BN B BN BN BN BE BN BN BN B OB B BN BN BN BN BN OB BN BN BN B OB NN BN BN BN B BN OF BN OB B B BN BN O BN BN BE BN OB OGN BN BN O By BN OR BN B OF BN OB NN B B O B

STEP 6

Essentially, the new code together with comments
could look like:

# Set the start value of A to 10
a=10

# Print the current value of A
print (“The value of A is,”, a)

# Player lost a life!

a=a-1
# Inform player, and display current value of A
(lives)

print (“You’'wve just lost a life!”)
print (“You now have”, a, “lives left!”)

Li *Coemments.py - C:/Python Cede/Comments.py (3.7.0)"

File Edit Format Run Optiens Window Help

# S=t the start value of A to 10

a=10

# Print the current valus of A

print ("The value of A is,", a)

# Player lost a life!

a=a-1

# Inform player, and display current of A ilivesﬂ
print ("You'wve -"Sunat losat a life!®)

Print ("Youi now have™; a; "lives left'™)

STEP 7 You can use comments in different ways. For
example, Block Comments are a large section of
text that details what's going on in the code, such as telling the code
reader which variables you're planning on using:

# This is the best game ever, and has been

.

developed by a crack squad of Pythmn experts
# who haven’t slept or washed in weeks. Despite

being very smelly, the code at least) ]
# works really well. | 9§ |

1 1 1 ] N 1 :
| & *Comments.py - C:/Python Code/Comments.py (3.7.0)" — O x

File Edit Format Run Options Window Help

#§ This is the best game ever, and has been developed by a crack sqguad of Python experts
$ who haven't slept or washed in weeks. Despite being wvery smelly, the code at least
§ works really well.]

r

§ Set the start walue of A to 10
a=10

$ Print the current value of A
print ("Ihe value of A iz, ™, a)

$# Player lost a life!

a=a-1
F Infore player, and diasplay current of B [lives)
print {("Tou've just lost a life!"™)

print{"You now have™, a,

0 1 O 1 0 0 0 0

"lives left!'"™)

|| File Edit

<Using Comments </>

RSN R ER R R R R R R RN

Inline Comments are comments that follow a
section of code. Take our examples from above,

instead of inserting the code on a separate line, we could use:

a=10 # Set the start value of A to 10
print (“The wvalue of A is,”, a) # Print the current
value of A

a=a-1 # Player lost a life!

printi("Tou’ve just losk a life!”)

print (“You now have”, a, “lives left!”) # Inform

player, and display current value of A (lives)

| & *Comments.py - C:/Python Code/Comments.py (3.7.0)* - O X

File Edit Format Run Options Window Help

|a=10 # Set the start value of A to 10

Eprinct“?he value of B is, ", a) ¥ Print the current value of A

a=a-1 # Player lost a life!

| print{"You've just lost a life!"™)

s A, "lives left!™) # Inform player, and display current of A [livesﬂ

LB B B B BN B BN OB OB OB B B BN OB B OB O BN BN OB BN OB BN B BN OGN BE BN BN BN BN OBE B B BN OB BN BN B B BN BE B B BN BN BN BE B OB BN BN BN OB B BN B B BN BF BF N B

The comment, the hash symbol, can also be used to
comment out sections of code you don’t want to be

STEP 9

executed in your program. For instance, if you wanted to remove
the first print statement, you would use:

# print (*The wvalue of A is,”, a)

L} *Comments.py - C:/Python Code/Comments.py (3.7.0)*

File Edit Format Run Options Window Help

# Set the start value of A to 10

a=1l0

# Print the current value of A

# print ("The value of A is,", a)|

¥ Player lost a life!

a=a-1

# Inform player, and display current of A (lives)
print {“"You've just loat a life!'"™)

print ("You now have", a, "lives left!"™)

You also use three single quotes to comment
out a Block Comment, or multi-line section of

STEP 10

comments. For them to work, place them before and after the areas
you want to comment:

L

This is the best game ever, and has been developed
by a crack squad of Python experts | l
who haven’t slept or washed in weeks. Despite

£

being very smelly, the code at least 1 0 O ]
works really well. e 0 ] L & %
(\ : 1_n N r\ N N

| & *Comments.py - C-/Python Code/Comments.py (3.7.0)* = O x

Format Run Options Window Help

1his i3 the bsat game &ver, and has been developed by & crack sguad of Python £Xpercs
who hawven't slept or washed in weeks. Despite being wery smelly, the code at least
worka really Well.

§ Ser the scart valus of A to 10
a=10

§ Print the current value of A
pEint ("The valus of A 13,", a)

# Playver logt a life!

a=gn-1
$ Inform player, and display current of A [lives)
print ("You've just loat a lifelWM)

print [("You noWw have™. a, "livas Isfe!l™)




</ >3 Coding with Python

Working with Variables

We've seen some examples of variables in our Python code already, but it's always
worth going through the way they operate, and how Python creates and assigns

certain values to a variable.

VARIOUS VARIABLES

we'll be working with the Python 3 IDLE Shell in this tutorial. If you haven't already, open Python 3 or close down the previous

IDLE Shell to clear up any old code.

STEP 1

In some programming languages, you're required

to use a dollar sign to denote a string, which is a
variable made up of multiple characters, such as a name of a person.
In Python this isn’t necessary, so, for example, in the Shell enter:
name="David Hayward” (use your own name, unless you're also
called David Hayward).

STEP 3

variable names. In our example, we can use: print (name + “:
“ + title).The middle part, between the quotations, allows
us to add a colon and a space. As variables are connected without
spaces, we need to add them manually.

As we've seen previously, variables can be
concatenated using the plus symbol between the

| & Python 3.7.0 Shell - O X

File Edit 5hell Debug Options Window Help

L Python 2.7.0 Shell = ] X
File Edit Shell Debug Options Window Help

Python 3.7.0 (v3.7.0:1bf%ccS093, Jun 27 2018, 04:06:47) [MSC v.1914 32 bit (Inte Python 3.7.0 (v3.7.0:1bf%cc50%3, Jun 27 2018, 04:06:47) [MSC v.1%14 32 bit (Intel)
1})] on win32 ] on win32
Type "copyright®, "credits"™ or "license()" for more information. Type "copyright®, *"credits®™ or ®license()® for more information.
»>>> name="David Hayward" >>> name="David Hayward"
>>> print (name) >>»>» print (name)
David Hayward David Hayward
e | >>> type (name)
<class "str'>
»>>»> title="Descanded from Celts"™
>>»>» print(name + ": " + title)
David Hayward: Descended from Celcts
>33
0
|
1 |
) ~
I£-::.-E LL:[ . :'-;-s!" ?’-‘-,; | J/ ! L L LY, -|

- i e

&% 88 88 ‘gl.lllllI--llI-llIIIIII.‘I.I.IIIII.IGII‘-Ii&ll‘ll"l{‘q&ll’}lill'l II-llIIII.--:'.-...;I'III-II-I-:I.I-IIIIIII-II'IIIIIIII.I.I'II!:Il'qll.il.‘l.fl:lj

l You can check the type of variable in use by issuing STEP 4 wWelcan also Bl Python 37,0 Shel '1
the type () command, placing the name of the combine variables -gi-hz:‘& = fj;”i LA L
variable inside the brackets: In our example, this would be: within another variable. For ] on win32
. : c . Type "copyright®™, "credits™ or "licen "
type (name).Adda new string variable: title="Descended example, to combing both name |22 aemesroavia faveazar 0
1 from Celts”. 00 1 1 6 and title variables into a new e s i
1 N N variable, we use: F2E THRER (HANE)
L& Pyt 2 7.0 Shell ) W <class "str'>
"\ i ot ot o : = »>>> title="Descended from Celts"
I'«'._,:" File Edit Shell Debug Options Window Help character=name + “: “ + >>> print (name + ": " + title)
Python 3.7.0 (v3.7.0:1bf9cc5093, Jun 27 2018, 04:06:47) [MSC v.1914 32 bit (Intel) ~ Ei¥Te Davighﬂaward: Descended from Cil‘“
] on win32 >>> aracter=name + ": " + title
] Type "copyright™, "credits" or "license ()" for more information. 0 >>> print (character) ] C}
>>> name="David Hayward" Then DUtpUt‘%-\e cgntent DF the David Hayward: Descended from Celts
>»>> print (name) M 1 >>> age=4g
David Hayward new variable as: ' >>> type (age)
>»> type (name) <class "int'> |
<class 'str'> w5 '
>>»> title="Descended from Celts™ print {C‘,ha]'_“a[:ter) _ 1
- -
1 Numbers are stored as different &
| ~ variables: )
age=44 0
) 11 Type (age) ] 1
0] Which, as we knaw, are integers. )
111 -' : 01 000
010

1 0 0 0 )
]000Q0O0OO 1 01

N0 0 01 38 0 0 () 0:..' 1 0 ] 0




(Working with Variables </>

LA LB R B B R R N NN NN N RN R ENENENEEDRNEREEEENENNEEN R NN EE RN B8 FS R R RN R R R R R R R R RN R R RN R ER

This presents a bit of a problem when you want

to work with a number that's been inputted by
the user, for example, as age + 10 is both a string variable and an
integer, it won’t work. Instead, you need to enter:

However, you can’'t combine both strings and
integer type variables in the same command as you

STEP 5

would a set of similar variables. You'll need to turn one into the
other, or vice versa. When you do try to combine both, you'll get an
error message:

int (age) + 10

rint (name + age) - e g ;
& = This will TypeCast the age string into an integer that can be
] on win3Z 1
Type "copyright™, "credita™ or "license()"™ for more information. WGFkEd WIth'
>>»> name="David Hayward"
>>> print (name) thon 1.7.0 Shell
David Hayward B Fython 3.7 Shel -
»>>> type (name) File Edit 5hell Debug Options Window Help

<class "str'>
>>»» titlem"Dascended from Celta®
»>>> print(name + ": " 4+ title)
David Hayward: Descended from Celts
>>>» character=name + ": " + title
»>>»>» print {character)
David Hayward: Descended from Celts
> AQewm4g
=>»> type (age)
<class '"int'>
»>>> print (name+age)
Traceback (most recent call last):
File "<pyshell#9>", line 1, in <module>
print (nam&+age)
TypeError: can only concatenate str (not "int™) to str
S 0

Python 3.7.0 (v3.7.0:1bf%cc5093, Jun 27 2018, 04:06:47) [MSC v.1914 32 bit (Inte
l})] on win32
Type "copyright™, "credits"™ or "license()" for more information.
»>>> age=input ("How old are you? ")
How old are you? 46
>>> type (age)
<class 'atr'>
>>»> age + 10
Traceback (most recent call last):
File "<pyshell#2>", line 1, in <module>
age + 10
ITypeError: can only concatenate str (not "int™) to str
>»> int (age) + 10
56
e

L O B B BN BN B BN BN BN BE BN BN BN B OB B BN BN BN BN BN OB BN BN BN B OB NN BN BN BN B BN OF BN OB B B BN BN O BN BN BE BN OB OGN BN BN O By BN OR BN B OF BN OB NN B B O B

STEP 6 This is a process known as TypeCasting. The Python
code is:

LY

print
ol s Hoks

(eharacter + ¥ 18 » + str(age)l + years

Alternatively, you can use:

print {(character, »is“, ags; “vyears old.")

STEP 9

numbers that have a decimal point in them. For example, enter:

LB B B B BN B BN OB OB OB B B BN OB B OB O BN BN OB BN OB BN B BN OGN BE BN BN BN BN OBE B B BN OB BN BN B B BN BE B B BN BN BN BE B OB BN BN BN OB B BN B B BN BF BF N B

The use of TypeCasting is also important when
dealing with floating point arithmetic; remember:

shirt=19.99

Now enter: type (shirt) and you'll see that Python has allocated
the number as a ‘float’, because the value contains a decimal point.

L; Python 3.7.0 Shell — |
File Edit Shell Debug Options Window Help
Python 3.7.0 (v3.7.0:1bf9%cc5093, Jun 27 2018, 04:06:47) [MSC v.1914 32 bit (Inte

Notice again that in the last example, you don't need the spaces
between the words in quotes, as the commas treat each argument
1l)] on win32

to print separately.
p - D ] y fTWE "Cﬂp‘j’rilﬁht", Peredics™ or "11CEI’1$E‘{]" for more information.
| W >» shirt=15.59

fﬁ David Hayward: Descended from Celts >>»> type(shirt)
\J >>> age=4§ <class 'float'>
1 >>> type (age) i

<class 'int'>
22> print (name+age)
Traceback (most recent call last):
| File "<pyshell#9%>", line 1, in <module>
= print (name+age)
{E TypeError: can only concatenate str (not "int") to str
| - »>»> print (character + "™ is " + str({age) + " years old.")
) David Hayward: Descended from Celts is 46 years old.
>>> print {(character, "is", age, "years old."™)
David Hayward: Descended from Celts is 46 years old.
e

L 1 |

-I-IllII‘II‘II'IIII-III--III-IiI-III-IiI-III'I;-;'II'IFILFIIiIiIIII'IIIII-III'I
"t

|
STEP 7 Another example of TypeCasting is when you ask
For input from the user, su¢h as a number. for
example, enter: 000 1 0

LW Nl

U | |

II-III-I-II-IlI-III-III-I__:..I-lI-II-II‘I-II‘I-I'I-"I_'IIIiI-IIIIil-'ll'.l'll'll'll-l

STEP 10 When combining integers and floats Python
usually converts the integer to a float, but should ¢
the reverse ever be applied, it's worth remembering that Python
doesn't return the exact value. When converting a float to an

] integer, Python will always round down to the nearest integer,
6[[ data stored from thei Inputémmmand is %tored as astring variable.  called truncating; in our case instead of 19.99, it becomes 19.

| !
et

r— F
o N

age= inﬁut (“How old are you? “)

‘[ . | i - ] 0
L; Pythan 3.7.0 Shell - o 4 L& Python 3.7.0 Shell = i X

File Edit Shell Debug Options Window Help

Python 3.7.0 (v3.7.0:1bfS%ccS5093, Jun 27 2018, 04:06:47) [MSC v.1%914 32 bit (Inte

l)] on win32

Type "copyright", "credits™ or "license()™ for more information.

>>»> age=input ("How old are you? ")
() How old are you? 46

>>»> Type (age) <class "float'>
<class 'str'> | | >>> int(shirt)
e 19

) [ () ()

File Edit Shell Debug Options Window Help
Python 3.7.0 (v3.7.0:1bf9%cc5093, Jun 27 2018, 04:06:47) [MSC v.1914 32 bit (Inte
l)] on win32

Type "copyright™, "credits™ or "license()™ for more information. 1
>>»> shirtc=15,90

>>> type(shirt) {j

P

O —
el el s—
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User Input

We've seen some basic user interaction with the code from a few of the examples

earlier, so now would be a good time to focus solely on how you get information from

the user, then store and present it.

USER FRIENDLY

The type of input you want from the user will depend greatly on the type of program you're coding. A game, for example, may
ask for a character’'s name, whereas a database can ask for personal details.

If it's not already, open the Python 3 IDLE Shell,
and start a New File in the Editor. Let's begin with

STEP 1

something really simple, enter:

print ("Hello®)

firstname=input (“What is your first name? “)
print{ " Thanks,.")

surname=input (*And what i1s your surname? “)

| & *Untitled’
File Edit

print ("Hello. ™)

firstname=input ("What 1i1s your first name? ")
print {(“"Ihanks.")

surname=input ("And what 1s your surname?? ")

Format Run Options Window Help

;[

--nl{}l-p--liﬁii]-li--i-

Save and execute the cr.?de, and, as you no doubt
suspected, in the IDLE Shell the program will ask
For your first name, storing it as the variable Firstname, followed by

your surname; also stored in its own variable (surname).
] N N nNnNAI1 ] 1N
,i [ Python 3.7.0 Shel - [ X
File Edit 5hell Debug Options Window Help
() L Python 3.7.0 (v3.7.0:1bf9%cc5093, Jun 27 2018, 04:06:47) [MSC v.1914 32 bit (Inte

1)] on win32
Type "copyright"™, "credits™ or "license()™ for more information.

2
-| RESTART: C:/Python Code/Userlnput.py
Hello.
What is your first name? David
Thanks.
() And what is your surname? Hayward
33>

N0 0 101 10 i 0 0 (0 0

Now that we have the user’'s name stored in a
couple of variables, we can call them up whenever

STEP 3

we want:

AL

print (“Welcome”, firstname, . I hope

you're well today.”)

surrname,

| & *Userlnput.py - C:/Python Code/Userinput.py (3.7.0)* — 0

File Edit Format Run Options Window Help

print ("Hello."™)

firstname=input ("What is your first name? ")

print ("Thanks."™)

surname=input ("And what is your surname? ")

print ("WNelcome®™, firstname, surname," . I hope you'rs well today.™)

STEP 4 Runthe code and you'll notice aslight issue, the |
full'stop after the surname follows a blank space.
To eliminate that, we can add a plus sign instead of the comma in

the code: 0 0 0
0

| M i,
print (“*Welcome”, firstname, surname+“. I hope

you’re well today.”)
] 0 i 0 ]
| & *Userinput.py - C:/Python Code/Userinput.py (3.7.0)* — n %

File Edit Format Run Options Window Help

print ("Hello. ")

firstcname=input ("What 1s your first nams=? ")

print ("Thanks."™)

surname=input ("And what 1s your surname? ") |
print ("WHelcoma™, firscname, 5urnamg+r. T hope you're well tcoday.™)

00130100 ] ]
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You don't always have to include quoted text within
the input command. For example, you can ask the

STEP 5

user their name, and have the inputin the line below:

print (“Hello. What's your name?”)

name=input ()

E_} *Userinput.py - C:/Python Code/Userlnput.py (3.7.0)" o ] X
File Edit Format Run Options Window Help

print ("Hello. What is your name?%)
name=input l,']ll
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The code from the previous step is often regarded
as being a little neater than having a lengthy

STEP 6

amount of text in the input command, but it's not a rule that's set in
stone, so do as you like in these situations. Expanding on the code,
try this:

print (“Halt! Who goes there?”)
name=input ()

L& *Userinput.py - C:/Python Code/Userinput.py (3.7.0)* e [ X
File Edit Format Run Options Window Help

print(“Halt! Who goes there?!"™)
name=jnput ()

: I
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It's a good start to a text adventure game, perhaps?
Now we can expand on it, and use the raw input

1 0

STEP 7

from the userto flesh outithe game a little;

) -
1f name=="David”:

0

1

’Lprint(“Welcmme, good sir. You
else: ] 0 0 |
print (*I know you not. Prepare for battle!”)

N 10 1 0 0 | R

[_} *Userinput.py - C:/Python Code/Userinput.py (3.7.0)" — ] X

may pass.”)'

File Edit Format Run Options Window Help
print(®Halc! Who goesa theres?"%)
name=input ()

i1f name=="David":

print ("Welcome, good sir.

You may pass."™)

print ("l know you not. Prepare for battle!"™)

N

<Userlnput </>

B8 FS R R RN R R R R R R R R RN R R RN R ER

What you've created here is a condition, based on
the user’s input. In short, we're using the input
from the user and measuring it against a condition. Therefore, if the
user enters David as their name, the guard will allow them to pass
unhindered. If, however, they enter a name other than David, the
qguard challenges them to a fight.

[ & Pynen 3.7.0 shell - O x [ veeinpus P\
File Edit Shell Debug Options Window Help Fie Edit Format Run Op d H
.Fjllhllv'.: .70 (vA.7.0:1b %5088, Tuen 27 2018, O4:0E:47)F [MIT ».1%814 32 Lic (TnLe e it [ ®Hal i~ | I 3
1j] on Wwin3iz ame=inpat ()
I'FPE TCOpYT1gRT®s, FEreadlits™ oar "liceEnssE(i® £4T mMOrE AAFOCMATLION. TIAMS == TRl a™ i
5% PELRT [ "Nelooe ] ¥ may pas b
- EESTARI: CT:/¥ython UCodes/Usszinput.py = e :
HALE! WA goEa THEDEY PIiOT ("l ] [ E BALTL ]

LaTLd

Walcome, good mir. You may pass.
L

RESTART: C:/Pythen Code/TacrInput.py
HBalti! Who goca there?

Jim

I kEmow you nov. Prepare Far bartle!
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STEP 9

As you learned previously, any input from a user

is automatically a string, so you'll need to apply a
TypeCast in order to turn it into something else. This creates some
interesting additions to the input command. For example:

# Code to calculate rate and distance
print (“Input a rate and a distance”)
rate = float (input (YRate: %))

L& *Userinput.py - C:/Python Code/Userinput.py (3.7.0)* -_ O X
File Edit Format Run Options Window Help

# Code to calculate rate and distance
fprintt"Input & rate and a distance")
\ rate = float (input ("Rate: “}ﬂ

|| U |
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STEP 10 Ahd to finalise the rate and distance code, we canadd:

distance = ﬂﬂat(input(“Distance: “ﬁ}

print ("ime:*, (distance f rate) )
|

Save and execute the code, and enter some numbers. Using the |
fluat(i_pput element, we've told Python that anything entered is a
Floating pﬂirtS number rather than a string. 0 ] L0

O o ] l

E;P}.rl.hnrli.lﬂﬂﬂdl - O 4 lii_.c' put.py = CoPython CedeUserdnput.py (1.7.0
File Fdir Shell Dsbug COphion:  Window  Help kde ket Format Hun Opbonc  Wendow  Help
Python 3.7.0 (v3.7.0:1bf%cc509%, Jun 27 2018, 04:06:47) [HS3C v.1l%l4 32 bic {(InoLe f Code ©0o calculace race and discance ] ]
1)] &R WiRE2 print ("Input. a rate and & distance®)
Type "copyright™, "credits®™ or "license (}® for more information. rata = float (imput ("Rate: ")}
( b diazance = flcat(input(“Discance: ")) (]
RESTART: C:/Python Code/Userlnput.py print (*Time:", (distance / rate}]
Inputr & TAcE and a discance
Hare: 12
Discanos:r 34

Tame: 2.8
o

—_ O

O O ¢

adl ﬂ:j-ﬁ:j

1000000 1 0 1
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Creating Functions

Now that you've mastered the use of variables and user input, the next step is to tackle

functions. You've already used a few functions, such as the print command, but Python

enables you to define your own function.

FUNKY FUNCTIONS

A Function is a command that you enter into Python in order to do something. It's a little piece of self-contained code that

takes data, works on it, and then returns the result.

It's not only data that a function works on. Functions
can do all manner of useful things in Python, such as

STEP 1

sort data, change items from one format to another, and check the
length or type of items. Basically, a function is a short word followed
by brackets. For example, len(), list(), or type().

| & *Python 3.7.0 Shell* — O ¥

File Edit Shell Debug Options Window Help

Python 3.7.0 (v3.7.0:1bfS9ccS5093, Jun 27 2018, 04:06:47) [MSC v.1%14 32 bit (Inte #
1l)] on win32

Type "copyright®™, "credita™ or "license()" for more information.

>>> len ()|
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A function takes data, usually a variable, works on
it depending on what the function is programmed

STEP 2

to do, and returns the end value. The data being worked on goes
inside the brackets, so if you wanted to know how many letters

are in the word antidisestablishmentarianism, then you'd enter:

len (“antidisestablishmentarianism”), and the number 28
would return.

Lﬂ Python 3.7.0 Shell ] X
File Edit Shell Debug Options Window Help

Python 3.7.0 (v3.7.0:1bfS%cc508%3, Jun 27 2018, 04:06:47)
l)] on win32

Type "copyright™, "credits™ or "license()"™ for more information.
»>>»> len({"antidisestablishmentarianism®)

28

>

[MSC v.1914 32 bit (Inte

STEP 3

You can pass variables through functions in much
the same manner. Let's assume you want the
number of letters in a person’s surname, you could use the following
code (enter the text editor for this example):

name=input (“Enter your surname: “)
count=len (name)

print (“Your surname has"“, count,
i )

“letters 1n

Press F5 and save the code to execute it.

==zs BESTRET: CiSPython Cods/Mamslounc,py ===
T murnams: Aajmeard
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STEP 4

Python has tens of functions built into it, far too
many to get into in the limited space available here.
However, to view the list of built-in functions available to Python

3, navigate to https://docs.python.org/3/library/fFunctions.html.
These are the pre-defined functions, but since users have created
many more, they're not the only ones available.

Laiden131-5hﬂl — 1 X

File Edit Shell Debug Options Window Help

Python 3.7.0 (v3.7.0:1bf%ccS093, Jun 27 2018, 04:06:47) [M5C v.1914 32 bit (Inte
1l)] on win32

Type "copyright®™, "credits™ or "license ()™ for more information.

>>>» len("antidiss=stcablishmentarianism"™)

28

>

RESTART: C:/Python Code/NameCount.py

Enter your surname: Hayward
Your name has 7 letters in it.
>2>2> 1NMDOTT
>>>

math
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Additional functions can be added to Python
through modules. Python has a vast range of

STEP 5

modules available that can cover numerous programming duties.
They add functions and can be imported as and when required. For
example, to use advanced Mathematics functions enter:

import math

Once entered, you'll have access to all the Math module functions.

o By & Fq-gnn L 5'\.5.:' « | D mesnialion = The Pyihin Standaed Lbirang »

S 2. Built-in Functions

p T T
i Fython inderpratar Ras 8 number of funchons and typas bl nio if that are alveys avadable They are =ied ham in alphabatcal order
Mt topac

3. Buit-m Constanly Built-in Functions
abs Lj ik

This Page all - nERt |

Repml a Fug

Eiuma Boarcs asy|l diwmed() L81) segesn i)
as I ek (] Li Lhod
b e L
ba I == (] am | |}
bytoazca ¥ . uk il i paz )}
Byresil f int 1
callabl farm 1 EEspesty b= A1
kri} frozrnant 04 | rangell =02 waral| }
1453me earer| ]

piled) abal T | IBRaSTE__

FORGING FUNCTIONS

(Creating Functions </>

To use a function from a module, enter the name of

the module, followed by a full stop, then the name
of the function. For instance, using the math module, since we've
just imported it into Python, we can utilise the square root function.
To do so, enter:

math.sgrt (16)

As you can see, the code is presented as module.function(data).

| & Python 3.7.0 She : O

File Edit 5hell Debug Options Window Help

Python 3.7.0 {v3.7.0:1bfS%cc5083, Jun 27 2018, 04:06:47) [MSC v.1%14 32 bit (Inte
l)] on win32
Iype "copyright®™, "credits™ or "license ()™ for more information.

»»>» len("antidisestablishmentarianism")
28

e e

RESTART: C:/Python Code/NamsCount.py
Enter your surname: Hayward

Your namese has 7 lstters in it.

>>> Amport math

>>»> math.sqgrt(le)

4.0

>

There are many different functions, created by other Python programmers, which you can import and you'll undoubtedly come
across some excellent examplesin the future. However, you can also create your own with the def command.
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STEP 1

user. enter:

def Hello () :

orint (“Hello®™)

Press F5 to save and run the script. You'll see Helloin the Shell,
typein Hello() and it'it return the new function.

Choose File > New File to enter the editor, let's
create a function called Hello that will greet a

[B Python 370 She 0 % [l [ hellopy - C/Python Code/helia.py (172

File Edit Shell Debug Options Window Help File

Pychen 3.7.0 [(v3.7.0:1bE9%cc5093, Jun 27 2018, 04:06:497) [MSC %.1914 32 bit (Ince
1)] om winiad

Type "copyright™, "credita™ or “license()™ for more informacion.

b S Hellal)

Edt Format Fun Ophons Window
&f Hellod):
print ("Hello®)

RESTARY: C:/FPython Codelhello.py

Hellas
v Hello|)

Hello
b
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STEP 2

Let's now expand the function to accept avariable,
the user’'s name for example. Edit your script toread;

ef Hello (name) :

orint (“Hello”, name)

Hello (“*David”)

This will now accept the variable name, otherwise it wilt print Hello

oL\l By ATl n ame= (“Bob” ) Bdili¥He 1 10 (name) &

Your function can now pass variables throughiit;

Fle Edit Shell De |_"|,.||3 ':lphl:n:. Windew Help
Python 3.7:0 (v3.T:0:1bf3%cc3053;, Jun 27 2018; 04:00:47) [HIC w.1%14 32 biv (Inte
1)] on win3d2

Tvpe "copyright®, "credits® or "license()® for more information.
S

File Edt Fomat FAun Optoons Window Help

fef Hello (name):
print [“H=1llo", name)

Hello (*David®)

RESTAKI: Cs/Pvthon Codefnello.py
Hello David

*3> pame=["Bob¥)

% Hells (nams)

Hello Bob

D
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STEP 3 To maodify it further, delete the Hello("David”) line,

the last line in the script, and press Ctrl+Sto save
the new script. Close the Editor and create a new file (File > New
File). Enter the following:

from Hello import Hello

Hello (“David”)
Press F5 to save and execute the code.

Li Podhan 1.7.0 She 0 : ljl....
File Bl Shell Debog Optiss Wiedew  Help File Edd Format Bus

Pyemon ¥_7_ 0 (WD _UiBEuses0ud, Jun 27 FOLN, UETOD&ET) [MSC v Lui4 37 pir (Inte from Helle impoct
11) vn windd

Typa "oopyright®, "oredita®™ or "liocanse()® for more information. Bells i=David=)
>3

RESTART : C:\Fython Code\tent.pv

Hells Dawid
]

STEP 4 What you've just done isimport the Hello function

from the saved Hello.py program, and then used it

to'say hello'to David, This is how modules and functions work, you

import the module then use the Function. Try this one, and modify
it For extra credit:

def add(a, b):

result = a + b
reftiirn raesult

| Pyrhon 3.7.0 Shel
File Edit Shell Debug Options Windew Help

Python 3.7.0 1?3.&.D:thﬂ::5D53. Jun 27 2018, Dﬂ:ﬂ5;171 [HSC w.1011 32 bic (Inte
1} ] =n wanid

Ivpe "copyright™, "crediva™ of "license ()™ for more information.

% %9

File Edd# Format HBon Optons Wind

=l addfa, b):
resule = a + b
n o resple

== RESTRRT: C:iy\Fyrhon Codeicesac.py =
fielle Dawvid
b

RESTART: C:/Fython Codefaadicion.py

Fer addildd, LZ2.2)
lEE.2

3 AGI{Z13,34.33)
246.,.32905550505090
B
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Conditions and Loops

Conditions and loops are what make a program interesting, they can be simple or rather

complex. How you use them depends greatly on what the program is trying to achieve,
they could be the number of lives left in a game, or just displaying a countdown.

TRUE CONDITIONS

Keeping conditions simple, to begin with, makes learning to program a more enjoyable experience. Let's start then by
checking if something is TRUE, then doing something else if it isn't.

STEP 1

Let's create a new Python program that will ask the
user to input a word, then check it to seeifit's a
Four-letter word or not. Start with File > New File, and begin with
the input variable:

word=input ("Please enter a four-letter word: ™)

[ T y2hon 3,70 5ne = - . M “Untiicd

File Edit Shel Dtbug Ootiors Window  Help File Edt Format Eun Optiond ‘Window Help

| Fyehaon 3.7.0 (vA.T.0:10Bf%>ch0R3, Jon 7 Z018, OS:0&:4T) [NSC v.19]14 3IF hit (Tnce WwarAminput ("Flease antear a ::.'_':-_'.g:-_;: worda: =) 1
[1p] on n

| Type “copyrignt™, “credics®
W

2r "license(}® Loz more informaticon.

sl Caka B
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STEP 2

Now we can create a new variable, then use the len
function and pass the word variable through it to
get the total number of letters the user has just entered:

word=input (“"Please enter a four-letter word: %)
word length=len (word)

L; “Untitled” [ ] X

File Edit Format Rum Options Window Help

word=input ("Please enter a four-letter word: ")
word length=len (word)

Now we'll use an if statement to check if the word
length variable is equal to four, and print a friendly

STEP 3

conformation if it applies to the rule:

word=input (*Please enter a four-letter word: ")
word length=len (word)
if word length ==

print (word, “is a four-letter word. Well done.”)

The double equal sign (==) check if something is equal to
something else.

| & *Untitled" - O X

File Edit Format Run Options Window Help

word=input ("Please enter a four-letter word: ")
word length=len (word)
if word length == 4:
print (word, "is a four-letter word. Well done."™)

LB L B B B B O B B N N N N R RN RN RN E R NN RN EENEENEERNESERLE.

The colon at the end of if tells Python that if this
statement is true, do everything after the colon

STEP 4

that's indented. Next, move the cursor back to the beginning of
the Editor:

word=input (*Please enter a four-letter word: ™)
word length=len (word)
1f word length == 4:

print (word, “is a four-letter word. Well
done.”)
else:

print (word, “is not a four-letter word.”)

| & *Untitled” - O X
File Edit Format Run Options Window Help

word=input ("Please enter a four-letter word: ")
wnrd*length-len[wnrd}
if word length = 4:

print (word, "is a four-letter word. Well done."™)
ElgE:
print (word, "is not a four-letter word."™)
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Press F5 and save the code to execute it. Enter
a four-letter word in the Shell to begin with, you

STEP 5

should have the returned message that the word is four letters.
Now press F5 again, and re-run the program, but this time, enter a
Five-letter word. The Shell will display that it's not a four-letter word.

[ Pytivom 200 Shell =, [n! Gl - R —
File Edit Shell Debuwy Optiois Window Help

Fython F.7.0 (vd.7.0rlbiv¥oochUsd, «Jun I7 J0LEF, UH10erd7) |MSC +.1%14€ dd Dt [lnEs
1] vy winidz

I'vpe "copyVILgRE®, "CrealiTs” orf “license|)® DOr more LACSIMATLION.
iy T

File Edit Fosmat Fun Opbere Window Help
word=inpue ("Clease enter & four-lesser word: ™)
WOrd lengrheléen [Wora)
Lf word length = 41
primt (word, "iw & foor=laertTar word, Wall dome.®)

e ™ =ww QESTANI© CofPython Cods/wordgams.py == T bl
Fleases #akefF A Fhir=lezzer ward: Waed

Word iE A EOUE-L8tTEr WOTd., Well asne.

e

primc (eord, "ilw opor 8 Dour=legier wood. ")

= == HESTAMLF Ci/f/Python Code/wordgame.py = =
Flrass s#nEaf a FArur=lsEEst ward: Frase
FroSt iF AOE A DOUE-L&EREF WiId.

LOOPS

< Conditions and Loops (G

STEP 6 Now expand the code to include other conditions.
Eventually, it could become quite complex. We've

added a condition for three-letter words:

word=input (*Please enter a four-letter word: %)
word length=len (word)
1f word length
print (word,
done.”)
elil word lengbh == 5:
print (word, “is a three-letter word. Try again.”)
else:
print (word,

“is a four-letter word. Well

“"is not a four-letter word.”)

[ ' y F

e Edn e Debua Qpbons Window Help File Edit Format Fun Opten: Wedews Help

iFthun 5.7.0 (v3.7.0:1bf8cc 08, Jun 27 2018, Od4:;04:47) [HSC w. L1814 32 bLit (Inte
11¥] oo winld
Tipe "copyrighe™, "cradita™ or "licenss (1™ for mors information.

wordeinput (“Fisars #NTED 4 COUC-19TTEr word: =)
ward_lengthE=len (Wwopd)
-2 wipd lemgth == §:

pelatr (word, "ls & foos-latre: woid. Waell dcips.")
| RESTART: Ci/Python Code/wordgams .py * ward lepgeh == 3:
!ritlﬂt enter 4 Cour-leEter wordi Word prine [wasd, "is a three-lemeey ward. Tey again.”)

;ld.lfrl 18 & ICUEr-LleCher Ward. Well Qone. LS §
| »a> BRAAT dEd., “1LF REE & DOUD-LloTREl wWOra.”w)

RESTRRT: C:/Pyihon Code/wardgams. -5
| Please epter & four-lettezr word: Frost

| Feosz i oot e fouz-lettes word.

1

| RESTART : C:/Pychon Codsfwardgams . pyr
nter a four-letter words Foa

Although a loop looks gquite similar to a condition, they are somewhat different in their operation. A loop will run through the
same block of code a number of times, usually with the support of a condition.

STEP 1 Let’s start with a simple while statement. Like if,
this will check to see’if something is TRUE, then run

the'indented code:

Hile %= < 1

X = x + 1

Lib.:ﬁ'“”thr

File Edit Format Run Options Window Help
%x=1
whiles =<10:

print (x)

=x+1

3=l 'he difference between if and while'is that when
while getstothe end of the indented code, it goes

back and checks the statement is still true; In our example xisless

than 10, With each'loop, it prints the current value of X, then adds
one to thatvalue, When x does eventually equal 10 it'llstop.

Jii.”c". hel = L] - Li oo b = thon Codefoop .oy (3
fle Edid  Shell Debug Optons Wendow  Help
Fython 3.7.0 ([(vi.7.0:11bI%cchi=l,
1] on wind2

Typc "ocopyright®™, "aredita®™ or "liccnac ()™ for morc information.

File Edit Formmai Run Optons Wndow Help
Jun T Z0LE, U4:0er47) [HSC v.l914 3F bat (Inte & =]
ig EelO;

RESTART: C:fPython Codefloopl .

W N -l LA s G P B
W

STEP 3 The for loop, is another example. Foris used to
loop over arange of data, usually a list stored as
variables inside square brackets, For example:

ords=["“"Cat”, "“Dog”, “Unicorn”]
tor word in words:

print (word)

[ Python 3.7

File Edit 5Shell Debuyg Options Wmdow Help File Edit Format Run Options Window Help

'H'I'Il'l'l.l-'["l-_.-""‘_ "Dy, "."i"."'.'-‘-"]

1)] on winiz

Tj‘]:-i:' "copyright®, "creditza®™ orf "licenae ()™ for moxe informaticn. L WoLd L0 woLDds;
e Ty

prine (word)

_— RESTRRT: C:/Pyrhon Codeflinsp] .py

%
55

RESTARY : C:fPython Coge/Lloocpl.py
Cat

Dog

Tnicoarn
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STEP 4

for x in range (1,

The for loop canalso be used in the countdown
example by using the range function:

IR

The x=x+1 partisn’t needed here, because the range function
creates a list between thefirst and last numbers used.

L‘|l.i 1 3.7.0 el ] ; lil'-. pry - iy & pry (T

File Edat Shell Debug Options Cdit Format Mun
Pychon 2.7.0 (v3.7.0:10L5%CcCa0593, Jun 7 2018, O04:0€:47) [MIC w.1%14 32 bit (Ince EOT X -Ar
1] on wind2

Type "copyright™, "credita™ or "licecmac ()™ for moze infozrmation.
b e

Whindow H{:F Tile ':":-Tli:-l'li Windoew

range (i, 4U] 3
e laL {R)

RESTART: C:/Pychon Code/loopl.py

WOl DR =l hUA el LD R =

BESTART: C:/Pyrthon Code/loopl. py ==
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Python Modules

We've mentioned modules previously, using the Math module as an example, but since

using modules is such a large part of getting the most from Python it's worth dedicating

a little more time to them.

MASTERING MODULES

Think of modules as an extension that's imported into your Python code to enhance and extend its capabilities. There are
countless modules available, and as we've seen, you can even make your own.

Although good, the built-in functions within Python
are limited. The use of modules, however, allows us
to make more sophisticated programs. As you are aware, modules
are Python scripts that are imported, such as import math.

| & Python 3.7.0 Shell - O X

File Edit Shell Debug Options Window Help

Python 3.7.0 (v3.7.0:1bf9%cc5093, Jun 27 2018, 04:06:47) [MSC v.1914 32 bit (Inte
1l})] on win32

Type "copyright"™, "“credits"™ or "license()"™ for more information.

>>»>» import math

}}}]
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Some modules, especially on the Raspberry Pi, are
included by default; the Math module is a prime
example. Sadly, other modules aren’'t always available. A good
example on non-Pi platforms is the Pygame module, which contains
many functions to help create games. Try: import pygame.

| & Python 3.7.0 Shell - O ¥

File Edit Shell Debug Options Window Help

Python 3.7.0 (v3.7.0:1bf%cc5093, Jun 27 2018, 04:06:47) [MSC v.1914 32 bit (Inte
l})] on win3:z
ITvpe "copyright®™, "credits=" or "license()"™ for more information.
>>> 1 T math
> DOrt pygame
1raceback [(most recent call last):
F <module

File "<pyshell#l

line 1, in
1mport pygame
ModuleNotFoundError:

e

No module named 'pygame”’

The result is an error in the IDLE Shell, as the
Pygame module isn’'t recognised or installed in
Python. To install a module we can use PIP (Pip Installs Packages).
Close down the IDLE Shell and drop into a command prompt or
Terminal session. At an elevated admin command prompt, enter:

pip 1nstall pygame

STEP 4 The PIP installation requires an elevated status due
to it installing components at different locations.
Start with a search for CMD, via the Start button, right-click the
result, and then click Run as Administrator. Linux and Mac users can
use the Sudo command, with sudo pip install package.
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Close the command prompt or Terminal, and re-
launch the IDLE Shell. When you now enter import

STEP 5

pygame, the module will be imported into the code without any
problems. You'll find that most code downloaded, or copied, from
the Internet will contain a module, mainstream or unique, and their
absence is commonly the source of errors in execution.

L& Python 3.7.0 Shel - O]

File Edit Shell Debug Options Window Help

Python 3.7.0 (v3.7.0:1bf5cc5093, Jun 27 2018, 04:06:47) [MS5C v.1914 32 bit (Inte
l)] on win32

Type "copyvright®, "creditcs™ or "license ()" for more information.

>>> 1Mport pygame

pygame 1.9.4

Hello from the pygame community. https://www.pygame.org/contribute.html
>3
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The modules contain the extra code needed to
achieve a certain result within your own code, with

STEP 6

which we've previously experimented. For example:

import random

Brings in the code from the Random number generator module. We
can then use this module to create something like:

for 1 1in range(lo) :

print (random.randint (1, 25))

E.& "Untitled” [

File Edt Format Run Options Window Help

import random

for 1 in range (10):
print (random.randint(l, 23))

This code, when saved and executed, will display ten
random numbers from 1 to 25. You can play around

STEP 7

with the code to display more or less, and from a greater or lesser
range. For example:

import random

for i in range(25):

[ P

print (random.randint (1, 100))
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D Al imrort random

RESTART: C:/Fython Code/rnd number.py

1 for L in range (25)
4 print (random.candint (1, 100} )
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Multiple modules can be imported within your code.
To extend our example, use:

import random
import math

for I 1in range(d5):

praint {random.randint(l, 25))

print (math.pi)

[_ﬂ *rnd number.py - C:/Python Code/rnd number.py (3.7.0)* — O X

File Edit Format Run Options Window Help
import random
import math

for 1 in range(S5):
print (random.randint (1, 25))

prlnt{math.piﬂ
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The result is a string of random numbers followed
by the value of Pi, as pulled from the math

STEP 9

module using the print(math.pi) function. You can also pullin
certain functions from a module by using the from and import
commands, such as:

from random import randint

for i in range (5):

printirandynt{l, 25))

[_; ‘rnd number.py - C:/F

File Edit Format Run Options

ython Code/rnd number.py (3.7.0) = a

Window Help

from random importc randint

for 1 in range (5):
print (randintc (1, 25))

This helps create a more streamlined approach to
programming. You can also use: import module¥*,

STEP 10

which will import everything defined within the named module.
However, it's often regarded as a waste of resources, but it works
nonetheless. Finally, modules can be imported as aliases:

import math as m
print(m.pi}

Of course, adding comments helps to tell others what's going on.

L% “rnd number.py - L:/Python Code/md number.py (3.7.0)° - ] o4
File Edit Format Rum Options Window Help
import math as m

Print (m.pi)






